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 USE OF THE DOCUMENT 
This document provides the users of Domintell home automation systems with the 
configuration procedure for the GoldenGate software. It clearly indicates the different 
steps to create an application. 

This manual is a support for users to adapt their .dap file (Domintell Application 
Program). 

For a better use of the manual, it is recommended to participate in the Domintell technical 
trainings sessions. 

The texts in italics designate the messages indicated on commands (button, checkbox, 
...) 

Bold markings indicate the menus and submenus to be navigated to reach a function. 

This document is limited to the configuration of the DGQG01 with the GoldenGate 
software. However, most of the information in this document remains valid for previous 
versions of the GoldenGate configuration software or Domintell2. 

If you have any questions about these products and their use through GoldenGate, 
please contact our support department at Support@domintell.com or by telephone on 
+32 (0) 67 88 82 50. 

mailto:support@domintell.com
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 PRESENTATION OF THE INTERFACE 
Toolbar 

 
Some icons may appear grayed out (not accessible), depending on the connection status 
with the Master. 

•  (CTRL+N, CMD+N) : Create a new empty application ( .dap file) 

•  (CTRL+O, CMD+O) : Open an existing application on the computer ( .dap file). The 
most recently opened files are also available from this button. 

•  (CTRL+S, CMD+S) : Saves the application ( .dap file) 

•  (CTRL+SHIFT+S, CMD+SHIFT+S) : Save the application under another name ( .dap 
file) 

•  : Reading the application from the Master 

•  : Writing the application in the Master 

•  : Activation of the PC active mode 

•  : PC active mode enabled, click to disable 

•  : Search for modules in the system (bus scan) 

•  : Management of the modules present on the installation 

•  (F6) : System diagnosis and update 

•  : Regional settings of the application 

•  : Setting up the presence simulation 

•  : Connection to the selected Master (here disconnected) 

•  : Disconnection of the Master (here connected) 

•  : Refreshing the list of Masters found on the Ethernet network 

•  : Editing recorded Masters 

•  (CTRL+Q, CMD+Q) : Exit 
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 PRE-PROGRAMMING OPERATIONS 
Connection to the Master 

To know the status of the USB connection that the DGQG01 module uses on the 
computer, go on the Windows control panel > Hardware and Sound > Device 
Manager. The ports list must contain Domintell DGQG01 USB. 

If the Universal Serial BUS controllers list does not contain the Domintell DGQG01 USB, 
that means the USB drivers have probably not been installed. The USB connection is 
recognized but appears as not installed. 

To install the USB driver, right click on the peripheral that has to be installed and select 
Update Driver Software. 
If you have an internet connection, choose the automatic installation. If you do not have 
an internet connection, choose the manual installation. The New Hardware Wizard will 
appear. Specify to the computer the location of the directory that contains the drivers. 
Those can be found on the installation CD or on our website PRO. 
The New Hardware Wizard finds and installs the drivers. It lets you know whe the unique 
procedure is done. 

Click finish to complete the driver’s installation. 

Implementation of the operating system in the master 

The DGQG01 must contain the same version of the Domintell operating system (Master O.S.) that 
the one installed on the computer (compiler). 

Note: If the version installed on the computer is higher than the version in the DGQG01, only the 
function Read application is possible. 
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To implement the operating system in the Master, go in the menu Tools > Update and diagnosis. 
The window Master: Software update will appear. 

If the O.S version is not updated, begin the transfer by clicking OK and confirm the procedure by 
clicking Yes. The transfer of the operating system to the DGQG01 takes about 8 minutes. The 
transfer of an operating system removes what is in the DGQG01 memory. 

It is impossible to transfer an application in the DGQG01 if the versions of the operating system in 
the DGQG01 and in the computers are not identical. 

Verification of the operating systems version (O.S./Firmware)  

You can check the O.S version in the Master in the menu Tools > Update and Diagnosis. The 
Master O.S version and the application version must be identical. Moreover, all modules must also 
have the firmware last update. If at least one module is not up to date,, it will be displayed in the 
Required update. 
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Creation of a new application 
To create a new application, go on the menu File > New. The empty configuration screen 
will appear: 

Network scanning 
The network scanning allows the program to detect every module connected on the 
BUS. The detection of the modules can be done from the menu Master > Network scan.  
The scan's progression is shown on the window below: 

Every module connected to the bus will appear on the screen when the detection is 
completed. 
 

 PROGRAMMING ENVIRONMENT 
Main screen 

After you have done the basic operations, the screen will look like this: 

This screen is divided in 3 parts: 
 The gray column on the left of the screen displays the different floors and the different 

rooms which compose the building. This is the tree diagram of the project. 
 The central part of the screen displays the inputs column. The inputs modules control the 
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installation. The result of the programming by dragging an output on an input, will be 
shown on the inputs modules. 

 The right column of the screen displays the outputs. The outputs make the actions on 
the system. 

 Some modules have inputs and outputs at the same time. Ex : DGSM01, DPBT02,.. 

Organization of the house (first column) 
To clarify the installation structure, the Domintell software allows you to create a tree 
diagram with two stages of installation. Like that, you are able to organize the different 
rooms in the building's floors and distribute the different inputs and outputs connected to 
the BUS. 
If a touch screen DTSC0x is part of the installation, the first column gives you a default 
configuration of the modules showing on the screen. 

 

Rooms and floors distribution 
Open the window house design. On the menu Project > Add floor. Or, right click in the 
first column > Add floor. 
The upper right part contains the Floors and the lower right part contains the Rooms. 
To add floors, select and drag the wanted floor to the left part of the screen. Release the 
left button of your mouse. The floor will appear now here. 
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To add rooms, select and drag the wanted room over a floor placed on the left part of 
the screen. Release the left button of your mouse. 

Click OK when the organization of the different floors and rooms is done. 

Creation and removal of floors and/or rooms 
It is possible to create new floors and new rooms or to rename the existing 
floors/rooms. 
To add a floor, right click in the floors place > Add a floor. A new floor will appear in 
the list, rename it. 
To rename a floor, select the wanted floor > left click > rename the floor. Following 
this change, a screen of icons selection appears and allows you to attribute an icon to this 
floor. To choose another icon, go in Project > Icon selection. 
To remove a floor, select the wanted floor > right click > Delete. 
Follow the exact same steps for the creation, the removal and the name’s modification of 
a room. 

Inputs and outputs layout in the rooms 
The units layout is made by: 
 Either from the main screen. Select each used component (input or output), drag the 

component to the room in which it is installed. 

 Either from the menu section Project > Layout. Take the inputs and outputs to rearrange 
them in a tree diagram. 

During a unit selection in the tree diagram, the inputs and outputs which are rearrange 
will appear. 
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The inputs modules (second column) 
Those are all the modules that give an operation's information to the DGQG01. The 
modules list can be found in the 'module' chapter of this manual. 

The outputs modules (third column) 
Those are all the modules that can be operated by the DGQG01. Those modules make 
actions depending of the DGQG01 programming. The modules list can be found in the 
'module' chapter of this manual. 

The programming setup 
The following steps allow you to change the links order within the application. 

Unit name's edition 
Every inputs and outputs can be renamed with the objective to make the programming 
easier. This is the same for the groups, the variables, the temperature probes, the IR 
detectors and the clocks. To change the unit’s name, select the unit > Right click > 
Rename. 

To rename all the units of a module, select one of the module’s unit > right click > Edit. 
Rename each unit of the module. 
The unit from which the module is edited appears in red on the list. 

 Renaming all the component gives you an easiness in the future programming. Use 
easy and intuitive names. 
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Links displacement 
When several outputs are linked to a unique input, it is possible to change the links 
order in this input. Right click on one the links and select Move the link up or Move the 
link down. 

  The links order is important when they have a variable's value as status. This link's 
displacement gives you a better ergonomics within the software. 

 Example: If the speed's incrementation of the ventilation is made in function of a variable's 
value and that this value is incremented by each pressure on the designated button. So, if 
the variable is in the first position, it will be incremented and the following actions will be 
made in function of the new variable's value. 

 

 If the variable is placed in the last position, the links will be made in function of the old 
variable's value and then the variable will be incremented. 

Clocks setup 
In order to organize the programming as you like, it is also possible to move the clocks 
created. Right click on one of the clocks, select Move the clock up or Move the clock 
down. 
To rearrange the clocks in a chronological order, right click on the clocks icon and select 
Clocks sorting. 

 This is only an ergonomics functionality. Moving a clock does not affect its start at the 
chosen time. 
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Locate the Inputs/Outputs 
Use the option Master PC active to easily locate the Inputs and/or Outputs. Connect 
the computer to the DGQG01. Select the Master PC active mode. An action on an Input 
will be shown by the green coloring on the involved Input’s icon. 

 
The option Hold last action highlight the last Inputs activated (Menu Options > Hold 
last action). 
To change the Outputs status from the computer, click on the wanted Output’s icon. The 
status is shown by a color change or an icon change. The Master PC active mode 
operates only the short support. 

Looking for elements within the application 
The function Search is applicable for every Inputs, Outputs, Variables and Groups. It 
locates where the elements are in the configuration file and show the related links. From 
the element you are looking for, right click and select the option Search. The window 
here below shows you every place where the element is located. 

The selection of one of the emplacements on this window shows directly the related link’s 
emplacement within the configuration program. 

Options Menu 
The Options menu operates the computer display's ergonomics. The options within the 
menu shows for each component: 
• Its serial number : Show module number 
• The place in the house where the Inputs and Outputs are located : Show floor/room 
• Its type : Show type 
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The menu allows you also: 
• To show or not the progress bar of the application's transfer : Show the information on 

transfer 
• To choose a language between the 23 offered : Select language 
• To extend or reduce every links in the program : Close all links/ Open all links 

Make a report 
A report shows you every details of the programming. It is created from the menu Tools > 
Creation statement. This document gives to the user an overview of the application 
during and after the programming. 
The Inputs are ordered according to their emplacement. The following information’s are 
shown: 
• Used Output(s) 
• Action type related to each output 
• Link's setup 

The clocks and their setups are shown as well. Save the application before making a 
report. 

 In order to make the understanding of the report easier to the final user, it is important to 
clearly rename every elements of the installation. This manipulation is done in an intuitive 
and coordinated way. 

Add modules manually 
Add virtual modules from the menu Tools > Add module. Select the type then the 
module to add. 

  Make the virtual programming of an installation before the cabling and the scan of the 
modules. This tool allows you to create application tests to get to know Domintell2's 
Environment. The PC active mode don't manage virtual modules, this is not a virtual 
simulator. 

The selected module has a virtual address. This serial number can be change. Click OK to 
validate. 
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  Without knowing the serial number of the module that will finally be installed, keep the 
default serial number. 

If this serial number is unchanged, the new module appears in the program's main 
window with the mark [not scanned x] 
After the house automation modules cabling, replace the virtual modules within the 
program by the installed modules. Follow the instructions described in the 'modules 
replacement' section.  

Module replacement 
Replace a virtual or defective module without making any modification in the 
programming. 
In case of a defective module, make the physical replacement on the BUS at first. Scan 
the network (menu Master > Network scan). A message indicates the lack of a module, 
Click OK. The Modules Manager screen appears. It is divided in 3 columns:  
• Present modules : The detected modules on the network are shown. The number between  

[ ] represents the number of scanned modules.  
• Away modules : The non-detected modules on the network (disconnected or defective 

modules) are shown. The number between [ ] represents the number of away modules.  
• New modules : The modules detected during the last network scan are shown. The number 

between [ ] represents the number of new modules scanned. 

In the away modules column, right click on the module that has to be replaced and 
select Change. 

After this manipulation, the column Away modules and New modules must be empty. 
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Click OK and transfer the application to the Master for the change to be effective. 
 

 THE MODULES 
The distributions of the following titles following the order established in the menu Add 
module in the Domintell2 software. This is the description of the software characteristics 
of the modules. 
Some modules are fitted with both input and output. Ex : DGSM01, DPBT02.. They 
appear in the center column (Input) and as well as in the right column (output). 
 For example : The DGSM01 module sends you an SMS to warn of an intrusion. And 

receives an SMS to turn on all lamps installation and scare away the thief. 

 INPUT 
General information 

The input type modules appear in the central part of Domintell2 program, in the column 
of the inputs. It is through the inputs that there is a control of the installation. In the 
Inputs column appears the programming links. 
Long push management: 

The long push function launches the output’s link of the Input. A push is considered as 
long after a fixed period of 0.4 second. 
To be able to select a long push, it is necessary to select the function 2 press types in the 
settings of the input module. 

 Do not validate the long push without programming the link on this button using both types of press. 
Without programming, a slow person may exceed the short push time and arrives in the long period. So 
having no action. 

Inversion of an input signal: 
The function inverted allows you to invert the signal transmitted by a sensor. It is 
interesting when the sensor contact is normally closed. 
This function is accessible from the setting screen of each button type or DISM0x module.  
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DISM08 ; DISM04 
 Description 

The module allows you to make the direct connection of buttons or any other inputs, 
detectors, etc. potential free. 

White wire Common 
Brown wire Input 1 
Red wire  Input 2 
Orange wire Input 3 
Yellow wire Input 4 
Green wire Input 5 
Blue wire Input 6 
Purple wire Input 7 
Gray wire Input 8 

 Edition of the module 
• Module setting: Name, type, version and address of the module. Only the name can be 

modified. 
• Input setting: Names of the inputs channels, 2 press type and inverted function. 

(description in the general information in the section inputs) 

DPBU01 ; DPBU02 ; DPBU04 ; DPBU06 
 Description 

Buttons with light indicators. Gamme Bticino Light/Living. There are 4 types of modules: 
1, 2, 4, 6 buttons with light indicators. 
Light indicators programmable. The intensity of the light indicators is not controlled by the 
Domintell2 software. 
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 Edition of the module 

 
• Module setting: Name, type, version et address of the module. Only the name of the module 

can be modified. 
• I/O setting: Names of the input buttons, names of the outputs light indicators, 2 press 

types and inverted function (description of the general information in the section Inputs). 

DDIR01 ; DDIR02 ; DNIDIR01 ; DTDIR03 ; DAXDIR04 
 Description 

Infrared sensors which allow the reception of a signal from a Domintell remote of a 
universal infrared remote. This module allows the decoding of the 32 channels of IR 
command used by Domintell. 
 Edition of the module 

• Output setting : Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Input setting : Name of the IR sensor. 
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DMOV01 ; DMOV02 ; DTMOV03 ; DAXMOV04 
 Description 

Motion detector IR. Setting of the sensibility by the configuration software. 
A detection indicator (red light) can be activated during the configuration.  
 Edition of the module 

• Module setting : Name, type, version and address of the module. Only the name of the 
module can be modified. 

• Input setting : Name of the motion detector. Function inverted. (description in the general 
information), detection sensibility management. Option Leds on while movement detection.  

DPBLCD01 ; DAXPBLCD01 ; DPBLCD02 ; DAXPBLCD02 
 Description 

Touch screen of control. Setting of the number of inputs and outputs used in the 
configuration software. Possible configurations: 1, 2, 4 or 6 of push zones. 
PBLCD01 = version without integrated T° sensor. PBLCD02 = version with integrated T° 
sensor. 
Possible push zones: LCD push button DAMPLI01 audio menu, air conditioning menu, 
menu, DFAN01 air conditioning menu, ventilation DMV01 menu, digital clock. 
Possible screensaver type: digital clock, analogical clock, temperature display, custom 
image. 
The light intensity of the backlight is operated by the Domintell2 software. 
Possibility to use custom images with * .bmp (bitmap) format according to the given 
dimensions in section Import and image management in library. 
Climate control programming of the PBLCD02 temperature sensor is explained in the 
section: General Information: Temperature sensors. 
 Edition of the module 

Edit the PBLCD0x by right click on one the inputs or outputs elements of the module. 
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 Main configuration window 
The configuration of the PBLCD0x is made from this screen: 

1) Choice of a number of buttons to display 
The screen has one, two, four or six push/ display zones. By default, they are buttons. It 
is possible to select a menu or to display a digital clock. 

If links are present, it is possible that some buttons configurations are no longer possible. 
To have those configurations, you must delete links on the inputs / outputs of the 
PBLCD0x. 
 
2) Backlighting options 

There are three modes of the backlighting: Active, disabled (changes in intensity after the 
specified time of inactivity) and screensaver (when the screen is inactive, the display of 
the screensaver and the modification of the intensity occurs after the specified time). 
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Possibility to change the brightness of the screen when going on night mode. The user 
indicates the timeframe (User mode) or bases on the astronomical clock. 
The direct action option allows an instant reaction when pressing on the screen, without 
waiting for the extinction of the screensaver. This option is available from the version 65 
of the firmware of the PBLCD. 
3) Screensaver 

The option 'Use screensaver' launches after a given time. Screensaver types selected on 
the PBLCD: 
• Analog clock : The time is displayed with an analog clock. 
• Digital clock : The time is displayed with a digital form. 
• Domintell : Black screen with a blue line and a small Domintell logo are displayed. 
• Customized : Image from the library. The image can not contain more than 32.000 pixels 

(h*l). The size is usually 200x150 pixels. It is possible to insert images more stretched and 
respecting the size limit. 
 Importation and image management in the library 

The images supported by PBLCD modules must meet certain criteria of format and size. 
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Images must absolutely be saved in * .bmp (bitmap) 24 bits format.  
Depending on the display area (screensaver or button), dimensions must be respected. 
The maximum size for PBLCD modules is 32,000 pixels. The maximum display width is 
318 pixels and the maximum display height is 138 pixels. It is not possible to fill the entire 
screen with a picture. 

Configuration type Height x Width 
B1 238 x 318 

B2-B4 118 x 158 
B6 200 x 150 

 The *.bmp (bitmap) 24-bit format does not support transparency. To remove the record "square" of 
an image and allow its cutting, it is possible to select the transparency option in the PBLCD module 
configuration window. This manipulation allows you not to display all pixels with the same color as 
the top left pixel of the image. You have to place a color that you are sure that it does not appear 
somewhere else on the image. In the example below, it is the magenta color.  

  
 
 
 

→ → 
It is possible to add images to the library of the PBLCD via the menu Tools > Add 
pictures to the DPBLCD0x library.  

In the window, click on Import. A window asks you the image's location. Select the 
wanted *.bmp (bitmap) file and press OK. The program automatically puts the file in the 
correct directories. If the image is too big, an error message appears. Click on Add to the 
directory, to confirm the image placement. To import another image, click on import 
again. To end the importation, press OK. 
The library management is possible via the menu Tools > PBLCD picture handling. 
This window allows you to manage the pictures directories of the PBLCD. Possibility to 
rename and delete the files inside the directories. 
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 Different screens available of the PBLCD 

The PBLCD modules have a configuration from 1 to 6 push zones, used as touch button 
or for the menu display. The menus are available if the modules associated with these 
menus are present in application. 
To facilitate the preview of the reader, the push zones illustrated below were colored. The 
zones colored in yellow on the different catches allow you to return to the main menu. 

 

  

Main menu 

The Main Menu button allows you to run button type links or to 
access to the menu functions. 

If a zone is not configured, it is advisable to choose the clock as 
button type to avoid unwanted pushes on this area of the screen. 

 

Menu Fan (Only with PBLCD02 + DFAN01) 
 
A module DFAN01 must be present in the application and must be 
linked to the (regulation) sensor of the PBLCD. 

This menu allows the regulation management of the DFAN01. 
Possibility to change the temperature mode (Auto, Absence, 
Comfort and Frost); to change the speed; to change the desired 
temperature. 

 

Menu Temperature (Only with DPBLCD02) 
 
Allows the management of the temperature linked to the module 
sensor. Possibility to change the sensor mode (blue area) and its 
set temperature (red areas).  
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Menu Sound (Only if the DAMPLI01 is present) 
 
Allows the management of one of the 4 HP outputs of the 
DAMPLI01 module by touch zone. This menu allows you to edit 
the audio volume and source. It allows you in the tuner part, to 
edit the station. In the 4 possible auxiliary parts, it allows you to 
send IR codes (previous and next) if the configuration has a 
DIREMIT01 module. 

 

Menu Ventilation (only if the DMV01 is present) 
 
A DMV01 module (Mechanical control ventilation) must be present 
in the application. 

This menu allows you to select one of the 3 ventilation speeds of 
the DMV01. 

DPBT01 ; DPBT02 ; DPBT04 ; DPBT06 ; DNKPB04 ; DNKPB06 ; DNIPB01 ; 
DNIPB02; DNIPB04; DNIPB06 
 Description 

Push buttons design with LEDs. The blue and red LEDs are dimmable color by color. The 
outline of the button changes from blue to red depending on the output status (Follower 
function). Night management allows the managing of the brightness based on the 
astronomical clock or a period chosen bu the user. Flashing function of LEDs depending 
on a customizable period. 
 Edition of the module 

• Module setting : Name, type, version et address of the module. Only the name of the 
module can be modified. 

• I/O setting : Names of the input buttons, name of the LEDs of output, 2 press type and 
function inverted. (description in the general information of the section input) 

• Brightness management : Setting of the LEDs brightness level. Selection of the night mode. 
Inactive mode, the brightness stays in day mode. Astronomical mode, the brightness 
change is made in function of the sunrise and sunset. User setting mode, the change is 
done in function of the wanted period. 
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DIN10V02 
 Description 

Module of reception of the input analog signal 0-10V on the BUS. The module is setup 
with help of the configuration software as an input or an interface on a temperature 
sensor 0-10V. The measure band is divided in maximum 100 values. Number of inputs:1. 
 Edition of the module 

• Module setting: Name, type, version et address of the module. Only to name of the module 
can be modified. 

• Setting: Name of the input 0-10V. Choice of the data type 0-10V, analog input or 
temperature input. Management of working range by setting of the measured min. and 
max. tension. Measurement conversion window, by default in %. Data refresh 
depending of a period or a chosen offset. 

DVIP01 & DVIP02 
 Description 

Videophone module integrated to the Domintell home automation system. Audio and 
video transfer protocol under IP. Displays and communicates with DTSC04 screens. 
Presence of O-LED display and volume settings in the Domintell configuration software. 
 Edition of the module 
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General characteristics: Name, type, version and address of the module. Only to name of 
the module can be modified. 
• Inputs : Name of the DVIP01 (call) input button, name of the function of door command. 
• Display : Choice of layout, text, alignment type, direct preview of the final result. 
• Connection : Choice of the DHCP mode or insertion of a fixed IP address. Possibility to 

directly apply the connection changes by pressing Apply. 
• Volume : Selection of the volume level of the speaker. 
 Additional information 

Possibility to have a static image of the videophone by request ftp of this form: 
ftp://dvip0x_ip/di_screenshotd/ 

DPBR04 
 Description 

Touch button design with LEDs. Configurations of LEDs colors for each button. Choice of 
16 million of colors. Flashing LEDs possible. Possibility of Sending a specific color at an 
event. A beep can be emitted when pressing. 
 Edition of the module 

• Module setting : Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Inputs : Name of the input buttons, 2 press types, selection of the sound by pushing. 
• Outputs : Names of the output LEDs, selection of the color of the LEDs « ON » and 

« OFF ». By right click, possibility to individually choose the color of the states « ON » and 
« OFF » of the LEDs. Color selection wheel and values field are available. Possibility to 
duplicate a color choice on all the module outputs or all the buttons (ex : each 1st button of 
the installation) or all modules DPBR0x buttons present on the installation. 

Setting of the LEDs brightness levels during day and night. Selection the inactive, user 
(brightness change depending on the selected period) and Astronomical (brightness 
change depending on sunrise and sunset) management mode. 

  

ftp://dtsc_ip/di_screenshotd/
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DPBECO01 ; DPBECO02 ; DPBECO04 ; DPBECO06 
 Description 

Push buttons design with LEDs. Unique, red and dimmable LEDs.  
 Edition of the module 

• Module setting : Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Inputs : Names of the input buttons, 2 press types and the function inverted (description in 
the general information in the section Input). 

• Outputs : Name of the output LEDs. 
• Brightness management : Setting of the LEDs brightness levels during day and night. 

Selection the inactive, user (brightness change depending on the selected period) and 
Astronomical (brightness change depending on sunrise and sunset) management mode. 

The range DPBECO0x has only a ON LEDs, red. 

DPBL01 ; DPBL02 ; DPBL04 
 Description 

push design button of Lithoss brand. Module resulting from the partnership between 
Domintell and Lithoss. LEDs configurable by button with a choice of eight predefined 
colors. Flashing of the LEDs possible. Possibility to send a specific color at an event. 
 Edition of the module 
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• Module setting : Name, type, version and address of the module. Only to name of the 

module can be modified. 
• Inputs : Names of the input buttons, 2 press types. 
• Outputs : Names of the output LEDs, selection of the color of the LEDs « ON » and 

« OFF ». By right click, possibility to individually choose the color of the states « ON » and 
« OFF » of the LEDs. Choice between 8 predefined colors. Possibility to duplicate a color 
choice on all the module outputs or all the buttons (ex : each 1st button of the installation) or 
all modules DPBL0x buttons present on the installation. 

Setting of the LEDs brightness levels during day and night. Selection the inactive, user 
(brightness change depending on the selected period) and Astronomical (brightness 
change depending on sunrise and sunset) management mode. 

 

 OUTPUTS 
General information 

The column on the right side of the screen displays the outputs. They create the home 
automation actions. 

DBIR01 
 Description 

8 bipolar relay outputs module. Option of communication of the relay by microswitch. 
Operational function when the potential-free contact is closed (by a switch or a direct 
connection). This option lets you manually control the relay without the presence of the 
Master. When the mircoswitches are switched, the CPU of the home automation can not 
command this circuit anymore. 
Possibility to view the operating time of the various outputs. Possibility to define a 
theoretical static consumption. 
 Edition of the module 
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• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Output setting: Name of the outputs. Durizing of the launching of the relays available in PC 
Active mode. Possibility to reset the operating time. Theoretical consumption field for 
theoretical consumption management. 

DDIM01 
 Description 

Dimmer interface module. Output card for the command of 1 to 8 Ddxxx type dimmers.  
 Edition of the module 

Right click on one of the outputs of the DDIM01 module and select the option Edit to get access 
on the module setting window. 

 Click on the horizontal arrows to scroll through the various accessible menus. Depending 
on the version of the module, some menus may not be accessible. 

• . Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• . Output setting: Name of the outputs. Option of memorization of the simmer intensity level 
before its final extinction (Remember last value). Possibility to view the operating time of the 
outputs. Minimum Value Option available from the firmware 32. Possibility to define a 
theoretical static consumption. From firmware version 34, availability of single edge mode 
for the control of DD10V and DD400L modules. 

DTRP01 
 Description 

Impulse switch module for the command of 1 to 4 impulse switches. During the manual 
command of the impulse switches, the CPU of the Home automation actualize the cards 
status.  
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 Edition of the module 

• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Output setting: Name of the outputs. Durizing of the launching of the TL2001 impulse 
switch device in PC mode Active, possibility to reset the operating time. possibility to view 
the operating time of the various outputs. Possibility to define a theoretical static 
consumption. 

DTRP02 
 Description 

Impulse inverter switch module for the command of motors with two directions of rotation. 
The command configuration of 2 x 2 impulse inverter switches allows the launching of 
two-way direction motor's. When manually failover of the TL1001 impulse switches, the 
CPU of the home automation refreshes the status of the cards. Possibility of setting a limit 
of time for the raising and the lowering. 
 Edition of the module 

• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Output setting: Name of the outputs. Durizing and stop management. 
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DTRV01 
 Description 

4 x 230V shutters module, for the command of motors with two directions of rotation. 
(shutters, screens, projection screen, solar tent, etc. Two connections without potential 
allow the manual control of the going up and down of the 4 outputs. The module is also 
equipped with LEDs indicating the relay status. Shutter management, type 'American', by 
pulse (pulse mode). 
 Edition of the module 

• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Output setting: Name of the outputs. Durinzing and stop management. 

From version 3 of the firmware of the DTRV01 module, going up and down time settings are 
available only in the module's configuration window (right-click on one of the outputs of the 
module > Edit). 

DTRVBT01 
 Description 

Low voltage (max 24 volt) direct current shutters module for the command of motors with 
2 directions of rotation. Use the consumption parameters to set the sensitivity of the end 
course. Durizing and back end course are programmable. 
 Edition of the module 
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• Module setting: Name, type, version and address of the module. Only to name of the 

module can be modified. 
• Output setting: Name of the outputs. Durinzing of the end of course management. 
• Consumption settings: Setting of the power and the motor supply voltage. Management of 

the stop sensitivity. The option back end course of shutter allows the inverted back course 
of the motor. It avoids leaving a mechanical tension in the reinforcements. In PC active 
mode, direct manual control of the module. 

DLED01 
 Description 

4 LEDs module programmed in function of the consumer's state, in function of a status of 
the application or turned on permanently. 
 Edition of the module 

• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Output setting: Name of the outputs.  

DOUT10V02 
 Description 

Output 0/1-10v on BUS module. The module (directly connected to the BUS) allows the 
management of systems and devices commanded by an analog signal of 0 to 10V or 1 to 
10V. Selection of the modes: 0 - 10 Vdc and 1 - 10 Vdc in the I/O settings of the module 
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 Edition of the module 

• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• I/O setting: Name of the output. Change in 1-10V mode(Normal mode : 0-10V), Possibility 
of the dimmer mode. By unchecking this option, it is no longer possible to use a long push 
to dimme the output DOUT10V02 (security used when a module controls the climate 
regulation). Option Remember last value. Timing function option available in PC active 
mode. Possibility to reset the Timing function.. 

DMR01 
 Description 

5 mono polar relay outputs module. The module is equipped with micro switches for 
activating the relay without the presence of the Master. Module with LEDs for the 
visualization of the relay’s status. Possibility to view the duration of the various channels. 
Possibility to define a theoretical static consumption. 
 Edition of the module 
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• Module setting: Name, type, version and address of the module. Only to name of the 

module can be modified. 
• Output setting: Name of the outputs. Duration of the relays launching available in PC active 

mode. Possibility to reset the duration. Theoretical consumption tab allows the theoretical 
management of the consumptions. 

DDMX01 
 Description 

Master interface for DMX512 protocol. DMX device (digital multiplexing). Allows dynamic 
control DMX devices (ex : strip LED RGB lighting type). Holds dimmer function and RGB 
LED's management. Number of managed DMX outputs: 64 (max 8 DMX drivers of 8 
outputs). 
 Edition of the module 

• Module setting: Name, type, version, address of the module and minimal duration of the 
color cycle. Only to name of the module and the duration of the color cycle can be modified. 

• Output setting: Choice of number of used channels (Max 8 channels for DMX slave 
modules). DMX address of the first channel used by the configured DMX slave. Name of 
the DMX slave. Configuration of the slave DMX channels: Name, Type (Red, Green, Blue, 
and Intensity). Minimum value (Min) and maximum value (Max) between 0 and 255. 
 Additional information: 

The DMX color cycle function start by the variation of the Red channel of the DMX 
interface. 

DINTDALI01 
 Description 

Master interface for the DALI protocol (Digital Addressable Lighting Interface). Allows 
dynamic control of lighting linked to a DALI device. Holds dimmer functions. Capacity: 
max 64 DALI devices available by DINTDALI01 interface. DALI protocols compatible in 
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Version 1.24.00: Type 0 (Fluorescent Lamps); Type 6 (LED). DALI commissioning 
function (equivalent to the Domintell network scan). DALI interface management function: 
Access to the settings of DALI internal parameters. Depending on the type of DALI 
devices connected access to the statistics of the device. 
 Edition of the module 

• Main window: Name, type, version and address of the module. Only to name of the module 
can be modified. Activation button of the DALI commissioning procedure. 

• DALI equipment management: Present modules list ; new modules and away modules. 
• Commissioning: List, parameters and characteristics of the detected DALI devices. Name, 

DALI type, EAN code, Serial number (Serial #), Version, Address (short addr.). 
 Additional information 

Access to information and advanced stings by right-clicking on the name of the DALI 
device included in the commissioning list. The changing of these values must be done by 
a professional with sufficient knowledge of DALI programming. Maintenance reporting 
tool available. 

DMV01 
 Description 

Interface for mechanical ventilation module. Works with 3 speeds of ventilation for the 
control of most dual flow ventilation devices. Three outputs control the ventilation speed, 
two outputs are free (ex: allows the launching of a lighting circuit). 
 Edition of the module 
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• Module setting : Name, type, version and address of the module. Only to name of the 

module can be modified. 
• Output setting : Name of the outputs. The first group of the 3 monopolar relays from the 

DMV01 output. The second group of relays contains the 2 auxiliary relays. 
 

 TOUCHSCREENS 
General information 

The displays contain the screen of the general management of the installation. 

DTSC02 
 Description 

TFT color touch screen. Allows viewing and the general control of the elements present 
on the BUS (home automation elements). Allows editing, setting and adjusting of the 
climate control, clocks and audio management. The module has a temperature sensor, 
an IR receiver, a micro SD (μSD) card reader, a connection to the Ethernet network and a 
passcode lock. Adjusting the intensity of the backlight. Setting the time and date. Drop 
photo frame function available. 
 Edition of the module 

• General window: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Input: Name of the inputs buttons, 2 press types(description in the general information of 
Input) 

• Output: Names of the outputs LEDs. 
• IP configuration: Choice of the IP address management mode of the module. DHCP 
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management (Dynamic Host Configuration Protocol) or by fixed IP address. 
• Lock screen: Name and choice of access code with 4 numbers. Only one code possible. 

The code 0000 prevents the appearance of a numeric keypad to enter the code. The screen 
locking is activated / deactivated by another output. 
 Additional Information 

Tools to take screenshot via http://<ip_du_dtsc>:17480. Automatic redirection to the 
generated picture in ftp://<ip_du_dtsc>/di_screenshotd/SCR_*.png 
To know the IP address of the module, Use the tools of diagnosis in the software at your 
disposal: The software GdethTester, the menu ETH DIAGNOSTIC present on the master 
(DGQG01) or the window flash of the module via Ethernet (Tools > Flasher > 
Firmware modules > Via Ethernet 

DTSC04 
 Description 

TFT color touch screen. Allows viewing and the general control of the elements present 
on the BUS (home automation elements). Allows editing, setting and adjusting of the 
climate control, clocks and audio management. The module has a temperature sensor, 
an IR receiver, a micro SD (μSD) card reader, a connection to the Ethernet network and a 
password lock. Adjusting the intensity of the backlight. Setting the time and date. Drop 
photo frame function available. 
Possibility to display the IP video stream display of the surveillance camera on the 
Ethernet network. Axis IP Camera Search Tool Axis. IP camera manual implementation 
tool. Setting of the time and the date. 
 Edition of the module 

• General window: Name, type, version and address of the module. Only to name of the 
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module can be modified. 
• Input: Names of the inputs buttons, 2 press types (description in the general information in 

the section Input) 
• Output: Names of the outputs LEDs. 
• IP configuration: Choice of the IP address management mode of the module. DHCP 

management (Dynamic Host Configuration Protocol) or by fixed IP address. 
• Screen lock: Name and choice of access code with 4 numbers. Only one code possible. 

The code 0000 prevents the appearance of a numeric keypad to enter the code. The screen 
locking is activated / deactivated by another output. 

• Volume: Setting of the audio volume in case of presence of the DVIP0x in the installation. 
 Additional information 

Tools to take screenshot via http://<ip_du_dtsc>:17480. Automatic redirection to the 
generated picture in ftp://<ip_du_dtsc>/di_screenshotd/SCR_*.png 
To know the IP address of the module, Use the tools of diagnosis in the software at your 
disposal : The software GdethTester, the menu ETH DIAGNOSTIC present on the master 
(DGQG01) or the window flash of the module via Ethernet (Tools > Flasher > 
Firmware modules > Via Ethernet 
 

 COMMUNICATIONS 
DGSM01 
 Description 

Communication module for SMS text messages. Allows the execution of actions on the 
system and receiving messages from the installation. Messages emission and reception 
directory configurable. A built-in battery allow you to send alarm messages at any time. 
Alarm message sending function in case of power shutdown and power restoration. 
Status diagnostic Tool of the DGSM01. Possibility of sending and receiving SMS 
messages to 200 phone numbers.  
 Edition of the module 
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• General options: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Status: In PC active mode, the button status allows you to view the following parameters 
state : Battery level, connectivity to the BUS, charging, module's temperature level, SIM 
card detection, state of the DGSM01 alarm, DGSM01 initialization, PIN code validation. 
PUK code menu. Menu Code PUK. After entering 3 times a wrong PIN code, the SIM card 
gets blocked. Insert the PUK code of the SIM card in the menu Code PUK to unblock it. 

• Input/output setting: Names of the input and the output. 
• Message sending: Allow you to send personalized messages, by choice, on a power loss 

or/ and on a power Restoration. The messages will be sent to a single number, the alarm 
number. 

• GSM option: Code PIN. Always use a PIN code. Do not use the code 0000, it is seen as an 
uninitialized SIM card code. N° message center : For more information, see the available 
list on the PRO Domintell website or contact your phone operator. 
 Additional information 
• . Configuration via Domintell2 
 During commissioning, the battery must be charged to allow the sending of a 

message. To achieve a sufficient level of battery, wait at least three hours. 
 Please insert the SIM card at the end of the module configuration. 
 Perform a network scan, the DGSM01 module appears in the input and the 

output columns. Indeed, the DGSM01 can receive and send SMS. 
 Right-click on the module icon. (Input or output column). Then click Edit. 
 A configuration pop-up appears. 
 Validate, in the choices the alarm messages for the information of the power loss 

and reconnection. 
 Enter the alarm number of the owner of the user of DGSM01 (ex : +32487326101) 
 Insert the sms server number of your phone operator. List 

(SMS_Message_Service_2008.pdf) available on the PRO website of Domintell. 
 All numbers must be encoded in the form: + _country code_number 
 Enter the PIN code of the SIM card. Do not select 0000 
 Transfer the application to the Master. 
 At the end of the application transfer, you can insert the SIM card into the DGSM01 

module. 
Check the status of the GSM module. 
• Other : Recharging a prepaid card can be done with the module or DGSM01 or the 

Domintell2 software. Using a mobile phone to recharge the prepaid card. 

DRS23201 
 Description 

Input / output Interface module for RS232 protocol. Allows the interconnection with 
systems such as air conditioning, alarms, home video etc ... Information sent and 
received by text messages. Connection to devices by female RS232 (DB9) connector. 
Central library for text messages management in Domintell2 software. Possibility to use 
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special characters. 
 Edition of the module 

The speed of data transmission (Baud rate) and parity of the module must be selected to 
allow the transfer of information. The "extended mode" allows you to send and receive 
characters whose ASCII code is between 0 and 31 (control characters) in hexadecimal 
form. 
 Additional information: 

The module DRS23201 commanded a single connection. The installation must contain as 
many modules DRS23201 as systems to interface. 

 For example, a message from an alarm center can lauch all the light spots in the house. 

General information DETH0x 
Before you use the DETH0x module, It is advised to transfer, a first time, the 
programming, vie the master (DGQG01) USB port. This connection allows the 
parameters configuration of the DETH0x module. 
 Module edition and general parameters 

Access to the properties of the DETH0x modules by editing the input of the DETH0x 
module. 
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Connection parameters 

If Use DHCP is selected. The module receives an IP address from a DHCP server 
present on the network. If the box is not checked, it is possible to enter a static IP 
address. 
The listening port defines the port on which the module can be reached. The default 
listening port is 17481. It is better to use a higher port number than1024. 
Session parameters 

By default, the module is configured exclusive session. When a session is opened, it is 
necessary to close this session before you can open a new session from a different 
computer. By configuring a non-exclusive session, any user who aks for a session 
opening takes hold of the DETH0x module. If a session was open it will be closed. An 
exclusive session involves defining a period of validity of this session. It will close 
automatically if no command is received during the expiration time of the session. 
NTP Parameters 

the NTP (Network Time Protocol) is a protocol to go back to the automatic time. The 
DETH0x modules offer all this functionality that replaces the DDCF01 module (Automatic 
time setting via the atomic clock of Frankfurt). The NTP option requires an internet 
access. Every day at 3am, a NTP request is sent to update the Master Clock. The NTP 
server address must be an IP address. The Search NTP server button can automatically 
find a domain name and configure the network gateway (read in the Windows 
configuration). 
The Search button allows you to find the IP address associated with the given domain 
name. 
The time zone (determined from the Windows local parameters) and the transition to 
summer time (if activated in the menu Tools-> Automatic time change) are managed by 
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the Master. 
 Advanced parameters 

Edit the MAC address only if the network has a card with the same MAC address (which 
must be unique on a LAN network). 
The MAC address is only stored in the module. 
For the opening of a session, it is possible to set a password. This password is only 
stored in the module, it is not in the *.dap file. 

DETH03 
 Description 

Ethernet communication interface. Connection between the home automation BUS and 
the local network (LAN). Allows the connection by Ethernet to Domintell2 configuration 
software. Possibility of dynamic and fixed IP address (DHCP). Session timeout option. 
Functionality of time setting by NTP connection (Network Time Protocol). Possibility to 
use a password. Modification a part of the MAC address of the module if necessary. An 
Internet connection is required to synchronize the time server. 
Information of configuration in the section General information DETH0x 
 Additional information 

To know the IP address of the module, use the diagnosis tools at your disposal : The 
software GdethTester or the menu ETH DIAGNOSTIC present in the master (DGQG01) 
 

 TEMPERATURE 
General information: temperature sensor 

Attention, some screens have temperature sensors for climate management. This chapter 
contains the strictly oriented climate control modules. 
Domintell thermal sensors have different profiles, fully configurable, for the management 
of the heating and cooling. 
So that regulation can properly perform each Domintell sensor must be set. 
 Basic parameters 
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Compensation  

The thermal sensors are not calibrated in the factory. This compensation is performed 
during the implementation of the system. Using a standard thermometer, measure the 
temperature at the temperature sensor. Enter the difference between the measured value 
of your reference thermometer available in PC active mode). 
Hysteresis 

Value used when the selection of an all or nothing regulation. Customizable value for 
each individual sensor. 
Absence temperatures 

Values used when the temperature sensor mode is in absence mode. 
Note: The absence temperatures are the sames for all the sensors. 
 Setpoint adjustment 

 
Setpoint adjustment 

Limitation of the setpoint adjustment (heating or cooling) in the different screens ( 
PBLCD02/DTSC02/DTSC04). The manual adjustment of the setpoint can not exceed 
those values. 
Setpoint incrementing : 

This value specifies the step of incrementing of the setpoint during the manual adjustment 
of the temperature setpoint.  
Rem: This value is the same for all the sensors. 
Rem: In absence and frost mode, the setpoint cannot be manually modified. 
 Display settings 

The display settings control the display of the temperature modes (automatic, absence, 
comfort and frost) and the regulation modes (Mixed, Heating, Cooling, Off) of the sensor 
at the displayers. (DTSC02 / DTSC04 / DPBLCD02). If the mode box is checked, the 
mode will be available in the temperature menu of the screen. 
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DTEM01 
 Description 

Temperature sensor module. Each minute, the module sends to the master the measured 
temperature. Allows the launching of an output according to a determined temperature. 
Actions management by logical test, according to a temperature mode (automatic, 
absence, comfort and frost) or regulation mode (Mixed, heating, cooling, Off) 
 Edition of the module 
• See the section : General information: temperature sensor 
 Additional information 

The regulation and temperature settings are in the Domintell2 software. 
 

DTEM02 
 Description 

Thermostat module. Allows the trigerring of outputs depending on a defined temperature 
with the possibility to edit the setpoint via 2 integrated keys on the module. Four modes of 
operation: automatic, away, comfort and frost. 
 

DFAN01 
 Description 

Control module for FAN COIL type air conditioners. Three relays control the fan speed. 
Two relays control the heating / cooling demand. The module must be used with a 
temperature sensor Domintell. Possibility of adaptation of the launching of the offset 
speeds. Selective menu Active air conditioning / heating. Test mode available in Master 
PC active mode. 
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 Edition of the module 

 
• Module setting: Name, type, version and address of the module. Only to name of the 

module can be modified. 
• Output setting: Launching value of the offset speeds of the ventilation. 
• Activation air conditioning/ heating: Possibility to validate/ cancel the temperature modes 

depending on the regulation modes of the air conditioning and the heating. 
 Additional information 

The temperature and regulation settings are in the Domintell2 software. 
 

 MISCELLANEOUS 
DRS23202 
 Description 

Light protocol RS232 interface. Interface module between the BUS Domintell and an 
input-output RS232. Allows the interconnection with various external systems such as 
PC, other touch screens other than Domintell's and other home automation systems. The 
actions on the Domintell system run by light protocol text code, the state of Domintell 
system is sent by this interface via a protocol available and delivered with the module. 
Connection to devices by female RS232 connector (DB9). 
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 Edition of the module 

 
• Module setting : Name, type, version and address of the module. Only to name of the 

module can be modified. 
 Additional information 

The data speed (Baud rate) is fixed at 57600 baud and without parity. 
The DRS23202 module is intended for integrators who want to interface their system 
(monitoring system, computer program, etc.) with Domintell. The purpose is to directly 
drive an installation module with a simplified protocol. The DRS23202 can receive 
personalized text (like the DRS23201) but not send it. 

DAMPLI01 
 Description 

Multi room audio amplifier. Allows the stereo sound broadcasting from 4 audio sources to 
4 audio zone of the configuration. The broadcasted sources come from independent 
auxiliary devices (ex : CD player, DVD player, tape player, etc.) or one of the four FM 
tuners integrated in the module. The DAMPLI01 has stereo outputs: 4 pairs (8 ohms). 
Output Power: 4 x 20 W RMS stereo. 
 Edition of the module 
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• Module setting: Name, type, version and address of the module. Only to name of the 
module can be modified. 

• Auxiliaries: Activating the auxiliary inputs by selecting the corresponding check boxes. 
Name of the connected devices in the corresponding fields to the used inputs. 

• Dedicated IR outputs: If presence in the installation of the DIREMIT01 module and a screen 
(with audio menu selection), the IR outputs of the DIREMIT01 allow the control of the 
auxiliary audio inputs with an IR receiver. 

 For example, The audio management of a room is controlled from a DPBTLCD0X touch 
switch. When I select the DVD audio source, it is possible to send IR commands to the 
DVD. By default, those are the IR codes of the previous and next actions.  

• Outputs setting: Names of the connected speakers, maximum value of the volume for each 
channel. Selection of the radio stations groups. Adjustment of the outputs channels 
balance. 
 Additional information 

The sources distribution between the different HP outputs of the speaker is independent. 
You can listen to the radio in the kitchen, enjoy a CD in the bathroom. For each output it 
is possible to select the source to broadcast and adjust the volume. When one of the 
tuners is on, it is possible to select a radio station or to adjust the frequency. 
Possibility to control the module from all the modules Input (push button, clock, remote 
control, ...) The functions dedicated to DAMPLI01 module are defined through the links 
created between the inputs and outputs of the module. The distribution of sources is 
also accessible by selecting the output from the touch screen. A window allows you to 
choose the type of source to broadcast and adjust the volume (and radio settings if the 
selected source is one of the tuners). 

 For a visualization of audio controls of the DAMPLI01, it is advisable to use a touch screen. 
Besides the range of screen proposed Domintell, it is possible to control the audio 
management via smartphone apps for Android, IOS, … 
 Selection of the radio stations 

From the menu Project > Station management, program your favorite FM radio stations. 
Possibility to directly scan the radio frequencies before saving them in the data base. 
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Crate the FM stations list: 
• Manual search: (Master mode and PC active Master mode) If you know the frequency of a 

radio station you want to add to the database, you can directly add it without doing 
research. 

Enter the frequency and the name of the station. The frequency must be 99.1 or 99.1 
form. 
The Attach button tests the frequency on the sound module (only if the Master is in PC 
active master mode). 
The station is added to the database by clicking Add. 
• Automatic search: (PC active master mode) 

This operation needs the transfer of the application in the master and to switch in PC 
active master mode. 
Steps to follow for the stations encoding: 

1. Select the audio output, physically the closest to you, with the buttons HP1, HP2, HP3 or 
HP4. 

2. Adjust the listening volume with help of the graduated bar. 
3. Start the research by clicking of the arrow buttons or  

Possibility to raise or lower the sound quality of the stations by moving the sensitivity 
cursor. 

4. When a station is detected, its frequency is indicated the frequency field. 
5. Name the station. 
6. Add the station to the database by clicking Add. 
7. Repeat the operations 3 to 5 to memorize all the wanted stations.  
The memorized stations appear in the right part of the window. 
The name or the frequency of a station of the database can be modified by clicking over it 
and changing the information in the manual research. 
To delete a station, right click on the station and click Delete. 
• Definition of the station groups: 

To limit the radio station number to a HP output, link this output to a station group. The 
selection action next and previous are limited to the selected stations. 
Steps to follow: 

1. Menu Project => Station group. 
2. In the central part of the window, right click and select the option Add. 
3. Name the new group. 
4. The stations previously memorized appear on the screen. Uncheck those you do not want 

on the group. 
5. Validate by clicking OK. 
The created groups will be assigned to certain outputs of the module (It is possible to edit 
the groups at all times. They can be removed only if they do not intervene in the module 
parameters. 
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DETH02 
 Description 

"light protocol" Ethernet interface. Interface module between the BUS Domintell and an 
Ethernet network. Allows the interconnection with various external systems such as 
tablet, smartphone, PC, touch screens other than Domintell and other home automation 
systems. The actions on the Domintell system run by light protocol text code. The state of 
the Domintell system is returned by this interface via the light protocol available and 
delivered with the module. 
Possibility of dynamic and fixed IP address (DHCP). Session timeout option. Functionality 
of time setting by NTP connection (Network Time Protocol). Possibility to use a password. 
Changing a part of the MAC address of the module if necessary. An Internet connection 
is required to synchronize the time server. 
Configuration information in the section General information DETH0x 
 Additional information 

A library (Windows / linux) is available ti encrypt the connection password. 
The configuration of the communication and of the security on the internet must be 
realised by a technician qualified in informatics networks. 
To know the IP address of the network, use the tool diagnosis: The software GdethTester 
or the menu ETH DIAGNOSTIC present on the master (DGQG01) 
 

 MODULES NOT COMPATIBLE ANYMORE SINCE GOLDENGATE 
DPULSE01 
 Description 

Interface of the home automation BUS has a triple pulse counter for monitoring the 
consumptions. The three independent pulse inputs are configurable by the configuration 
software. 

DIREMIT01 
 Description 

The DIREMIT01 module is a universal infrared remote control. Its 3 IR emitters allow the 
sending of IR codes to the infrared receivers (ex .: DVD player, TV, projector, radio, etc.). 
The module has a learning sensor (TEACH) to learn the IR code sequences. 
 

 MODULES NOT COMPATIBLE ANYMORE SINCE VERSION 1.24.XX 
General information 

This section contains the elements that are available in version 1.24.00. A part or the 
totality of the functionalities of those modules might not react in the programming. This 
information concerns specifically the module interconnection with the last Domintell's 
modules. 
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DTSC01  
 Description 

Monochrome touch screen that allows the viewing and control of the home automation 
points and the setting of temperatures, clocks, text, sound, etc. It includes temperature 
sensor, 32 channels IR receiver, access code. 

DTSC03 
 Description 

Color touch screen that allows the viewing and control of the home automation points and 
the setting of temperatures, clocks, text, sound, etc. It includes temperature sensor, 32 
channels IR receiver, access code. 

DLCD02 
 Description 

LCD module. Allow the viewing of the state of all the outputs and temperature sensors. It 
also allows the command of all the outputs and the modification of some parameters. 6 
buttons in which 2 are free of programming. 

DLCD03 
 Description 

LCD / temperature / sound module. Allows the viewing of the state and the command of 
the outputs and the temperature sensors. Allow the modification of some parameters. 
Has a temperature sensor, 5 buttons free of programming and 5 control pictures. 

DUSB01 
 Description 

Interface module between the Domintell BUS and an USB input-output. This module 
allows the interconnection external systems equipped with a USB connection such as PC, 
Computer, … The information is transmitted et received by text messages. 

DTEM02 
 Description 

Thermostat module. Allow the launching of the outputs in function of the determined 
temperature with the possibility to edit the setpoint via 2 buttons integrated to the module. 
5 functioning mode : automatic, absence, comfort, frost. 

DDCF77 
 Description 

DCF clock. Connect to the Domintell BUS. It puts the system to the exact time every 
minutes as soon as the synchronization is done. This module works with the free receipt 
from the signal of the atomic clock of Frankfort (DCF77). 

DGRAFINT01 
 Description 

USA interface – graphic software. Interface by USB connection. Allows the control and 
the consultation from help of the Domintell visual software. Graphic support as wallpaper 
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by importation of pictures JPEG, BMP, ICO or WMF (same as DETH04). 

DETH04 
 Description 

Ethernet / Internet interface – Graphic Domintell visual software. Ethernet / Internet 
communication module. Use: Online graphic software (same to DGRAFINT01), NTP. 
Allows the command of the Domintell visual program by Ethernet / Internet connection. 

DETH07 
 Description 

Philips Pronto remote interface. Bidirectional Ethernet interface to the Pronto command of 
Philips. Allow you, by connecting this module to a wifi connection, to control its Domintell 
installation with the Pronto command of Philips. 

 

 LINKS 
Basic action 

The main element in the Domintell2's programming is the Drag and Drop. It is the fact of 
taking an element from the Outputs (right of the screen) and displace it to the Inputs (left 
of the screen). A link joins an Inputs to an Outputs and create a specific action between 
those two components. 
 

Select  Drag  Drop  Choose the action 

 Since the version 1.16.xx, the displacements drag and drop in the Domintell2's program are 
always made from the right column to the left column. 

Steps to follow to create a link: 

1. Select a component in the Outputs column.  
2. Hold the left button of your mouse. 
3. Move the selected component to a component in the Inputs column. 
4. Release the button of your mouse when the Output component is on the desired Input 

component. 

If the link is not possible, a forbid sign appears right next the selected component. 
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5. When you release the button of your mouse, a dialog box tells you to set the link up. 

Links configuration 
A dialog box appears at the end of the drag and drop manipulation. The options within the 
dialog box depends on the technical characteristics of the Input module and the Output 
module related to the link.  
Here is a dialog box which appears as a result of the link created between an interruptor 
module (Ex: DPBT02-LG) and a relay module (DBIR01). It shows every setup available 
for the link created. 

Pression types on the Input module  

This setup sets the Output link on a short push or long push from the Input. A push is 
considered as long when it takes more than 0.4 seconds. 
To select the option long push, select the function 2 press types in the Input module 
setup. 
Select 2 press types only if two different actions are related to the input. Ex : A 
temporizing on the short push and an action ON/OFF alternated on the long push. 
The actions like dimmer function and shutter function sets automatically the option 2 
press types. 

  Warning: do not validate the long push without programming the link on this button using 
the 2 press types. Without programming, the users exceed the short push time and arrive in 
the long period. And so, to no have any action. 
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Steps to follow: 

1. Select the Input tab (1)  
2. Click on the button Card setting (2)  
3. Check the square 2 press types related to the link's Input (3)  
4. OK. 

The option Action on end of push allows you to make the link only during the release of 
the Input (rising edge) 
The setup of each module is mentioned in the rest of this manual. 
 Inversion of the input's signal : 

The function inverted allows you to invert the signal transmitted by a captor. It is used 
when the contact of a captor is a contact normally closed (NC) or when the consumer 
connected to the output is normally closed (NC). 
Function available from the setup screen of the input module of the type button or 
DISM0x.  
 

Basic actions: Relay type output module on button type input 
 Relay actions 

The actions of an input module, button type, dragged and dropped on a relay type 
output is presented as below. The actions described from here are applicable to the 
following modules: 
• DBIR01 ; DTRP01 ; DLED01 ; Auxiliary Output DMV01 ; DMR01. 
• Leds from the button type input modules DPBU0x. 
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ON/OFF Alternated 
Alterned activation or shutting OFF the output 
ON 

Activation from the Output. 
OFF 

Shutting OFF the output. 
Maintain 

Activation of the output while the pressure, shutting OFF while release. 
Timer 

Activation or deactivation of the output during a predefined time. 
The selection of the action's duration brings up the following setup. They program 
duration's time on the output. 
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1. The option Start action > ON Turns on the output for a fixed time.  
2. The option Start action > OFF turns off the output for fixed time then turns it on. 
3. The option duration lets you chose the duration, 
4. The option Action on new press allows to chose three types of action during a new push of 

a duration time.  
• You can have a reload during the duration time.  
• You can have an execution of the ending action.  
• You can have no action at all as well.  

If an action is activated by another input of the system (Switch, clock, …) on the same 
temporized output, the current duration will be canceled.  
 Delay 

The delay allows you to delay the execution of a link. 

The selection of the Delay tab allows you to male the retardation of the action on the 
output. 
The option Action on new press allows you to chose between four types of actions during 
a new push during the delay's time. 

1. You can have a reload of the delay's time. 
2. You can have a stop. It deletes the delay and the execution of the link. The output will not 

be activated so. 
3. You can have a link execution. The delay is canceled and the action takes place directly. 
4. You can have no action at all. The delay runs until the execution of the action. 
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  The delay is often used during a general execution of the house. It allows you to not find 
directly yourself in the dark. For example, the user has a minute to get out, close his door 
and enter the car. 

  By letting the pointer of your mouse more than 5 seconds over one of the mentioned 
actions, the action's description appears. 

Basic actions : Dimmer output type module on a button type input 
The actions of a button type input link over a dimmer type output is shown as below. 
The actions described from here are applicable to the following modules : 
• DDIM01 ; DOUT10V02 ; DDMX01 ; DINTDALI01 

The ON/OFF, ON, OFF and Maintain actions are seen in the section  Basic actions : Relay 
type output module on button type input. 
 Dimmer actions: 

Dimmer value 
It allows you to turn on a spot to certain percentage of its maximal value. To turn off the 
output, you need to create a second like or select the action Value/OFF alternated. 
The rise time is the time in which the spot will take its selected value. 
Dimmer function 

This action allows you to chance the spot's value in function of the pressing time on the 
input. 
A brief action on the input, when the spot is turned off, turns on the spot to its maximal 
value. A brief action on the input, when the input is turned on, turns off the spot. 
A long action on the input change the percentage of intensity. 
Duration action 

This action allows you to turn on a spot for a fixed time. The rise time and the value are 
customizable from the Dimmer tab. Basic information about the duration in the 
section  Basic actions : Relay type output module on button type input. 
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Value/OFF alternated 
The action turns on a spot to a certain percentage of its maximal value. 
An action on the input when the spot is turned off creates its lighting to the selected 
value. 
An action on the input when the spot is turned on creates its extinction. 
The rise time is used for the lighting and the extinction of the spot. 

Basic actions: Shutter/ Motor type output modules with two directions on a 
button type input 

The actions of a button type input link on a Shutter/ motor type output with two directions 
is shown as below the actions described from here are applicable to the following 
modules: 
• DTRV01 ; DTRP02 ; DTRVBT01 

Two directions shutter actions: 
Up 

The action allows you to automatically make the shutter go up. The setup on the screen 
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below shows the rise time of the shutter. 
Down 

The action allows you to automatically make the shutter go down. Just like in the action 
« up », it is possible to tied a time to the action. 
Up with hold 

The action allows you to make a shutter go up by combining the long push and short 
push. The short push to add a durizing to the up action. The long push allows you to 
make the shutter go up with retention. 
Down with hold 

The action allows you to make the shutter go up manually by combining the long push 
and short push. The short push allows you to add durizing to the action. The long push 
allows you to make the shutter go down with retention. 
Shutter function 

The shutter function controls the going up and down from a single button. The long and 
short pushes are automatically selected. 
A short push on the active control button activates the going up or down of the shutter. A 
new push during the going up or down stops the movement. If no push is done during the 
movement, the shutter will stop ate the end of fixed duration. 
A maintain push on the control button activates the manual going up or down of the 
shutter the movement stops when the button is released. 

 The going up and down commands are alternated. A going up command will always be 
followed by a going down command. So two going up or down commands are impossible in 
this function. 
OFF 

The action allows you to stop instantly the shutter whatever the movement. 
Up pulse 

During the automation of the venetian blinds (American shutter), it is possible to control 
plates orientation by the launching of successive pulses of the relay. The action allows 
you to send a number of rising pulses during a high time period. The number of pulses is 
separated by a break period. 
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Down pulse 
During the automation of the venetian blinds (American shutter), it is possible to control 
the plates orientation by the launching of successive pulses of the relay. The action 
allows you to send a number down pulses during a high time period. The number od 
pulses is separated by a break period. 
American shutter function raise 

During the automation of the venetian blinds (American shutter), it is possible to control 
the plates orientation by the launching of successive pulses of the relay. The action 
allows you to make the shutter go up manually by combining the long push and short 
push. The short push allows you to add duration to the rise. The long push allows you the 
make the launching by pulses with retention. 
American shutter function drop 

During the automation of the venetian blinds (American shutter), it is possible to control 
the plates orientation by the launching of successive pulses of the relay. The action 
allows you to make the shutter go down manually by combining the long push and short 
push. The short push allows you to add duration to the drop. The long push allows you 
the make the launching by pulses with retention. 
American shutter function 

The American shutter function allows you to control the going up and down as well as the 
swiveling by pulses from a single button. The short and long pushes are automatically 
selected. 
The short push on the active control button activates the going up or down of the shutter. 
A new push during the going up or down stops the movement. If no push is done during 
the movement, the shutter will stop at the end of fixed duration.  
The long push allows the launching of pulses with retention, upwards or downwards, 
depending of the last movement of the output. 

 The going up and down commands are alternated. A going up command will always be 
followed by a going down command. So two going up or down commands are impossible in 
this function. 

 

 LINKS ON ANALOGICAL INPUT MODULE 0-10V : DINT10V02 
The links presented in this part are available if the module DIN10V02 is in analogical 
Input mode. In case of a validation of the temperature input mode, see the following 
section Temperature management. 
 Management of an action according to the tension level 0-10V 

The creation of a link on the module DIN10V02 is done in function of an analogical value. 

1. Action if the analogical value is Above a tension level of 0-10V  
2. Action if the analogical value is Under a tension level of 0-10V  
3. Action if the analogical value is Equal to a tension level of 0-10V  
4. Action if the analogical value is Between a tension level of 0-10V  
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For a dimmable output, the action can be done in function of a mathematics function. 
Select Function, right click on the graphic and Edit.  
Create a function by clicking on the graphic. The INPUT value (analogical signal) is on x-
axis. The OUTPUT value is on the y-axis. The function can be done in continue or step by 
step. Save the function by clicking OK. 

 
During the editing of an existing function, you have to possibility to edit or add a new 
function.  

 Example : Use a luminosity sensor emitting an analogical signal 0-10V connected to the 
DIN10V02 module. Depending on luminosity intensity level, the dimmer interfaces of the 
room will adapt themselves to diffuse a constant luminosity. 
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 LINKS DRS23201, DUSB01, DRS23202, DETH02 , DRS23203 AND 
 DGSM01 
 Messages manager of the modules DRS23201 / DUSB01 

The creation of a link with the module DRS23201/DUSB01 make appear the following 
window: 

 
Selects the text to be handled an validate by clicking OK. 
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 Output activation on text reception 
This action is obtained when an Output is linked to the Input of the module 
DRS23201/DRS23202/DETH02/DUSB01 (in the central part of the screen). 
To Add a new message, write it in the text entry field. Click Add to insert it in the list. 
Attention, the size of the texts cannot go over 32 characters. 

 
If the ''extended mode'' is activated, the codes ASCII included between 0 and 31 must be 
written in decimal (always two characters) and surrounded by the characters ''<'' and ''>''.  

 Example: To send STX and GS, you have to write "<02><19>" (without the quotation mark). 
 Management of the messages for the module DETH02 

Except of the configuration window, the module DETH02 has the same functionalities 
than the module DRS23202. 
Outside the use of the Domintell's Light Protocol of Domintell, possibility to create inputs 
links on the module DETH02. This functionality controls the Domintell's system due to the 
sends of others text messages than the ones used by the light protocol. 
 Management of the messages for the module DGSM01 

The DGSM01 interface has the same functions as the modules DRS23201 and DUSB01. 
In the case of the module DGSM01, The element that makes the action is the reception of 
a phone text message. The action of the module is the sends of a phone text message. 

 Example: The module DGSM01 sends a text message to let you know of an intrusion. It is 
possible to send a text message to the DGSM01 to turn on all the lamps of the installation 
and to scare the thief. 

The management of the phone numbers are established in the Contacts. (Project > 
Contacts). 
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The phone directory contains the phone numbers of the persons who can receive and 
send messages to the DGSM01. In order that a message sent from a certain phone 
number can initiate an action, the phone number must be listed in the phone directory 
and must have the quality accept command. 

 
• Link DGSM01 as an Output (Sender of the text message) 

1. Make a drag and drop of the output DGSM01 on an input module (ex : button).  
2. Enter the wished text. 
3. Validate by clicking OK. 

 Example : The water level sensor in your cellar get activated, the DGSM01 sends the text 
message 'FLOODING'.  

• Link DGSM01 as an Input (receiver of the text message) 

1. Make a drag and drop of an output element (ex : kitchen lamp) on an input element of the 
DGSM01 . 

2. Choose a text making the action 
3. Choose the action to make.  
4. Validate by clicking OK. 

 Example: I leave quickly the house. After 15 minutes, I realized that I didn't turn off some 
lamps. I sen a group message to all my lamps OFF to make a general lights out. 

 

 LINK DMV01 
The module has 3 outputs of ventilation's management and 2 auxiliary outputs. The 
links management of the auxiliary outputs works as a relay for the module DMR01. For 
their configuration, see the section Basic actions : Relay type output module on 
button type input. 
 Ventilation link on button type output or clock type output 

The actions that control the ventilation are: 
• The launching of specified speed. OFF, Speed 1, Speed 2, Speed 3. 
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• The increase of the speeds with a possibility to loop the values. 
• The decrease of the speeds with a possibility to loop the values. 
• The stop of the module. The 3 relays are released. 

 
 Ventilation link on analogical input 0-10V (DIN10V02) 

According to the analogical value, possibility to launch the ventilation's speed(s). To set 
the management of the analogical values of the DIN10V02, see the section Links on 
analogical input module 0-10V: DINT10V02 p(76) 
The control actions of the ventilation in a link with a DIN10V02 are : 
• The launching of a specified speed. OFF, Speed 1, Speed 2, Speed 3 
• The stop of the module. The 3 relays are released. 
 

 LINK DAMPLI01 
The module DAMPLI01 is an audio amplifier which allows you to spread the stereo sound 
from 4 audio source to 4 audio zone of the configuration. The spreaded sources come 
from the auxiliary independent devices (example : CD player, DVD player, tape drive, 
Blue Ray, Audio Server,etc) or from one of the four FM tuners inside the module. The 
amplifier has 4 outputs, on each of them a pair of speakers are connected.  
To configurate the basic settings of the DAMPLI01, see the section Selection of the 
radio stations. 

 For a visualization of the audio commands of the DAMPLI01, It is better to use a touch 
screen. Besides the screens offered by Domintell, it is possible to control the adio 
management via smartphone's applications (Androïd, IOS, …). 
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Link creation on the outputs of the module DAMPLI01 
The use of the module DAMPLI01 needs the creation of links between the configuration 
inputs and the outputs of the module DAMPLI01.  
The actions being exclusive, select them one by one from the 3 main types (Volume, 
Tuner et Source). To make the launching of a radio with 50 % of its volume, you have to 
make 2 links as shown below. 

Reminder, each pair of speakers connected to the module is considered as a single 
output.  

1. Link of an audio output on a button 

Volume control 

 Off: this action stops the output. 
 Rise the volume: this action increase to 2 db (decibels) the volume of the output from each 

pulse on the input. A long push on the input creates the dynamic increase of the volume. 
 Lower the volume: this action decrease to 2 db the volume of the output from each pulse 

on the input. A long push on the input creates the dynamic decrease of the volume. 
 Volume: This action allows you to obtain the percentage of the volume defined from the 

dropdown list Volume. It is possible to set the transition time. 
 Volume ON/OFF: This action activates and cuts the output in a single link. A first push on 

the link's input allows you to obtain the percentage of the volume defined from dropdown list 
Volume. A second push allows you to cut the output. 
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 Volume Function: This action allows you to increase and decrease the volume from a single 
input. The commands increase and decrease are alternated: an increase command will be 
automatically flowed by a decrease command of the volume, and vice versa. The short 
pushes allow you the stop or to launch the output. The long pushes allow you to edit 
dynamically the volume applied to the output. 

For Volume function, Rise the volume and Lower the volume, the short and long pushes 
are selected automatically. It is possible to command sequentially (by steps of 2db) or 
dynamically the output. 
It is possible to choose a rise time for the actions Off, Volume et Volume On/Off. It is the 
period taken by the output to reach the defined volume. This setup is defined from the 
dropdown list of Rise time. 
Control of the radio stations: 

 Up seeking: Allow you to make the increasing scans of the radio stations. 
 Down seeking: Allow you to make the decreasing scans of the radio stations. 
 Frequency: Allow you to reach directly the radio station of which the frequency must be 

indicated from the tab Frequency. 
 Station: Allow you to reach a radio station memorized in the data base. The choice of the 

station takes place in the dropdown list Station. 
 Next Station and Previous Station: Allow you to review the stations contained in the stations 

group of the output. 
Control of the sources: 

 Selection source: Allow you to select directly one of the sources connected to the module 
DAMPLI01. The source selection takes place in the dropdown list Source.  

 Next source and Previous source: Allow you to review the different auxiliary sources 
connected to the module DAMPLI01 (Ex: Blue Ray, Computer, Television, etc.) 

2. Link of an audio output on a clock. 
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Action 
 Off: this action stops the output. 
 Volume: This action allows you to have the percentage of the volume defined in the 

dropdown list Volume. It is possible to set a rise time. 
 Frequency: Allow you to reach directly the radio station in which the frequency must be 

indicated from the tab Frequency. 
 Station: Allow you to reach a radio station memorized in the data base. The choice of the 

station takes place in the dropdown list Station. 
 Selection source: Allow you to select directly on of the sources connected to the module 

DAMPLI01. The selection of the source can be done from the dropdown list Source. 

 

 LINK DTSC02/DTSC04 
This part retakes the functionalities screen locking and video DTSC04. The links 
concerning the indicator LEDS are in the section Basic actions: Relay type output 
module on button type input. 

Programming the actions buttons 
Each screen has 4 programmable Action buttons. 

Those buttons are touch buttons from which it is possible to program links. The settings 
and the name of those buttons are modifiable. They are visible when a link is created. 
 

Icon Selection 
Possibility to edit the default icon. The icons are in a directory. From the menu Project > 
Icon selection.  
Steps to follow: 

1. Select the element type (inputs, outputs, probes, floors/rooms, ambiances, memos,...) 
for which it needs an icon modification. Look in the dropdown list on the up right corner part 
(1). 

2. Select the element for which the icon mus be replaced. Look in the right column (2). The 
default icons appear on the up left part (3). 

3. Select in the repertory (4) The icon which represents the element when it is ON. Drag and 
drop it in the case Image ON. Make the handling for the other status. 
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Masking some elements on the touch screen 
Some elements of the installation may not be displayed.  
Steps to follow:  

1. Select the element that you do not want to display. 
2. Click on the green v « » to mask the element of the screens. A red cross «» to the left of 

those elements shows that they are not displayed on the screen. The lights, the inputs 
and the variables are masked by default.  

 An interesting function when the outputs of the installation are unused or when variables or 
memos do not need to be command. 

Screen setting 
By default, the display of elements on the screens DTSC0x follow a tree diagram 
configuration established in the first column of Domintell2 software. 
Possibility to have a different display for each screen in the house. Possibility to set the 
order of elements, display or hide certain elements. Setting becomes essential when the 
installation includes several touch screens and that is necessary to distribute the 
commands according to the location of each screen. 
The defined settings will apply only for the concerned module DTSC0x. All changes made 
to a local display, will no be transferred to the other screens of the installation.  

 Example : An industrial building has 2 screens DTSC0x. The installed screen in the director's 
office can command all the installation, the screen DTSC0x of the reception commands only 
the room in the front part of the building. 

To get access to the screens setting : Right click on one of the action keys of the screen 
to be set > select the option screen settings. 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    70 
TVA : BE0429942701  
 

The left part of the setting window has: 
• The menu Displayed Components. It contains all the elements that are shown on the main 

screen. 
• The temperature menu. It contains all the temperature sensors, the temperature modes 

and the temperature profiles which are shown in the submenu air-conditioning management 
of the screen. 

• The Clock menu. It contains all the clocks created that can be shown in the submenu Clock 
management of the screen. 

The right side of the setting window includes different elements that can be displayed in 
the screen or the menu. 
 Default Configuration 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    71 
TVA : BE0429942701  
 

Each screen is set according to a default display:  
• The configuration of the house appears as it was created; 
• the outputs are displayed by type and ascending order of module's serial number; 
• the lights, the inputs and the variables are not displayed ; 
• the masked elements from the icon selection's window are not displayed. 

Personalize the tree diagram of a local screen by unchecking the option Use default 
configuration. 
 Setting possibilities 
• Definition of the elements apparition's order : 

Organize the main screen by manipulating vertical drag and drop on the left part of the 
window. 
• Delete elements : 

Right-click and delete the elements that should not appear in the main screen. The 
elements return to the right part of the configuration window. 
• Add elements : 

By manipulating drag and drop from the right part of the configuration window, add 
elements that are not in the main screen. 
• Names and icons modification of rooms and floors : 

Right click on the element to edit and replace the names and / or icons defined for the 
rooms and floors. 
The icons for other types of elements (inputs, outputs, memos, ...) are common to all 
screens and can not be changed from the touch screens settings window. 
To edit them, see the section Icon Selection. 

Modules hiding 
Some menus and touch screens settings can be protected. From the Screen layout of a 
DTSC0x, select the Displayed items tab. 
The masking of one of the menus deletes the access to all the setting it contains.  
Disable menus and settings to hide by deselecting them from this screen. The disabled 
menus and setting are shown with a red cross «». 

 If the screen needs an OS modification. See the section: Pre-programming operations. 
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Locking screen's link 
 
The screen lock allows you to block access to the features present on the screen during 
the lockout period. Lock the actions are identical to those of a relay module type. For 
more information, see the section Basic actions: Relay type output module on button 
type input. 
Setting the locking code through the editing window of the touch screen in the section 
Lock screen. 

When pressing on the screen, if the lock is activated, a numeric keypad appears. Enter 
the code to unlock the screen. 
When selecting the 0000 code, no numeric keypad appears on the screen. In this case, 
the unlocking must be done from another input element of the system. 

  Example: When launching the alarm system, it warned the home automation and locks the 
touch screen. It is necessary to disarm the alarm system for the screen to be again 
available. 
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DTSC04 video link 
The screen DTSC04 allows you to display the video stream from the videophone DVIP01 
and the IP camera(s) installed on the network.  
 Video link 

By manipulating drag and drop, make the link creation window appear. The possible 
actions are: 
• Start camera 
• Stop camera 

 
Possibility of an automatic disconnection after a fixed time.  
 IP cameras management 

The menu Project > IP cameras control shows the cameras list within the application.  
 Implementing IP cameras other than DVIP01/DVIP02 
• For IP cameras AXIS2: Click on the button IP cameras scan 
• For other IP cameras with a contact URL: Manually enter the connection parameters, IP 

address, and URL. 
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To know the camera URL to encode, read the manufacturer's specifications of the 
camera or visit ISPY connect. 

http://www.ispyconnect.com/sources.aspx#info 

 Example : For the IP camera IP D-LINK DCS 2121, the URL from is : 
http://IPADDRESS/video/mjpg.cgi .  

In the Domintell2's software, you have to write: /video/mjpg.cgi 
The default communication port is the port 80. The login and password are those used by 
the IP camera. 
• To validate, click Apply changes and OK. 
 

 MULTIPLE LINKS CREATION 
It is of course possible to control several outputs from one single input. The principle is 
the same as with classical links. You need simply to drag and drop all outputs one after 
the other to the selected input. For each link created, a dialog box will appear in which 
you will be able to program the type of link and define the configuration. 
If the actions of multiples inserted outputs are the same, see the section Group. 
 

 

http://www.ispyconnect.com/sources.aspx#info
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 ADVANCED FEATURES OF THE APPLICATION 
This section contains the steps to follow to create a link not included in the section Basic 
actions: Relay type output module on button type input. 
 

 ATMOSPHERE 
The Atmospheres management allows you to change the configuration of home 
automation players in one action. An atmosphere includes several outputs (bright spots, 
shutter controls, infrared codes, etc.). Adding a scene assigns default values to the 
outputs. By manipulating drag and drop, the programmed scene is linked to an input. 
The Atmospheres management allows you to centralize a programming of several links 
between different outputs and one input. The same scene can be slid over several 
entry. 
The recording function can memorize the current values of the grouped outputs. These 
values are applied during the next pressing on the entry dedicated to the execution of the 
atmosphere. 

Creation of the atmosphere players list 

1. Select the outputs to be command together. (relay, dimmer, shutter, variables, SMS, 
etc..). 

2. Right click on the Atmosphere icon => Add a new group. 
3. Name the new atmosphere. 
4. By manipulating drag and drop from the right column to the left one, build a list of 

outputs included in the atmosphere. 
5. Click OK to validate. 
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Scenes creation 
Determines the values of each outputs that form the atmosphere. For the same 
atmosphere, it is possible to create a maximum of 8 different scenes. 

Steps to follow 

1. Right click on the atmosphere previously configured and select Add scene.  
a. The column Name shows the selected outputs, 
b. The column Action shows the type of action applied to the outputs, 
c. The Settings column shows the value associated with the type of action. This 

column is completed in the case of a command by dimmer, by an audio control, ... 
2. Rename the scene 
3. In the column of names, select the desired output. Select the corresponding checkbox in 

the Action column. Select an action associated with the output. 
4. If the action is configurable, the sphere settings of the window displays the various 

parameters related to the selected action type. 
5. Confirm by pressing Apply. These settings are now displayed in the Settings column at the 

configured output. 
6. Make the moves described in the points 3 and 4 for all the outputs of the group. 
7. End the configuration of the scene by pressing OK. 

 For example: The living room of a house is equipped with dimmers cards (DDIM01), 
shutters (DTRV01), audio (DAMPLI01) and an infrared transmitter (DIREMI01). These are 
selected and form the atmosphere LIVINGROOM. This atmosphere comes in 3 different 
scenes. 
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• The cozy scene : the dimmers are at 70 % and a sweet music is turned on. 
• The cinema projection scene : The screen goes down, the projector is turned on and the 

dimmers are turned off for a period of 5 minuts. 
• The Eco scene: A lamp is dimmed at 70 %. The audio and the projector are in standby. 
• The OFF scene: All the players of the athmosphere LIVINGROOM are turned off. 

Scene execution 
Running an atmosphere requires the creation of a link between an input and one of the 
previously created scenes. By drag and drop, move the desired scene on a home 
automation input. When creating the link, select Execute scene. 

Atmospheres registration 
The registration of an atmosphere is, at a specific time, to memorize the output values 
of the players of the atmosphere. The registration creates a virtual scene. Those status 
are registered in the RAM of DGQG01. 

 The execution and recording of a scene can be made from a single entry. Then use the 
short press function for the execution and long press function for the recording. 

 For example: We suppose that the values of the show lights when the "video" scene is 
activated no longer satisfy the occupants. It is then possible for them to adjust the values of 
these lamps and then memorize them by pressing an entry (button or other) which is 
reserved for this function. The values will be memorized only for this scene. The values 
programmed for the other scenes therefore remain unchanged. 
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 GROUP 
The groups allow you to combine several outputs (of the same type or of different types) 
into a single output. In a single link, a group can change, to a same state, the status of 
several outputs. 
Different types of groups: 
• The basic group : Groups the following outputs : DLED01, DMR01, DBIR01, DTRP01, 

DDIM01, DOUT10V02, DAMPLI01, DIREMI01, leds/images control switches and variables. 
• The shutter group : Groups the outputs of two steering motor, Mainly the shutter. (DTRV01, 

DTRVBT01 and DTRP02). 
• The dimmer group : Groups only the dimmable outputs (DDIM01 et DOUT10V02). Only 

this type groups allows the actions with function dimmer, dimmer value and alternated Off 
value on grouped dimmer outputs. 

• The sound group : Groups the outputs of the modules DAMPLI01. 
• The FAN group : Groups the outputs of the modules DFAN01. 
• The DMX group : Groups the outputs of the modules DDMX01. 
• The screen group : Groups the video outputs the screens DTSC04. 
• The led group: Groups the led outputs of the DPBR0x and DPBL0x. 
• The DMV group : Groups the outputs of the modules DMV01. 
• The DALI group: Groups the channels DALI of the DINTDALI01. 

Creation of a group 
Steps to follow: 

1. Right click on the groups icon of the outputs column. 
2. Rename the new group. 
3. With a drag and drop, from the right column to the left one, build the list of outputs 

included in the group. To add more outputs at once in the group, select the desired 
outputs and click the button      . Possibility to delete one or more outputs of the groups 
by clicking on the single arrow       or the general arrow      . 
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 Use a group once several outputs of the same type must be ordered by the same input. 
This allows you to easily put this output group to another input. The group avoids the 
unsynchronization of the link, because the entire group adopts the same state. 

Modification of a group 
Possibility to change the composition of a group to add or remove one or more outputs. 
Right-click on the group > Edit 
For the sake of the stability of the application, it is impossible to delete a group if it is 
used in a link. We must first remove the link to be able to delete the group. 

Creation of a group link 
From a programming perspective, a group is considered as a single output. The creation 
of a link group is the same as the creation of a link between an input and an output. 
The group's state is the state of the first element of the list of elements making the group. 
The offered action depends of the group type. For more information, see the section 
Basic actions: Relay type output module on button type input. 

 The basic group can only perform basic actions (ON / OFF alternated, ON, OFF, hold, delay) 
even if it is made only of dimmer modules. 

 

 THE FOLLOWERS 
Manual followers 

The follower function allows you to postpone the status of an output on another output 
regardless of the command executed on the first one. 

 The manual follower is used when neon ballast is controlled by a controller 0-10V. In some 
cases, it is necessary to turn off the ballast power when the controller is at 0%. 

Steps to follow: 
1. Select the following output and move to the follower icon in the inputs column. 
2. In the dialog box, select the followed output; 
3. Validate by pressing OK. 

When a follower function is assigned to an output, it is no longer possible to assign 
another follower function to this output. 

 When multiple outputs must follow a single output, group within a group the different 
follower outputs. Link the group at the output to follow. 

Automatic followers 
Since the 1.16.13 version, it is possible to automatically generate followers for leds of the 
push buttons (images of DPLCD modules are treated as LEDs).  
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Steps to follow: 

1. Create links between the outputs and the inputs with LEDs. 
2. Right click on the follower icon, choose spawn following groups. 
This feature creates a group of LEDs in the column of the outputs and a follower in the 
column of the inputs. The follower in the inputs column links the output that will change 
the state of the group of led which was just created. 
The follower is generated if a link is programmed and that the LED or the image of the 
input module is not included in another part of the program (in a link, a condition, a 
group, an atmosphere …) 

 For example: An automatic follower generated for the link of a relay of a DBIR01 module 
controlled from a single button.  

 For example: An automatic follower generated for the link of a relay of a DBIR01 module 
controlled from many buttons.  
 Erase all the links of the programming. At the end of the programming, generate the 

follower group. 

 

 PERIODIC ACTIONS 
Events that repeat at regular intervals, for each configured period of time. The first period 
begins at the end of the initialization of the master, just after the transfer of an application 
or a DGQG01 restart action. 
The diagram below illustrates the control of an output from a periodic action. The 
function that links them is an action ON / OFF alternated. The event is repeated after 
each period. 
The purpose of these events is to perform repetitive actions without requiring intervention 
from the user. 

 

 For example: A heating system has several circuit. When at least one circuit is in demand, 
the circulator must get turned on. When no circuit is in demand, the circulator must stop. A 
periodic verification provides a quick solution in this type of programming. 
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The Periodic action can regularly check the output states grouped into a group. 
Depending on the status of one or more outputs of the group, a type of programmed 
action can take place. 

 To avoid overloading the communication on the bus, limit the number of events with short 
period(five seconds is the minimum time recommended). 

Creation of a periodic action 
Steps to follow: 

1. Right click on the Periodic actions > Add an action 
2. Rename the new action. 
3. Choose the period time 
4. Validate by pressing OK. 

 For example: The event Action Watering performs an action on the outputs on which it is 
linked every hour and 30 minutes. 

Creation of links from a periodic action 
Using a periodic action requires the creation of a link between it and the outputs to 
drive. By manipulating drag and drop, program the links. For more information, see the 
section Basic actions : Relay type output module on button type input. 

 Some links are shown in the section Basic actions: Relay type output module on 
button type input are not available in the function periodic actions. A link with a relay 
module does not allow a hold action. 

 

 ONCHANGE EVENT 
Event that runs after the change of another output state. Depending on the action made 
ont the first output in place in the onchange event, ON, OFF, or state change, an action 
is performed on a second output. 

 For example: The lamp of my toilet is independent of the ventilation of my toilet. When I 
turn off the light in the toilet, the ventilation begins a timeout of 5 minutes. 

The onchange event is a good alternative to schedule too short periodic events. 
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Creation of an onchange event 
Steps to follow: 

1. By manipulating drag and drop, bring the output of which the change of state will 
produce the change. 

2. By manipulating drag and drop, bring the output which, following the change of state of 
the first output, makes the event. 

3. Choose if the change state type which make the action. On, OFF or state change.  

4. Choose the wished action type. For more information, see the section Basic actions: 
Relay type output module on button type input. 

5. Validate by pressing OK. 
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 CONDITIONED LINK, THE CONDITIONS 
A link can be made following some conditions. The output snaps only if all the conditions 
are verified.  
• the conditions take the form of : the 

state of an input ;  
• the state of an output ;  
• the state or the value of a dimmed 

output ;  
• the temperature of a temperature 

sensor ; 
• the value of a clock ; 
• the state or the value of a variable ;  
• the state or the value of variable 

system ; 

• the state or the value of an audio 
output ;  

• the state of groups ;  
• the state of atmospheres ; 
• the state, the mode or the speed of 

DFAN01 ;  
• the value of an analogical signal 0 -

10Volt ;  
• the value of a channel DMX. 
• the value of a channel DINTDALI01. 

Add a condition 
Steps to follow: 

1.  
2. During the creation of a link, select the condition tab shown on the screen below. 

3. Right-click on the first blank row of the board at the bottom of the window and select the 
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option Add to condition to open the settings window of the condition. 
4. Select the tab of the wished type of condition (Input, Output, Dimmer, etc...).  
5. Select the condition and define its settings. 
6. Click on Add. The condition appears in the list.Add another condition if necessary 
7. Validate by pressing OK. The creation window shows now all the conditions applied to the 

link. 

 This is a condition programming of AND type. To create an OR type condition, you must 
repeat the basic link between the input and the output, the number of times the OR 
condition type is desired. 

Conditions type 
Condition on an input 
• Option ON: the link will be made only if the selected input is activated. 
• Option OFF: the link will be made only if the selected input is deactivated. 

Condition on an output 
• Option ON: the link will be made only if the selected output is activated. 
• Option OFF: the link will be made only if the selected output is deactivated. 

Condition on a dimmer output 
• Option ON: the link will be made only if the selected dimmed output is activated. 
• Option OFF: the link will be made only if the selected dimmed output is deactivated. 
• Option Above: the link will be made only if the value of the selected dimmed output is 

higher than the set value. 
• Option Under: the link will be made only if the value of the selected dimmed output is 

lower than the set value. 
Condition on a temperature 
• Depending on the temperature detected by the sensor. 
• Option T° higher than: the link will be made only if the value transmitted by the selected 
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temperature sensor is higher than the indicated value. 
• Option T° lower than: the link will be made only if the value transmitted by the selected 

temperature sensor is lower than the indicated value. 
• Option T° equal to: the link will be made only if the value transmitted to the selected 

temperature sensor is equal to the indicated value. 
• Option T° between: the link will be made only if the value transmitted by the selected 

temperature sensor is situated between the temperature values T1 and T2. 
• Depending on the setpoint of the temperature profile. 
• Option Setpoint higher than: the link will be made only if the setpoint is higher than the 

indicated value. 
• Option Sestpoint lower than: the link will be made only if the setpoint is lower than the 

indicated value. 
• Option Setpoint equal to: the link will be made only if the setpoint is equal to the indicated 

value. 
• Option Setpoint between: the link will be made only if the setpoint is situated between the 

setpoints T1 and T2. 

 Selecting the temperature mode of the sensor: Automatic mode, Absence mode, Comfort 
mode, Frost mode. If this additional restriction is not desired, leave all modes option 
activated. 

Selection of regulation mode of the sensor: heating mode, cooling mode, mixed mode, OFF 
mode. If this additional restriction is not desired, leave all modes option activated. 

Condition on the clock 
• Option After: the link will be made only if the input is activated after the set time 
• Option Before: the link will be made only if the input is activated before the set time 
• Option Value between: the link will be made only if the input is activated between the set 

times 
• Option Date between: the link will be made only if the input is activated between the 

indicated dates 
• Selection of the days of the week: the link will be made in function of the options above and 

if the day of the week is selected 
• Selection of a day, a month, a year: the link will be made in function of the options above, if 

the day of the week is selected, and if the day and/or month and/or year correspond to the 
moment of the action 

Condition on an audio output 
• Option ON: the link will be made if the selected audio output is activated (at least at 1%) 
• Option OFF: the link will be made is the selected audio output is deactivated (0%) 
• Option Above: the link will be made is the volume of the selected audio output is higher than 

the set value 
• Option Under: the link will be made if the volume of the selected audio output is lower than 

the set value 
Condition on an output DFAN01 
• Depending on the Mode 
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• Option Automatic mode : the link will be made only if the air conditioning mode is automatic 
• Option Manual mode : the link will be made only if the air conditioning mode is manual 
• Depending on the speed 
• Option Off : The link will be made only if the ventilation speed is zero 
• Option Speed 1: The link will be made only if the ventilation speed is at speed 1 
• Option Speed 2: The link will be made only if the ventilation speed is at speed 2 
• Option Speed 3: The link will be made only if the ventilation speed is at speed 3 
• Depending on the state 
• Option Off : The link will be made only if the state of the air conditioning contacts are off 
• Option Heating : The link will be made only if the state of the air conditioning contacts heats 

up 
• Option Cooling : The link will be made only if the state of the air conditioning contacts cools 

down 
Condition on an output DMX 
• Option Above: the link will be made inly if the value of the selected DMX channel is higher 

than the set value. 
• Option Under: the link will be made only if the value of the selected DMX channel is below 

the set value. 
• Option Equal: the link will be made only if the value of the selected DMX channel is equal to 

the set value 
• Option ON: the link will be made only if the selected DMX channel is activated (at least 1%) 
• Option OFF: the link will be made only if the selected DMX channel is deactivated (0%) 
• Condition on an analogical input from 0 to 10 Vdc (DD10V or DOUT10V02): 
• Option Above: the link will be made only if the value of the selected analogical input is 

higher than the set value 
• Option Under: the link will be made only if the value of the selected analogical input is lower 

than the set value 
• Option Between: the link will be made only if the value of the selected analogical input is 

included between the selected values 
• Option Equal: the link will be made if the value of the selected analogical input is equal to 

the measured value 
Conditions on a group 
• Option At least ON : the link will be made only when the number of activated outputs inside 

the group is higher or equal to the defined setting. 
• Option At least OFF : the link will be made only when the number of deactivated outputs 

inside the group is higher or equal to the defined setting. 
• Option Exactly ON : the link will be made only when the number of activated outputs inside 

the group is equal to the defined setting. 
• Option All ON : the link will be made only if all the outputs of the group are activated. 
• Option All OFF : the link will be made only if all the outputs of the group are deactivated 

Conditions on an atmosphere 
• Option Same sphere: the link will be made only if all the values of the atmosphere outputs 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    87 
TVA : BE0429942701  
 

have the same values than the ones defined in the selected scene settings 
• Option Different sphere: the link will be made only if the value of at least one atmosphere 

output is different from the one defined in the selected scene settings 
Condition on a system variable 
• Depending on the presence simulation 
• Option Value: the link will be made only if the value of the selected system variable is equal 

to the set value. The presence simulation is active when the value is true. The presence 
simulation is inactive when the value is false 

• Depending if we are in day or in night according to the astronomic clock 
• Option Day: the link will be made only if the value of the selected system variable is equal to 

the set value. The value Day starts with the sunrise and the value night starts with the 
sunset 

Condition on a variable 
• Option Value: the link will be made only if the value of the selected variable is equal to the 

set value. If this is a value type variable, its status will be true or false. If this is a value 
variable, it will be from 0 to 100 included. For more information, see the section The 
variables/ 

• Option Above: the link will be made is the value of the selected variable is higher than the 
set value 

• Option Under: the link will be made only if the value of the selected variable is lower than 
the set value 
 

 THE VARIABLES 
The variables are information contained in the memory of the master (DGQG01) in 
system memory. The use of variables in the conditions will allow the creation of more 
complex relationships between inputs and outputs. 
Variables can take the form of fictitious outputs True / false or numerical value. 

 For example : The use of the variable TRUE/FALSE (boolean) for the blocking of a function 
during a certain period of the day. 

 For example : The use of a numerical value to program the course of 5 successive functions 
(ex : 5 different atmospheres) on the same button.  
 

Creation of a variable 
Steps to follow: 

1. Right click on the variables icon in the outputs column 
2. Rename the created variable 
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Variables setting 
The use of variable needs beforehand the variable type. 
• The true/false type variables (Boolean): 
• Two possibles values : true or false. The actions on this type of variable are the same of a 

relay output (ON or OFF). 
• The value type variables (numerical): 
• Possible values : a number between 0 and 100 included. The limit value of this variable is 

selectable from the Limit dropdown list.  
• The value of the variable can be looped : when the incremented variable reaches its limit 

value, it starts again its cycle. This option is activated by checking Loop on value. 

Modification of the variables state 
The change of a variable's state is made from an input (ex:button). 
Modification of the value of true/false variable. 

An action on an input will reverse the initial state of the variable. The possibles actions 
are:  
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• True/False alternated : A first push on the input can be the activation of the variable. A 
second push deactivates the variable. 

• True : A push activates the variable. 
• False : A push deactivates the variable. 
• Maintain and durizing : More information in the section Basic actions : Relay type output 

module on button type input. 
Modification of the value of a numerical variable. 

The value of a variable value can be incremented, decremented, or carried to a certain 
value. This change takes place from a pulse on the input linked to the variable. The 
creation of the link generates the following actions: 
• Increase : The variable's value increases of a unit after each pulse on the input of the link. 
• Decrease : The variable's value decreases of a unit after each pulse on the input of the 

link. 
• Value : The variable has as value the selected number in the dropdown list Value after a 

pulse on the input of the link. 
• Value/ 0 alternated : The variable has as value the selected number in the dropdown list 

Value after a pulse on the input of the link. A new pulse on the input resets the variable. 

 The use PC active master mode allows you, via the computer, to change the status of the 
variable. For a variable value, it is a change in value from 0 to its maximum value defined 
during its creation. 

 

 PRESENCE SIMULATION 
The presence simulation reproduces the habits of the occupants of the building. When it 
is active, it switches on the registered actions a week earlier. It is possible to select only a 
part of the outputs. 
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The recording over a period of one week is performed as a mobile 'circular buffer'. The 
system performs a continuous update of the simulation. 

Selection of the outputs to command during the simulation 
This operation consists to define the outputs for which the system will register the state 
and then reproduce it during the simulation. From the menu Project > 
Restore/Simulation. The window allows you to select the outputs to register. 

 The lamp of a toilet with no window, or the regulation a heating will not be selected. 

Activation of the simulation 
The presence simulation variable system activates the presence simulation. The 
programming of this variable is similar to programming a True/False type variable. The 
activation of the simulation can therefore be made from any type of input: button, touch 
screen, receiving a text message, clock, … 
Steps to follow: 

1. Select Presence simulation variable system. By drag and drop, move it to the wished 
input. 

2. Select the wished action. (For more information, see the section The variables. 
3. Validate by pressing OK. 

The presence simulation can be directly activated from a touch screen.  

1. For DTSC01 and DTSC03 screens: From the Screen Setup menu, select the submenu 
Security Management. In this location is the icon of the variable Presence simulation. 
This type of command does not require any link in the configuration program. 

2. For DTSC02 and DTSC04 screens: From the Screen Setup menu, select the submenu 
Tools. In this location is the icon of the variable Presence simulation. This type of 
command does not require any link in the configuration program. 
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The system needing a full week to memorize the states of the outputs to control, the 
simulation will not work until a week after the commissioning of the installation. This delay 
also applies to each new transfer of application to the master DGQG01. The presence 
simulation's data is stored in RAM memory of the DGQG01. To know the recording state 
of presence simulation, refer to the menu Tools > Simulation logs. 

 

 

 CLOCKS 
The clocks perform actions at specific times. The clock is set on a 24-hour time slot 
associated with a weekly schedule and a precise selections a day, month or year. The 
clocks are included in the memory of the DGQG01. The limit is 250 clocks. 

Clock type 
• Classic clock : At a certain time snaps a programmed action.  
• Astronomical clock: It automatically adapts to the sunset and sunrise based on a specific 

date and the location of the installation. It is possible to delay or to anticipate an action over 
the launching of this clock. 

• Startup clock: Possibility to perform a number of actions during the system startup 
(DGQG01 - Master) to put outputs in a certain states. This is done at the end of the 
initialization period of the DGQG01. 

Creation of clocks 
Steps to follow: 

1. Right click on the clock icon (inputs column) > add a clock > add astronomical clock ; 
add a startup clock.  

Basic clock: Add a clock: 

1. Rename the new clock. 
2. Select the clock's settings: 
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• Time: Choose the exact time when the action will take place. 
• Week: Choose the days of the week when the action will take place. 
• Day selection: Choose a day, a month, a year, a complete month, a complete year or a 

specify date when the programming will take place. 
3. Validate by pressing OK. 

 
Astronomical clock: Add astronomical clock 

1. Open the astronomical clock settings via Project > Set regional preferences 
2. In the Time tab, you can select the hour settings you want. It is by default based on the 

nearest city but can be customized. 
a. This window shows the time of the sunrise and sunset. 

3. The astronomical clock can make an action either at sunrise or sunset. The sunrise and 
sunset's time is shown in red. 

4. Choose the clock setting. Possibility to Anticipate or to Delay the launching of the clock. For 
more information on the clock setting, see the section Select the clock's settings. 

5. Validate the settings by pressing OK. 
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Startup clock; Add a startup clock 

1. Right click on Clocks > Add a startup clock 

2. The startup clock makes its programming as soon as the module DGQG01 makes its 
initialization. This occurs after the transfer of an application to the master. 

3. Validate by pressing OK. 

 Possibility to organize the clocks to make the programming more clear. programming. 

Modification of a clock settings 
It is possible at any time to change the settings of a clock : right click on the clock > Edit. 
The configuration window appears and allow you to edit the settings. 
It is also possible to edit a clock from the touch screens. For this, see the section Erreur : 
source de la référence non trouvée Erreur : source de la référence non trouvée 

Creation of the links of a clock 
The launching of an output at a specified time needs the creation of a link between an 
output and a clock previously created. This link creation is the same as the one for the 
basic clocks, the astronomical clocks and the startup clocks. 

 
The left part of the window shows the clock settings : name, activation time and 
functioning period. It is possible to edit those settings directly from this screen by pressing 
the tab Clock. 
Depending on the linked output nature, choose the wished action. For more information 
on the actions to make, see the section Basic actions : Relay type output module on 
button type input. 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    94 
TVA : BE0429942701  
 

 TEMPERATURE MANAGEMENT 
The Domintell system can perform actions based on the temperature measured by home 
automation probes. The actions are of two types. A climate regulation or a logical test 
applied to the measured temperature. 

 REGULATIONS Type 
The Domintell system has 4 types of actions. There are 3 types of regulation and an 
action type based on a temperature value. The regulations are: proportional regulation, 
the regulation all or nothing and the DFAN01 regulation. These regulations are available 
for the management of heating or cooling. 

Proportional regulation 

1. For a relay type output 
• For a defined period, the activation duration of the output is proportional to the temperature 

difference between the setpoint and the value measured by the probe. 

2. For a dimmer type output 
The period does not count. The value of the output will be directly proportional to the 
temperature difference between the measured temperature and the set temperature. 

Three predefined proportional regulations are proposed. Possibility to customize the 
regulation. 

• Fast : period = 5 min; proportional strip = 1,5°C 
◦ For: - modulating gas boiler 

       - motorized mixing valve 
       ( Period = 5 minutes, 1.5°C of proportional band) 

• Medium : period = 10 min; proportional strip = 2,5°C 
◦ For: - fuel burner 

       - gas boiler 
       - circulator 
       - zone valve 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    95 
TVA : BE0429942701  
 

     (Period = 10 minutes, 2.5°C of proportional band) 
• Slow : period = 20 min; proportional strip = 3,5°C 

◦ For: - floor heating 
       ( Period = 20 minutes, 3.5°C of proportional band) 

• Custom : Allow you to edit the regulation settings. 

Regulation all or nothing 
If the temperature is higher than the set temperature the output is disabled. If the 
temperature is below the setpoint temperature minus the hysteresis value, the output is 
activated. 

For proportional regulation type and all or nothing regulation type, the activation 
management of the output is reversed with compared to the heating management. 
• For heating, the output is activated if the measured temperature is below the setpoint 

temperature minus the hysteresis value. 
• For cooling, the output is activated if the measured temperature exceeds the set 

temperature plus the hysteresis value. 
All Domintell probes are capable of managing a heating profile and a cooling profile. 
Depending on the capabilities of your installation you have to select one or two cooling 
modes. 

DFAN01 regulation 
Unique choice of DFAN01 regulation. The module DFAN01 speeds are switched 
depending on the temperature difference between the set temperature and the measured 
temperature. The heating or cooling relay are controlled according to this temperature 
difference. 

Actions in function of a temperature value 
This is the action of an output according to a logical test applied to the measured 
temperature. 
We distinguish 3 modes of comparison or logical test:  
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• Smaller : the output will be activated if the measured temperature is lower than the set 
temperature.  

• Higher : the output will be activated if the measured temperature is higher than the set 
temperature. 

• Equal : the output will be activated if the measured temperature is equal than the set 
temperature. 

 AIR CONDITIONING PROGRAMMING 
To access the programming of air conditioning, make a link between an output and a 
temperature sensor. 

The explanation of the regulation type is explained in the section Regulations type. 

Choose the heating and/or cooling management 
Depending on the capabilities of the element connected to the output module, select the 
mode of heating management and / or cooling management. 
The choice of the management of the heating or of the cooling mode is done in the ilin 
creation window. (no temperature sensor). 

1. If the output only controls the heating management, select only the heating management. 
 For example, a gas boiler 

2. If the output only controls the cooling management, select only the cooling management. 
 For example, single chiller 
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3. In the case of a single air conditioning circuit (2 pipes), if the output module is able to 
manage heating and cooling, select 2 managements (management of heating and 
management of cooling). 
 For example, heat pump Inverter. 

4. In the case of a double air conditioning circuit (4 pipes), the heating management is done 
with an output module. The cooling management is done with another output module. 
 For example, Configuration used in hotels. A link controls the cooling unit, the other link 

control the boiler. In times of between season, a part of the building can be heated, and 
the other can be cooled. 

The air conditioning management is based on a normally closed valve. When using a 
normally open valve, it is possible to invert the output by checking the reverse output of 
the link creation window. 

Temperature offset 
A regulation is always done from the setpoint of the temperature sensor. Domintell allows 
you to add a Temperature Offset on this set. When a temperature offset is set, the 
regulation is done on the set temperature supplemented with the temperature offset. 

 For example, the bathroom has a floor heating and electric towel dryer. The engagement of 
the towel dryer can have this temperature offset. When the temperature is too far from the 
set, the towel dryer will snap to heat more rapidly the bathroom. 
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 TEMPERATURE MODE AND REGULATION MODE 
Temperature mode 

Each temperature sensor has a temperature mode. The temperature mode of a sensor 
allows the management of the air conditioning installation in the management of 
temperature profiles. 
Choose an automatic, comfort profile, an absence or frost temperature. 
• Automatic mode  : The temperature profiles of each day of the week are selected. 
• Comfort mode  : The comfort profile is selected. 
• Absence mode  : The absence temperature is selected. 
• Frost mode  : The frost temperature is selected. 

To get access to the temperature mode in a link, you have to create a temperature zone 
including the sensor. 

Regulation mode 
Each temperature sensor has a mode of regulation. The regulation mode of a probe 
manages the climatic installation with a level of regulation. The regulation modes are 
available for each temperature sensor. 
• Mixed Mode : execution of the links (regulation) controlling the heating and the cooling. 
• Off Mode : the outputs linked to the regulations are stopped. 
• Heating Mode : execution, of the links (regulation) controlling the heating. 
• Cooling Mode : execution of the links (regulation) controlling the cooling. 
• To access the regulation mode in a link, establish a temperature zone comprising the 

probe. 
In the case of management in mixed mode, when the management of the air conditioning 
(hot source and cold source) is centralized in a single device, ensure that the change of 
regulation mode at the probes is also disclosed to the air conditioning device. 

 

 TEMPERATURE SENSORS SETTING 
All Domintell probes have the double regulation management. This management is used 
to manage heating and cooling by the same probe. 
So that the regulation can properly perform, each Domintell probe must be set, more 
information in the section General information : temperature sensor. 

Profiles assignation 
All Domintell probes 16 have different profiles, 8 for the management of heating, 8 for the 
management of cooling. 
The automatic profiles that run 7 days of the week have a heating profile and a cooling 
profile. 
The Comfort profile also has a heating profile and a cooling profile. 
The temperature of absence is common to all the temperature sensors. 
The frost temperature is common to all the temperature sensors. 
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Assign a profile  
Make a drag and drop from the profiles list to the corresponding image. 

A heating profile must be placed on the red background thermometer, meaning warm. A 
cooling profile must be placed on the blue background thermometer, meaning cold. 
Remove a profile 

Right-click in the profile area. Possibility to remove the heating profile and cooling profile 
for a selected day. It is also possible to delete all of the probe profiles. 

Copy the profile 
Right-click in the profile area and select Copy profile to other sensors. 

Copy the temperature profiles on other days and / or other temperature sensor. Select the 
days that the profile should be assigned. Select the profile to be copied (heating profile 
and / or cooling profile). Select the sensors where the profile should be copied. Confirm 
by pressing OK. 
For the climate control to be operational, all profiles must be set (for the desired type of 
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regulation). If a profile is not filled, a message appears when sending the application. The 
climate regulation will trip if a profile is not completed. 
If the probe does not handle the heating regulation, it is advisable not to fill the heating 
profiles. If the probe does not handle the cooling regulation, it is advisable not to fill the 
cooling profiles. 

Inheritance of the sensors 
When multiple probes make the climate regulation, it is possible to create a dependency 
between them. A probe may be a master of one or more other probe (s)  
The slave sensor follow the master sensor,  
• only for its temperature mode,  
• only of its set,  
• only for its regulation mode,  
• or a combination of the three previous options. 

Steps to follow: 
1. Open the dependence window for the temperature probes. Either via the menu Project > 

sensors inheritance or through the publication of a temperature sensor and the 
modification of the slave sensor window. 

2. Select a sensor present in the right column of the inheritance window and drag in the left 
column on the probe that will be master of this probe.  

3. Select the desired type of heritage: Temperature mode inheritance, Regulation Mode mode 
inheritance, Setpoint inheritance. 

To delete an inheritance between two sensors, right click on the dependent probe you 
want to delete. Click delete. 

 For example, A multizone house is equipped with a heat pump inverter. The probe of the living room 
is the main probe of the house. When this one changes of regulation mode, all the others adopt this 
mode of regulation. 

 

 CREATION OF A TEMPERATURE PROFILE 
The automatic and comfort mode are made of temperature profiles. The automatic mode 
can handle seven different profiles for the seven days of the week. The comfort mode 
uses a fixed profile. 
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It is necessary to define temperature profiles for each probe. 
Steps to follow: 

1. Edit the probe for which the temperature profiles must be defined. 
2. Profile > Add/modify (Top left). Or by right clicking on the profiles list and selecting 

Add/Modify. 

3. Select the different ranges which made the profile. Max 12 bands over a 24 hours period.  

Add a temperature profile 
Steps to follow: 

1. In the profiles list, click on New. 
2. Left click in the profile zone. While holding the left button pressed, move the mouse to 

draw the temperature profile. When releasing the left button, the range is created. 
3. The temperatures can be directly completed in board situated on the right part of the 

screen. 
4.  
5. To save the new profile, enter a name and click on save. Your new profile is now 

created. 
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Modification a an existing temperature profile 
Select the profile to edit in the list of profiles. Make the desired changes in the profile 
zone. Click on save. 

Delete a profile 
Select the profile to delete in the list of profiles. Click on delete. The profile is deleted from 
the application.  
• If the profile is in the application, a confirmation is asked to delete the module. 
• If a used profile is deleted, all the probes using this profile are not set anymore. 
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 TECHNICAL SUPPORT 
Successive steps of a standard installation 

 Task 1: Check the loaders in the master and touch screen. 
 Task 2: Scan the network. 
 Task 3: Rename all the inputs and outputs. 
 Task 4: Distribution of the rooms and floors. 
 Task 5: Creation of the groups (outputs, sound, shutter, etc.) 
 Task 6: Creation of the ambiances. 
 Task 7: Creation of the clocks. 
 Task 8: Adapt the astronomical clock. 
 Task 9: Creation of periodic events. 
 Task 10: Creation of variable users. 
 Task 11; Creation of temperature zones. 
 Task 12: By drag and drop, make link inputs-outputs and assign functions. 
 Task 13: Creation of temperature profiles. 
 Task 14: By drag and drop, make element links heater-temperature sensor. 
 Task 15: Set the sound module + IR transmitter/receiver. 
 Task 16: Set the module DGSM01. 
 Task 17: Save the configuration. 
 Task 18: Send the configuration to the master. 
 Task 19: Try the configuration and verify the functions. 
 Task 20: Take a copy of the configuration on CD. 
 Task 21: Make a network diagnosis of the installation. 
 Task 22: Launch all the home automation elements for at least 2 hours to ensure the 

network stability and the low power supply of the BUS. 
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 DIAGNOSIS ET MEASUREMENTS TAKING. 
Software verification 

Launch the software to verify the installation.  
Menu > Tools > Network diagnosis 
If errors are detected, solve them. 

Hour & scree of the DGQG01 
Set the installation to the correct time.  
Verify the screen of the DGQG01 that the 2 points between the hours and the minutes 
flash.  

DGQG01 battery 
The tension of the battery (type = CR1216) of the DGQG01 must be higher than 2.8Vdc. 
The battery of the DGQG01 is placed on the electronic PCB of the DGQG01. Open the 
module's case from the back. 

Consumption & electric cases 
Each electronic case must include at least a power supply DALI0x. All the consumptions 
of the cases must be calculated separately in the configuration's software. It is better to 
not interconnect 2 cases with power supply + (red cable). This measure is important for 
the DALI03 cabling. 

Measures on the BUS 
Your Domintell system must be powered by a power supply DALI0x.  

With a multimeter: Every power supply ON 
BLACK - RED Always > 14 Vdc (All the relays ON)  
BLACK – BLUE Data + : between 2 & 4 Vdc. 
BLACK - WHITE Data - : between 1 & 3 Vdc.  

Connections 
The connections to the BUS is made by cable « Domintell DCBU01 ». Respect the 
cable's colors during the connection to the fast connector.  
Use the BUS configuration. Avoid the cabling in STAR. The configuration on STAR is a 
lost of home automation signal. 
It is forbidden to make a simple LOOP or total cabling of the BUS datas. The loop creates 
ghost messages that blocks the perfect operation of the system. 

DDIM01 & power modules 
The phase connected the dimmer modules of power (DD10V / DD400L/ DD75 / DD500 / 
DD750 / DD1000) have to be the same than the one connected to the corresponding 
module DDIM01. 
See DDIM01 information’s for more details. 
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The DHUB01 module 
Only necessary if: 
• There are more than 128 modules on the Bus and/or 
• The Bus is more than 300m long and/or 
• Your Bus is cabled in STAR with a total length higher than 100m. 

REQUESTED CONDITION: Each DHUB01 must have a connection on the same line 
than the central unit DGQG01 : See the references on the Bus. 
See the DHUB01 information’s for more details.  

DTRP01 - DTRP02 
The remote control switch modules need an important peak current for each change 
state. Domintell can not guarantee the good operation of those modules if there is no 
power supply DALI01 in the same electric case, or if the number of power supply is too 
low. Maximum 32 remote control switches are able to change state in the same time if 
there is only one DALI01. 

DGSM01 
Before programming the module DGSM01, the batteries must be charged.  
In order to treat the requests on the module DGSM01, we need the print screen of the 
corresponding state window:  

1. Charge your application and wait for the initialization 
2. Launch you computer in PC active mode 
3. Right click on the input DGSM01 => Status 
4. Take a print screen 
5. Send it by email 

 LOG FILES 
• Support can ask a log file if needed. 
• They are generated in c:/Program_Files/Trump/Domintell2/Log. 
• Starts during the launching of the software Domintell. 
• Ends when you leave the software Domintell. 
• Send only the corresponding file ate the wanted time. 

 TECHNICAL SUPPORT 
For more information’s, contact the Domintell technical support at support@domintell.com 
or +32 (0) 67 88 82 50. 
Send the application file with a complete description, the diagnosis and the results from 
measures taken on the BUS. The pictures and print screen can be sent to allow a quick 
diagnosis. 

mailto:support@domintell.com
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 UTILISATION DU DOCUMENT 
Ce document fournit aux utilisateurs des systèmes domotiques Domintell la marche à 
suivre de configuration pour le logiciel GoldenGate. Il indique de manière claire les 
différentes étapes de la création d'une application. 
Ce manuel est un support aux utilisateurs pour l'adaptation de leur fichier .dap (Domintell 
Application Program). 
Pour une meilleure utilisation du manuel, il est conseillé de participer aux formations 
techniques Domintell. 
Les inscriptions en italique désignent les messages indiqués sur des commandes (bouton, 
case à cocher, ...) 
Les inscriptions en gras indiquent les menus et sous-menus à parcourir pour atteindre une 
fonction. 
 
Le présent document se limite à la configuration du DGQG01 avec le logiciel GoldenGate. 
Cependant, la majorité des informations reprises dans ce document reste valable pour les 
versions précédentes du logiciel de configuration GoldenGate ou Domintell2. 

 

Pour toute question relative à ces produits et leur utilisation via GoldenGate, veuillez 
contacter notre service support à support@domintell.com ou par téléphone au +32 (0) 67 
88 82 50. 

mailto:support@domintell.com
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 PRÉSENTATION DE L’INTERFACE 
Barre d’outils 

 
Certaines icônes peuvent apparaître grisées (non-accessibles), selon l’état de connexion au 
Master. 

•  (CTRL+N, CMD+N) : Créer une nouvelle application vide (fichier .dap) 

•  (CTRL+O, CMD+O) : Ouvrir une application existante sur l’ordinateur (fichier .dap). 
Les fichiers les plus récemment ouverts sont aussi disponibles depuis ce bouton. 

•  (CTRL+S, CMD+S) : Enregistre l’application (fichier .dap) 

•  (CTRL+SHIFT+S, CMD+SHIFT+S) : Enregistrer l’application sous un autre nom 
(fichier .dap) 

•  : Lecture de l’application depuis le Master 

•  : Écriture de l’application dans le Master 

•  : Activation du mode PC actif 

•  : Mode PC actif activé, cliquer pour désactiver 

•  : Recherche des modules sur l’installation (scan du bus) 

•  : Gestion des modules présents sur l’installation 

•  (F6) : Diagnostic et mise à jour du système  

•  : Paramètres régionnaux de l’application  

•  : Paramétrage de la simulation de présence 

•  : Connexion au Master sélectionné (ici déconnecté) 

•  : Déconnexion du Master (ici connecté) 

•  : Rafraîchissement de la liste des Masters trouvés sur le réseau Ethernet 

•  : Édition des Masters enregistrés 

•  (CTRL+Q, CMD+Q) : Quitter 
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 OPÉRATIONS PRÉLIMINAIRES À LA PROGRAMMATION 
Connexion au Master 
Pour connaître le statut de la connexion USB qu'utilise le module DGQG01 sur l'ordinateur, se 
rendre dans le panneau de configuration de Windows > Système > onglet Matériel > 
Gestionnaire des périphériques. La liste des ports doit contenir le contrôleur Domintell 
DGQG01 USB. 

Si la liste du contrôleur de bus USB ne comprend pas le driver Domintell DGQG01 USB, les 
pilotes du driver USB n'ont sans doute pas été installés. La connexion USB est reconnue, 
mais apparaît comme non installée. 

 
Pour installer les pilotes USB, cliquer droit sur le périphérique à installer, sélectionner Mettre à 
jour le pilote logiciel. 
Opter pour l'installation automatique si vous disposez d'une connexion Internet. Sinon, optez 
pour l'installation manuelle. Un assistant d'ajout de matériel apparaît. Indiquer à l'ordinateur 
l'emplacement du répertoire contenant les drivers. Ceux-ci se trouvent sur le CD d'installation 
ou sur notre site web PRO. 
L'assistant trouve et installe les pilotes. Il vous avertit lorsque cette procédure unique est 
terminée. 

 

Cliquer sur Terminer pour clôturer l'installation des drivers. 

Implémentation du système d'exploitation dans le Master 
Le DGQG01 doit obligatoirement contenir la même version de système d'exploitation Domintell 
(Master O.S.) que celle installée sur l'ordinateur (compilateur). 
Rem : Si la version installée sur l'ordinateur est supérieure à la version contenue dans le 
DGQG01, seule la fonction lecture application est possible. 
Pour implémenter le système d'exploitation dans le Master, aller dans le menu Outils > Flasher 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    8 
TVA : BE0429942701  

> Master. La fenêtre de mise à jour du master apparaît. 

Si la version O.S. n'est pas à jour, effectuer le chargement en appuyant sur OK et confirmer la 
manipulation avec le bouton Oui. Le transfert du système d'exploitation au DGQG01 dure 
environ 8 minutes. Le transfert d'un système d'exploitation efface ce qui est contenu dans la 
mémoire du DGQG01. 
Il est impossible de transférer une application dans le DGQG01 si les versions de système 
d'exploitation dans le DGQG01 et dans l'ordinateur ne sont pas identiques. 

Vérification de la version des systèmes d'exploitation (O.S./Firmware) 
La version de l'O.S. contenu dans le Master se vérifie à partir du menu Outils > Mise à jour et 
diagnostic. La Version Master O.S. et la Version de l’application doivent être identiques. De 
plus, tous les modules doivent également contenir la dernière version du firmware. Si au moins 
un module n’est pas à jour, celui-ci apparaîtra dans la section Mise à jour nécessaire. 
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Création d'une nouvelle application 
Pour créer une nouvelle application, aller dans le menu Fichier > Nouveau. L'écran de 
configuration vide apparaît : 

Scan du réseau 
Le scan du réseau permet au programme de détecter tous les modules connectés au 
bus1. La détection des modules se fait à partir du menu Master > Scan du réseau. 

1. Bus de communication Domintell de norme RS485 sur lequel sont reliés tout les modules domotiques. 

La progression du scan est illustrée par la fenêtre ci-dessous : 
Tous les modules connectés au bus apparaissent à l'écran lorsque la détection est 
terminée. 
 

 ENVIRONNEMENT DE PROGRAMMATION  

Écran principal 
Après avoir réalisé les opérations de base, l'écran se présente comme ceci : 

Cet écran se divise en 3 parties : 
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 La colonne grise à gauche de l'écran affiche les différents étages et les différentes pièces 
qui composent le bâtiment. Il s'agit de l'arborescence du projet. 

 La partie centrale de l'écran affiche la colonne des entrées. Les modules d'entrées 
contrôlent l'installation. Le résultat de la programmation par manipulation de « glisser 
déposer » d'une sortie sur une entrée, apparaît sur les modules d'entrées. 

 La colonne à droite de l'écran affiche les sorties. Les sorties effectuent des actions sur le 
système. 

 Certains modules sont pourvus à la fois d'entrées et de sorties. Ex : DGSM01, DPBT02, 
… 

Organisation de la Maison (première colonne) 
Pour clarifier la structure de l'installation, le programme Domintell permet d'établir une 
arborescence en deux niveaux de l'installation. Vous pourrez ainsi organiser les 
différentes pièces dans les étages du bâtiment et y répartir les différents organes 
d'entrées et de sorties connectés au bus. 
Si un écran tactile DTSC0x équipe l'installation, la première colonne permet de fournir 
une configuration par défaut des modules apparaissant sur l'écran. 

 

 

Répartition des pièces et des étages 
Ouvrir la fenêtre de création de maison. Dans le menu Projet > Ajouter étage. 
Ou, cliquer droit dans la première colonne > Ajouter étage. 
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La partie supérieure droite contient les Étages tandis que la partie inférieur droite 
contient les Pièces. 
Pour ajouter des étages, sélectionner et glisser l'étage désiré vers la partie gauche de 
l'écran. Relâcher le bouton gauche de votre souris. L'étage apparaît maintenant à cet 
endroit. 
Pour ajouter des pièces, sélectionner et glisser la pièce désirée sur un étage se trouvant 
dans la partie gauche de l'écran. Relâcher le bouton gauche de votre souris. 

Cliquer OK, lorsque l'organisation des différents étages et des pièces est établie. 

Création et suppression d'étages et/ou de pièces 
Il est possible de créer de nouveaux étages et de nouvelles pièces ou de renommer les 
étages (pièces) existants. 
Pour ajouter un étage, cliquer droit dans l'espace des étages > Ajouter étage. Un nouvel 
étage apparaît dans la liste, Renommer-le. 
Pour renommer un étage, sélectionner l'étage désiré > cliquer gauche > renommer 
l'étage. Suite à ce changement, un écran de sélection d’icônes apparaît et permet 
d'attribuer une icône à cet étage. Pour choisir une autre icône, aller dans Projet > 
sélection icônes. 
Pour supprimer un étage, sélectionner l'étage désiré > clic droit > Supprimer. L'ajout, la 
suppression et la modification du nom d'une pièce s'effectue de la même manière que 
pour un étage. 

Répartition des entrées et des sorties dans les pièces 
La répartition des éléments s'effectue : 
• Soit à partir de l'écran principal. Sélectionner chaque composant utilisé (entrée ou sortie), 

tirer le composant vers la pièce où il est installé. 

• Soit via le menu Projet > Disposition. Prendre les éléments entrées et les éléments sorties 
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pour les trier dans l'arborescence. 
Lors de la sélection d'un élément de l'arborescence, les entrées et sorties qui y sont 
triées apparaissent. 

Les modules Entrées (seconde colonne) 
Il s'agit de tous les modules permettant d'apporter une information de commande au 
DGQG01. La liste des modules se trouve au chapitre 'module' de ce manuel. 

Les modules Sorties (troisième colonne) 
Il s'agit de tous les modules pouvant être commandé par le DGQG01. Ces modules 
effectuent des actions en fonction de la programmation contenue dans le DGQG01. La 
liste des modules est repris au chapitre 'module' de ce manuel. 

Organisation de la programmation 
Les points suivants permettent de modifier l'ordre des liens au sein de l'application. 

Modification du nom des éléments 
Toutes les entrées et toutes les sorties peuvent être renommées dans le but de faciliter 
la programmation. Il en va de même pour les groupes, les variables, les sondes de 
température, les capteurs IR et les horloges. Pour changer le nom d'un élément, 
sélectionner l'élément > clic droit > Renommer. 
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Pour renommer tous les éléments d'un module, sélectionner un des éléments du 
module > clic droit > Éditer. Renommer chaque élément du module. 

 

L'élément par lequel est édité le module apparaît en rouge dans la liste. 

 Renommer tous les composants permet une aisance future dans la 
programmation. Utiliser des noms simples et intuitifs. 

Déplacement des liens 
Lorsque plusieurs sorties sont liées à une même entrée, il est possible de modifier 
l'ordre des liens sur cette entrée. Effectuer un clic droit sur un des liens et Remonter le 
lien ou Descendre le lien. 

 L'ordre des liens est important lorsqu'ils ont comme condition la valeur d'une 
variable. Ce déplacement de lien permet une meilleure ergonomie du programme. 
 Exemple : Si l'incrémentation de vitesses de ventilation s'effectue en fonction de la 
valeur d'une variable et que celle-ci est incrémentée à chaque pression sur le bouton 
désigné. Alors, si la variable est en première position, elle sera incrémentée et les 
actions suivantes s'effectueront en fonction de la nouvelle valeur de la variable. 

 
Si la variable est placée en dernière position, les liens s'effectueront en fonction de 
l'ancienne valeur de la variable et ensuite la variable sera incrémentée 
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Organisation des horloges 
Afin d'organiser votre programmation comme bon vous semble, il vous est également 
possible de déplacer les horloges créées. A partir d'un clic droit sur une des horloges, 
sélectionner l'option Remonter horloge ou Descendre horloge. 
Pour trier les horloges par ordre chronologique, effectuer un clic droit sur l'icône Horloges 
et sélectionner l'option Trier. 

 Il ne s'agit que d'une fonctionnalité d'ergonomie. Déplacer une horloge n'influence 
pas son enclenchement à l'heure choisie. 

 

Repérer des Entrées / Sorties 
Utiliser l'option de Master automome PC actif pour repérer facilement les éléments de 
type Entrée et /ou sortie. Connecter le PC au DGQG01. Sélectionner le mode Master 
autonome PC actif. Une action sur une Entrée sera indiquée par la coloration verte de 
l'icône de l'Entrée concernée. 

L'option Garder dernière action met en évidence la dernière Entrée activée (menu Affichage 
> Garder dernière action). 
Pour modifier l’état des Sorties à partir du PC, cliquer sur l’icône de la Sortie concernée. 
L'état est signalé par le changement couleur ou le changement de symbole de l'icône. Le 
mode Master autonome PC actif gère uniquement l'appui court. 

Rechercher des éléments dans l'application 
La fonction de Recherche est applicable pour toutes les Entrées, les Sorties, les 
Variables et les Groupes. Elle situe le ou les emplacements des éléments dans le fichier 
de configuration et met en évidence les liens qui s'y rapportent. A partir de l'élément à 
rechercher, effectuer un clic droit et sélectionner l'option Rechercher. La fenêtre illustrée 
ci-dessous indique tous les endroits où est répertorié l'élément. 
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La sélection d'un des emplacements dans cette fenêtre indique directement 
l'emplacement du lien qui s'y rapporte dans le programme de configuration. 

Menu Affichage 
Le menu Affichage gère l'ergonomie de l'affichage PC. Les options contenues dans ce 
menu indiquent pour chaque composant : 
• Son numéro de série : Afficher n° de série 
• L'endroit de l'habitation où se trouvent ses Entrées ou ses Sorties : Afficher pièce/étage 
• Son type : Afficher Type 

Le menu permet aussi : 
• L’affichage ou non de la barre de progression d'un transfert d'application : Afficher 

information sur transfert 
• De choisir une langue parmi les 23 proposées :Selection langue 
• De développer ou de réduire tous les liens du programme : Fermer tous les lien / ouvrir 

tous les liens. 

Créer un rapport 
Un rapport indique tous les détails de la programmation. Il est généré à partir du menu 
Outils > Création rapport. Ce document donne une vue d'ensemble de l'application à 
l'utilisateur durant et après la programmation. 
Les Entrées sont classées selon leur emplacement. Les informations suivantes sont 
renseignées : 
• sortie(s) pilotée(s) 
• type d'action associée à chaque sortie 
• paramètres du lien 

Les horloges ainsi que leurs paramètres y sont mentionnées. Enregistrer l'application 
avant de générer la création de rapport. 

 Afin de faciliter la compréhension du rapport par l'utilisateur final, il est primordial de 

renommer clairement tous les éléments de l'installation. Cette manipulation est faite de manière 

intuitive et coordonnée. 
Ajouter manuellement des modules 

Ajouter des modules virtuels à partir du menu Outils > Ajout module. Sélectionner le 
type puis le module à ajouter. 

 Réaliser la programmation virtuelle d'une installation avant le câblage et le scan des 
modules. Cet outil permet la création d'application de test pour se familiariser avec 
l'environnement GoldenGate. Il ne s'agit pas d'un simulateur de fonctionnement de 
l'installation. 
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Le module sélectionné dispose d'une adresse virtuelle. Ce numéro de série peut être modifié. 
Cliquer sur OK pour valider 

 

 Sans connaissance du numéro de série du module qui sera finalement installé, 
conserver le numéro de série inscrit par défaut. 

Si ce numéro de série est inchangé, le nouveau module apparaît dans la fenêtre 
principale du programme avec la mention [non scanné x] 
Après le câblage des modules domotiques, remplacer les modules virtuels présents dans le 
programme par ceux installés. Suivre les instructions de « Remplacement de module ». 

Remplacement de modules 
Remplacer un module virtuel ou défectueux de même type sans effectuer de modification 
de programmation. 
En cas de module défectueux, effectuer d'abord le remplacement physique sur le bus. 
Scanner le réseau (menu Master > Scan du réseau). Un message signale l'absence 
d'un module, cliquer sur OK. L'écran de Gestion des modules apparaît. Il se compose 
de 3 colonnes : 
• Modules présents : Les modules détectés sur le réseau y sont indiqués. Le nombre entre [ ] 

représente le nombre de modules scannés. 
• Modules absents : Les modules non détectés sur le réseau (modules déconnectés ou 

défectueux) y sont indiqués. Le nombre entre [ ] représente le nombre de modules absents. 
• Nouveaux modules : Les modules détectés lors du dernier scan du réseau sont indiqués. 

Le nombre entre [ ] représente le nombre de nouveaux modules scannés. 
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Dans la colonne des modules absents, effectuer un clic droit sur le module à remplacer 
et sélectionner Remplacer. 

 

Après cette manipulation, les colonnes Modules absents et Nouveaux modules sont vides. Cliquer 
sur OK et transférez l'application au master pour que le changement soit effectif. 
 

 

 LES MODULES  
La répartition des titres suivants suit l'ordre établi dans le menu d'ajout de module du 
logiciel GoldenGate. Il s'agit de la description des caractéristiques logiciels des modules. 
Certains modules sont pourvus à la fois d'entrées et de sorties. Ex : DGSM01, DPBT02, 
… Ils apparaissent dans la colonne centrale (Entrée) ainsi que dans la colonne de droite 
(Sorties). 

 Par exemple : Le module DGSM01 envoie un SMS pour avertir d'une intrusion. Et il 
reçoit un SMS pour enclencher toutes les lampes de l'installation et faire fuir le voleur. 

 ENTRÉES 
Informations générales 

Les modules de type entrée apparaissent dans la partie centrale du programme 
GoldenGate, dans la colonne des entrées. C'est au moyen des entrées qu'il y a un 
contrôle de l'installation. Dans la colonne des entrées apparaissent les liens de 
programmation. 
Gestion de l’appui long : 

La fonction appui long enclenche la sortie du lien de l'entrée. Un appui est considéré 
comme long après une période fixe de 0,4 seconde. 
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Pour pouvoir sélectionner un appui long, il est nécessaire de sélectionner la fonction 
appui long dans les paramètres du module d'entrée. 

 Ne pas valider l'appui long sans programmation du lien sur ce bouton utilisant les deux 
types d'appuis. Sans programmation, une personne lente risque de dépasser le temps d'appui 
court et arriver dans la période longue. Donc ne pas avoir d'action. 
Inversion du signal d'entrée : 

La fonction inverse permet d'inverser le signal transmis par un capteur. Elle est 
intéressante lorsque le contact du capteur est normalement fermé (NC). 
Cette fonction est accessible à partir de l'écran de paramétrage de chaque module 
d'entrée de type bouton ou DISM0x. 

DISM08/DISM04 
 Description 

Le module permet le raccordement direct de boutons poussoirs ou de toutes autres 
entrées, détecteurs, etc. libres de potentiel. 

 
 

Fil blanc Commun 

Fil brun Entrée 1 

Fil rouge Entrée 2 

Fil orange Entrée 3 

Fil jaune Entrée 4 

Fil vert Entrée 5 

Fil bleu Entrée 6 

Fil violet Entrée 7 

Fil gris Entrée 8 
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 Édition du module 
• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 

module est modifiable. 
• .Paramètre entrée : Noms des canaux entrées, 2 appuis et fonction inverse. (description 

dans l'information générale du titre Entrée) 
 

DPBU01/DPBU02/DPBU04/DPBU06 
 Description 

Boutons poussoirs avec témoins lumineux. Gamme Bticino Light/Living. Il existe 4 types 
de modules : 1, 2, 4, 6 boutons poussoirs avec témoins lumineux. 
Témoin lumineux programmable. L'intensité des témoins lumineux n'est pas gérée par le 
logiciel GoldenGate. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre E/S : Noms des boutons entrée, noms des témoins lumineux de sorties, 2 
appuis et fonction inverse. (description dans l'information générale du titre Entrée. 
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DDIR01/DDIR02/DNIDIR01/DTDIR03/DAXDIR04 
 Description 

Capteur infra-rouge qui permet la réception du signal d'une télécommande Domintell ou 
d'une télécommande infrarouge universelle. Ce module permet le décodage des 32 
canaux de commande IR utilisés par Domintell. 
 Édition du module 

• Paramètre sortie : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre Entrée : Nom du capteur IR. 

DMOV01/DMOV02/DTMOV03/DAXMOV04 
 Description 

Détecteur de mouvement PIR. Réglage de la sensibilité par le logiciel  de configuration. 
Un témoin de détection (témoin lumineux rouge) peut être activé lors de la configuration. 

 Édition du module 
• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 

module est modifiable 
• Paramètre entrée : Nom du détecteur de présence. Fonction inverse. (description dans 

l'information générale), gestion de sensibilité de détection. Option d'allumage du témoin 
lumineux du module en cas de détection, Allumer les témoins lumineux lors de détection de 
mouvement. 
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DPBLCD01/DAXPBLCD01/DPBRLCD02/DAXPBLCD02 
 Description 

Écran tactile de contrôle. Réglage du nombre d'entrées et sorties utilisées dans le logiciel 
de configuration. Configurations possibles :1, 2, 4 ou 6 zones d'appuis. 
PBLCD01 = version sans capteur de T° intégré. PBLCD02 = version avec capteur de 
température intégré. 
Zones d'appuis possibles : bouton poussoir LCD, menu audio DAMPLI01, menu 
climatisation, menu climatisation DFAN01, menu ventilation DMV01, horloge numérique. 
Type d'écran de veille possible : horloge numérique, horloge analogique, affichage de la 
température, image personnalisée. 
L'intensité lumineuse du rétro-éclairage est gérée par le logiciel GoldenGate. 
Possibilité d'utiliser des images personnalisées au format *.bmp (bitmap) selon les 
dimensions indiquées au point Importation et gestion d'images dans bibliothèque. 
La programmation de régulation climatique du capteur de température du PBLCD02 est 
expliquée au point : Informations générales : Sondes de température. 
 Édition du module 

Éditer le PBLCD0x par un un clic-droit sur un des éléments entrées ou sorties du module. 

 

 Fenêtre principale de configuration 
La configuration de l'aspect du DPBRLCD0x s'effectue à partir de cet écran : 

 
1) Choix du nombre de boutons à afficher 

L'écran dispose d'une, de deux, de quatre ou de six zones d'appuis/affichages. Par 
défaut il s'agit de boutons poussoirs. Il est possible de sélectionner un menu ou 
l'affichage de l'horloge numérique. 
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Si des liens sont présents, il est possible que certaines configurations de boutons ne 
soient plus possibles. Pour disposer de ces configurations, il faut supprimer des liens sur 
les entrées/sorties du PBLCD0x. 
2) Options de rétro éclairage 

Il existe trois modes de fonctionnement du rétro-éclairage : Actif, Inactif (modification de 
l'intensité après le temps d'inactivité spécifié) et Veille (lorsque l'écran est inactif, 
l'affichage de l'écran de veille et la modification de l'intensité s'opère après le temps 

indiqué). 
Possibilité de modifier l'intensité lumineuse de l'écran lors du passage en mode nuit. 
L'utilisateur indique lui-même la plage horaire (mode Utilisateur) ou se base sur l'horloge 
Astronomique. 
L'option d'action directe permet une réaction instantanée lors de l'appui sur l'écran, sans 
attendre l'extinction de l'écran de veille. Cette option est disponible à partir de la version 
65 du firmware des PBLCD. 
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3) Écran de veille 

L'Option 'Utiliser écran de veille' enclenche après un période donnée le type d'écran de 
veille sélectionné sur le DPBRLCD : 
• Horloge Analogique : l'heure est affichée sous la forme d'une horloge à aiguilles. 
• Horloge Numérique : l'heure est affichée sous la forme numérique. 
• Domintell : Écran noir avec une ligne bleue et un petit logo Domintell sont affichés. 
• Personnalisée : Image issue de la bibliothèque. L'image ne peut pas contenir plus de 

32.000 pixels (h*l). La taille habituelle est de 200x150 pixels. Il est possible d'insérer des 
images « plus étirées » tout en respectant la taille limite. 

 

 Importation et gestion d'images dans la bibliothèque 
Les images supportées pas les modules PBLCD doivent respecter certains critères de 
format et de taille. 
Les images doivent absolument être sauvées sous format *.bmp (bitmap) 24 bits. 
Suivant la zone d'affichage (écran de veille ou bouton) des dimensions sont à respecter. 
La taille maximale pour le module PBLCD est de 32000 pixels. La largeur maximale 
d'affichage est de 318 pixels et la hauteur maximale est de 138 pixels. Il n'est pas 
possible de remplir l’entièreté de l'écran avec un image. 

 

Type de configuration Hauteur x Largeur 
B1 238 x 318 

B2-B4 118 x 158 
B6 200 x 150 

 Le format *.bmp (bitmap) 24 bits ne gère pas la transparence. Pour retirer le rendu « carré » 
d'une image et permettre sa découpe, il est possible de sélectionner l'option de transparence 
dans la fenêtre de configuration du module PBLCD. Cette manipulation permet de ne pas 
afficher tous les pixels ayant la même couleur que le pixel en haut à gauche de l'image. Il y a lieu 
de placer une couleur dont vous êtes certain qu'elle n’apparaît pas autre-part sur l'image. Dans 
l'exemple ci- dessous, il s'agit de la couleur magenta. 
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→ → 
 
 
 

Il est possible d'ajouter des images à la bibliothèque du DPBRLCD via le menu Outils > 
Importation d'images PBLCD. 

Dans la fenêtre vide blanche, cliquer-droit sur Importer une nouvelle image. Une 
fenêtre de saisie demande l'emplacement de l'image. Sélectionner le fichier *.bmp 
(bitmap) désiré et cliquer sur Ouvrir. Le programme place automatiquement le fichier 
dans le/les répertoires appropriés. Si l'image est trop grande, un message d'erreur 
apparaît. Pour importer une autre image, répéter la procédure. Pour terminer l’importation 
des fichiers *.bmp (bitmap), cliquer sur OK. 
La gestion de la bibliothèque est possible via le même menu. Cette fenêtre permet de 
gérer les répertoires d'images du PBLCD. Possibilité de renommer et supprimer les 
fichiers présents dans les répertoires de gestion d'images. 
 Différents écrans disponibles du PBLCD 

Les modules PBLCD disposent d'une configuration de 1 à 6 zones d'appuis, utilisées 
comme bouton poussoir tactile ou permettant l'affichage de menus. Les menus sont 
disponibles si les modules liés à ces menus sont présents dans l'application. 
Pour faciliter la prévisualisation du lecteur, les zones d'appui illustrées ci-dessous ont été 
coloriées. Les zones coloriées en jaune sur les différentes captures permettent de revenir 
au menu principal. 
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Menu principal 
 
Le menu principal permet d'exécuter des liens de type bouton 
ou d'accéder aux fonctions des menus. 
Si une zone n'est pas configurée, il est conseillé de choisir 
l'horloge comme type de bouton pour éviter des appuis 
intempestifs sur cette zone de l'écran. 

 

 

Menu Fan (seulement avec PBLCD02 + DFAN01) 
 
Un module DFAN01 doit être présent dans l'application et il 
doit être lié (régulation) à la sonde du PBLCD. 
Ce menu permet la gestion de la régulation DFAN01. 
Possibilité de changer le mode de température (Auto, 
Absence, Confort et Gel) ; de changer la vitesse ; de changer 
la température désirée. 

 

 

Menu Température (uniquement avec DPBLCD02) 
 
Permet la gestion de la température liée à la sonde du module. 
Possibilité de changer le mode de la sonde (zone bleue) ainsi 
que sa température de consigne (zones rouges). 

 

 

Menu Son (uniquement si DAMPLI01 présent) 
 
Permet la gestion d'une (seule) des 4 sorties HP du module 
DAMPLI01 par zone tactile. Ce menu permet de modifier le 
volume et la source audio. Il permet dans la partie tuner, de 
modifier la station. Dans les 4 parties auxiliaires possibles, il 
permet d'envoyer des codes IR (précédant et suivant) si la 
configuration dispose d'un module DIREMIT01. 

 

 

Menu Ventilation (uniquement si DMV01 présent) 
 
Un module DMV01 (Ventilation Mécanique Contrôlée) doit être 
présent dans l'application. 
Ce menu permet de sélectionner une des 3 vitesses de 
ventilation du DMV01. 

 

DPBT01/DPBT02/DPBT04/DPBT06/DNKPB04/DNKPB06/DNIPB01/DNIPB02/D
NIPB0/DNIPB06 
 Description 

Boutons poussoirs design avec témoins lumineux. Les témoins lumineux bleus et rouges 
sont dimmables couleur par couleur. Le contour du bouton passe du bleu au rouge en 
fonction de l'état de la sortie (Fonction suiveur). Gestion de nuit permettant la gestion de 
l'intensité des témoins lumineux en fonction de l'horloge Astronomique ou d'une période 
déterminée par l’Utilisateur. Fonction de clignotement des témoins lumineux selon une 
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période personnalisable. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre E/S : Noms des boutons entrée, nom des témoins lumineux de sortie, appuis 
et fonction inverse. (description dans l'information générale du titre Entrée. 

• Gestion des intensités : Réglage des niveaux d'intensité des témoins lumineux. Sélection 
du mode gestion de nuit. Mode Inactif, l’intensité reste en mode jour. Mode Astronomique, 
le changement d'intensité jour-nuit s'effectue en fonction du lever et du coucher du soleil. 
Mode réglage Utilisateur, le changement se fait en fonction de la période désirée. 

DIN10V02 
 Description 

Module de réception d'un signal analogique d'entrée 0-10V sur le bus. Le module est 
paramétré à l'aide du logiciel de configuration comme entrée ou comme interface sur une 
sonde de température 0-10V. La plage de mesure est segmentée en maximum 100 
valeurs. Nombre d'entrées : 1. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
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module est modifiable. 
• Paramètre : Nom de l'entrée 0-10V. Choix du type de donnée 0-10V, donnée analogique 

ou donnée température. Gestion de la plage de fonctionnement par réglage de la tension 
min. et Max. mesurée. Fenêtre de conversion de mesure, par défaut en valeur %. 
Rafraîchissement des données selon une période ou un écart de tension déterminé. 

DVIP01 & DVIP02 
 Description 

Module vidéophone intégré au système domotique Domintell. Protocole de transfert audio 
et vidéo sous IP. Affiche et communique avec les écrans DTSC04. Présence des 
paramètres d'affichage O-LED et du volume dans logiciel de configuration Domintell. 
 Édition du module 

• Caractéristiques générales: Nom, type, version firmware et adresse du module. Seul le nom 
du module est modifiable. 

• Entrée: Nom du bouton d'entrée DVIP01 (appel), nom de la fonction de commande de 
porte. 

• Affichage: Choix de disposition, champs texte, type d’alignement, Aperçu direct du 
rendu final. 

• Connexion: Choix de mode DHCP ou insertion d'une adresse IP fixe. Possibilité d'appliquer 
directement les changements de connexion en appuyant sur le bouton Appliquer. 
• Volume: Sélection du niveau de volume du haut-parleur. 

 
 Informations supplémentaires 

Possibilité de disposer de l'image statique du vidéophone par requête ftp de cette forme : 
ftp://dvip0x_ip/di_screenshotd/ 

 

DPBR04 
 Description 

Bouton poussoir tactile design avec témoins lumineux. Configuration de la couleur des 
témoins lumineux pour chaque bouton. Choix de 16 millions de couleurs. Clignotement 
des témoins lumineux possible. Possibilité d'envoi d'une couleur précise lors d'un 
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événement. Un signal sonore peut être émis lors de l'appui. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Entrées : Noms des boutons entrée, 2 appuis, sélection du son sur appuis. 
• Sorties : Noms des témoins lumineux de sortie, sélection de la couleur du témoin lumineux 

« ON » et « OFF ». Par clic droit, possibilité de choisir individuellement les couleurs des 
états « ON » et « OFF » des témoins lumineux. Roue de sélection de couleur et champs de 
valeurs disponibles. Possibilité de dupliquer un choix de couleur sur toutes les sorties du 
module ou sur tous les boutons (ex : chaque 1er bouton de l'installation) ou de tous les 
boutons des modules DPBR0x présents sur l'installation. 

Réglage des niveaux d'intensité des témoins lumineux en période jour et nuit. Sélection 
du mode de gestion inactif, utilisateur (changement d'intensité en fonction de la période 
sélectionnée) et Astronomique (changement d'intensité en fonction du lever et du coucher 
du soleil). 

DPBECO01/DPBECO02/DPBECO04/DPBECO06 
 Description 

Boutons poussoirs design avec témoins lumineux. Témoins lumineux uniques, rouges et 
dimmables 
 Édition du module 
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• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Entrées : Noms des boutons entrée, 2 appuis, et fonction inverse. (description dans 
l'information générale du titre Entrée. 

• Sorties : Noms des témoins lumineux de sortie. 
• Gestion des intensités : Réglage des niveaux d'intensité des témoins lumineux en période 

jour et nuit. Sélection du mode de gestion inactif, utilisateur (changement d'intensité en 
fonction de la période sélectionnée) et Astronomique (changement d'intensité en fonction 
du lever et du coucher du soleil). 

La gamme DPBECO0x dispose uniquement d'un témoin lumineux ON, rouge. 
 

DPBL01/DPBL02/DPBL04 
 Description 

Bouton poussoir design de la marque Lithoss. Module découlant du partenariat entre 
Domintell et Lithoss. Témoins lumineux configurables par bouton avec un choix de 8 
couleurs prédéfinies. Clignotement des témoins lumineux possible. Possibilité d'envoi 
d'une couleur précise lors d'un événement. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Entrées : Noms des boutons entrée, 2 appuis. 
• Sorties : Noms des témoins lumineux sortie, sélection de la couleur du témoin lumineux « 

ON » et « OFF ». Par clic droit, possibilité de choisir individuellement les couleurs des états 
« ON » et « OFF » des témoins lumineux. Choix de 8 couleurs prédéfinies. Possibilité de 
dupliquer un choix de couleurs sur toutes les sorties du module ou sur tous les boutons (ex 
: chaque 1er bouton de l'installation) ou de tous les boutons des modules DPBL0x présents 
sur l'installation. 

Réglage des niveaux d'intensités des témoins lumineux en période jour et nuit. Sélection 
du mode de gestion inactif, utilisateur (changement d'intensité en fonction de la période 
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sélectionnée) et Astronomique (changement d'intensité en fonction du lever et du coucher 
du soleil). 
 

 SORTIES 
Informations générales 

La colonne à droite de l'écran affiche les Sorties. Elles effectuent les actions domotiques. 

DBIR01 
 Description 

Module 8 sorties relais bipolaires. Option de commutation des relais par micro- 
interrupteurs. Fonction opérationnelle lorsque le contact sans potentiel est fermé (par un 
interrupteur ou une connexion directe). Cette option permet de commander les relais 
manuellement sans la présence du Master. Lorsque les micro-interrupteurs sont 
basculés, l'unité centrale de la domotique ne peut plus commander ce circuit. 
Possibilité de consulter la durée de fonctionnement des différentes sorties. Possibilité de 
définir une consommation statique théorique. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Nom des sorties. Durée d'enclenchement des relais disponible en mode 
PC Actif. Possibilité de remise à zéro de la durée de fonctionnement. Champ de 
consommation théorique permettant une gestion théorique des consommations. 

DDIM01 
 Description 

Module d'interface dimmer (variateur). Carte de sortie pour la commande de 1 à 8 
dimmers de type DDxxx. 
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Édition du module 
Effectuer un clic droit sur une des sorties du module DDIM01 et sélectionnez l'option 
Éditer pour accéder à la fenêtre de paramétrage du module. 

 Cliquer sur les flèches horizontales pour faire dérouler les différents menus 
accessibles. Selon la version du module, certains menus peuvent ne pas être 
accessibles. 
• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 

module est modifiable. 
• Paramètre sortie : Nom des sorties. Option de mémorisation du niveau d'intensité du 

dimmer avant sa dernière extinction (mémoriser dernière valeur). Possibilité de consulter la 
durée de fonctionnement des sorties. Option de Valeur minimal disponible à partir de la 
version firmware 32. Possibilité de définir une consommation statique théorique. A partir de 
la version firmware 34, disponibilité du Mode single edge pour le contrôle des modules 
DD10V et DD400L. 

DTRP01 
 Description 

Module télérupteur, pour la commande de 1 à 4 télérupteurs. Lors de commande 
manuelle des télérupteurs, l'unité centrale de la domotique actualise le statut des cartes. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Nom des sorties. Durée d'enclenchement des périphériques télérupteurs 
TL2001 en mode PC Actif, possibilité de remise à zéro de la durée de fonctionnement. 
Possibilité de consulter la durée de fonctionnement des différentes sorties. Possibilité de 
définir une consommation statique théorique. 
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DTRP02 
 Description 

Module télérupteur inverseur pour la commande de moteurs à deux sens de rotation. La 
configuration de commande de 2 x 2 télérupteurs inverseurs permet l'enclenchement de 
moteurs à double direction de course. Lors du basculement manuel des télérupteurs 
TL1001, l'unité centrale de la domotique actualise le statut des cartes. Possibilité de 

réglage d'un temps de fin de course pour la montée et la descente. 
 Édition du module 
• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 

module est modifiable. 
• Paramètre sortie : Nom des sorties. Gestion de temporisation de fin de course. 

 
DTRV01 
 Description 

Module 4 volets 230V, pour la commande de moteurs à deux sens de rotation. (volets, 
screens, écran de projection, tente solaire, etc. Deux connexions sans potentiel 
permettent la commande manuelle de descente et de montée générale des 4 sorties. Le 
module est également équipé de témoins lumineux de visualisation indiquant l’état du 
relais. Gestion de volet, de type 'Américain' (volet à lamelles), par impulsion (mode 
pulse). 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Nom des sorties. Gestion de temporisation de fin de course. 
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 À partir de la version 3 du firmware du module DTRV01, les paramètres de temps 
de montée et de descente sont accessibles uniquement dans la fenêtre de paramétrage 
du module (clic-droit sur une des sorties du module > option Éditer). 

DTRVBT01 
 Description 

Module volets DC (direct current) basse tension (Max 24 Volt) pour la commande d'un 
moteur à deux sens de rotation. Utilisation des paramètres de consommation pour le 
réglage de sensibilité de fin de course. Durée et retour de fin de course programmable. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Nom des sorties. Gestion de temporisation de fin de course. 
• Paramètre de consommation : Réglage de la puissance et de la tension d'alimentation du 

moteur. Gestion de la sensibilité d'arrêt. L'option de Retour de fin de course volet permet le 
retour de course inverse du moteur. Il évite de laisser une tension mécanique dans les 
armatures. En mode PC actif, Commande manuelle direct du module. 

DLED01 
 Description 

Module 4 témoins lumineux programmé en fonction de l'état du consommateur, en 
fonction d'un statut de l'application ou allumés en permanence. 
 Édition du module 
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• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Nom des sorties. 

DOUT10V02 
 Description 

Module de sortie 0/1-10v sur bus. Le module (connecté directement sur le bus) permet la 
gestion de systèmes et d'appareils commandés par un signal analogique de 0 à 10 V ou 
1 à 10 V. Sélection des modes : 0 - 10 Vdc et 1 - 10 Vdc dans les paramètres E/S du 
module. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre E/S : Nom de la sortie. Basculement en mode 1-10V (Mode normal : 0-10V), 
Disponibilité du mode dimmer. En décochant cette option, il n'est plus possible d'utiliser un 
appui long pour dimmer la sortie DOUT10V02 (sécurité utilisée lorsque le module gère une 
régulation climatique). Option de mémorisation de dernière  valeur. Durée d'enclenchement 
de la sortie disponible en mode PC Actif. Possibilité de remise à zéro de la durée de 
fonctionnement. 

DMR01 
 Description 

Module 5 sorties relais monopolaires. Le module est équipé de micro-interrupteurs pour 
l'activation des relais sans la présence du Master. Module équipé de témoins lumineux 
de visualisation de l'état des relais. Possibilité de consulter la durée de fonctionnement 
des différents canaux. Possibilité de définir une consommation statique théorique. 
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 Édition du module 
• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 

module est modifiable. 
• Paramètre sortie : Nom des sorties. Durée d'enclenchement des relais disponible en mode 

PC Actif. Possibilité de remise à zéro de la durée de fonctionnement. Champ de 
consommation théorique permettant une gestion théorique des consommations. 

DDMX01 
 Description 

Interface maître pour protocole DMX512. Contrôleur de périphérique DMX (digital 
multiplexing). Permet le contrôle dynamique périphériques DMX (ex : éclairage de type 
strip led RGB). Supporte les fonctions dimmer et la gestion de LED's RGB. Nombre de 
sorties DMX gérées : 64 (max 8 drivers DMX de 8 sorties). 
 Édition du module 

• Paramètre module : Nom, type, version firmware, adresse du module et durée minimale du 
cycle de couleur. Seul le nom du module et la durée du cycle de couleur sont modifiables. 

• Paramètre sortie : Choix du nombre de canaux utilisés (Max 8 canaux par modules 
esclaves DMX). Adresse DMX du premier canal utilisé par l’esclave DMX configuré. Nom 
de l'esclave DMX. Configuration des canaux DMX de l'esclave : Nom, Type (Rouge, Vert, 
Bleu et Intensité). Valeur minimale (Min) et maximale (Max) entre 0 et 255. 
 Informations supplémentaires : 

La fonction de cycle de couleur DMX débute par la variation du canal Rouge de l'interface 
DMX. 

DINTDALI01 
 Description 

Interface maître pour protocole DALI2 (Digital Adressable Lighting Interface). Permet le 
contrôle dynamique d'un éclairage lié à un périphérique DALI. Supporte les fonctions 
dimmer. Capacités : max 64 appareils DALI disponibles par interface DINTDALI01. 
Protocoles DALI compatibles en version 1.48.00 : Type 0 (Fluorescent Lamps) ; Type 6 
(LED). Fonction de commissionnement DALI (équivalent au scan du réseau Domintell). 
Fonction de gestion des interfaces DALI : Accès aux réglages des paramètres internes 
DALI. Suivant le type d'appareils DALI connectés accès aux statistiques de l'appareil. 
2 http://www.dali-ag.org/ 

  

http://www.dali-ag.org/
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 Édition du module 

 

• Fenêtre principale: Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. Bouton d'activation de la procédure de commissionnement DALI. 

• Gestion appareillage DALI : Liste de Modules présents, de Nouveaux modules et de 
Modules absents. 
• Commissionnement : Liste, paramètres et caractéristiques des appareils DALI détectés. 

Nom, Type DALI, Code EAN, Numéro de série (Serial #), Version, Adresse (short addr.). 
 Informations supplémentaires 

Accès aux paramètres et informations avancées par clic droit sur le nom de l'appareil 
DALI repris dans la liste de commissionnement. La modification de ces valeurs doit être 
faite par un professionnel disposant des connaissances suffisantes en programmation 
DALI. Outil de rapport de maintenance disponible. 
 

DMV01 
 Description 

Module interface pour ventilation mécanique. Fonctionne avec 3 vitesses de ventilation 
pour le contrôle de la plupart des appareils de ventilation à double flux. Trois sorties 
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contrôlent les vitesses de ventilation, 2 sorties sont libres (ex : permet l'enclenchement 
d'un circuit d'éclairage). 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Nom des sorties. Le premier groupe de 3 relais monopolaires compose 
la Sortie DMV01. Le second groupe de relais reprend 2 relais auxiliaires.  AFFICHEURS 

Informations générales 
Les afficheurs reprennent les écrans de gestion globale de l'installation. 
 

 ÉCRANS TACTILES 
DTSC02 
 Description 

Écran tactile couleur TFT. Permet la visualisation et la commande générale des éléments 
présents sur le bus (éléments domotisés). Permet la modification, le réglage et 
l'ajustement de la régulation climatique, des horloges et de la gestion audio. Le module 
dispose d'une sonde de température, d'un récepteur IR, d'un lecteur de carte micro SD 
(µSD), d'une connexion au réseau Ethernet et d'un verrouillage par code d'accès. 
Réglage de l'intensité du rétro-éclairage. Réglage de l'heure et de la date. Fonction cadre 
photo déroulant disponible. 
 Édition du module 
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• Fenêtre générale : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Entrée : Noms des boutons entrées, 2 appuis (description dans l'information générale du 
titre Entrée) 

• Sortie : Noms des témoins lumineux sorties. 
• Configuration IP : Choix du mode de gestion de l'adresse IP du module. Gestion DHCP 

(Dynamic Host Configuration Protocol) ou par adresse IP fixe. 
•  Verrouillage écran : Champs du nom et choix de code d'accès à 4 chiffres. Un seul code 

possible. Le code 0000 empêche l'apparition d'un pavé numérique permettant de rentrer le 
code. Le verrouillage écran est alors activé/désactivé par une autre entrée. 
 Informations supplémentaires 

Outil de capture d'écran disponible via la page http://<ip_du_dtsc>:17480. redirection 
automatique vers l'image générée dans le ftp://<ip_du_dtsc>/di_screenshotd/SCR_*.png 
Pour connaître l'adresse IP du module, utiliser les outils de diagnostique mis à votre 
disposition : Le logiciel GdethTester, le menu ETH DIAGNOSTIC présent sur le master 
(DGQG01) ou la fenêtre de flash du module via Ethernet (Outils > Flasher > 
Firmware modules > Via Ethernet) 

DTSC04 
 Description 

Écran tactile couleur TFT et vidéophone. Permet la visualisation et la commande 
générale des éléments présents sur le bus (éléments domotisés). Permet la 
modification, le réglage et l'ajustement de la régulation climatique, des horloges et de la 
gestion audio. Le module dispose d'une sonde de température, d'un récepteur IR, d'un 
lecteur de carte micro SD (µSD), d'une connexion au réseau Ethernet et d'un 
verrouillage par code d'accès. Réglage de l'intensité du rétro-éclairage. Réglage de 
l'heure et de la date. Fonction cadre photo déroulant disponible. 
Possibilité d'affichage de flux vidéo IP de caméra de surveillance présente sur le réseau 
Ethernet. Outil de recherche de caméra IP Axis. Outil d'implémentation manuel de 
caméra IP. Réglage de l'heure et de la date. 
 Édition du module 

• Fenêtre générale : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 
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• Entrée : Noms des boutons entrées, 2 appuis (description dans l'information générale du 
titre Entrée) 

• Sortie : Noms des témoins lumineux sorties. 
• Configuration IP : Choix du mode de gestion de l'adresse IP du module. Gestion DHCP 

(Dynamic Host Configuration Protocol) ou par adresse IP fixe. 
• Verrouillage écran : Champs du nom et choix de code d'accès à 4 chiffres. Un seul code 

possible. Le code 0000 empêche l'apparition d'un pavé numérique permettant de rentrer le 
code. Le verrouillage écran est alors activé/désactivé par une autre entrée. 

• Volume : Réglage du volume audio en cas de présence d'un DVIP0x sur l'installation. 
 Informations supplémentaires 

Outil de capture d'écran disponible via la page http://<ip_du_dtsc>:17480. redirection 
automatique vers l'image générée dans le ftp://<ip_du_dtsc>/di_screenshotd/SCR_*.png 
Pour connaître l'adresse IP du module, utiliser les outils de diagnostique mis à votre 
disposition : Le logiciel GdethTester, le menu ETH DIAGNOSTIC présent sur le master 
(DGQG01) ou la fenêtre de flash du module via Ethernet (Outils > Flasher > 
Firmware modules > Via Ethernet) . 
 

 COMMUNICATIONS 
DGSM01 
 Description 

Module de communication par message textes SMS. Permet l'exécution d'actions sur le 
système et la réception de messages provenant de l'installation. Annuaire d'émission et 
de réception de messages configurables. Une batterie incorporée permet l'envoi de 
messages d'alarme à tout moment. Fonction d'envoi de messages d'alarme en cas de 
coupure et de restauration d'alimentation électrique. Outil de diagnostic du statut du 
DGSM01. Nécessite l’utilisation d’une carte SIM pour initier les messages. Possibilité 
d'envoi et de réception de messages SMS à 200 numéros de téléphone. 
 Édition du module 

• Options générales : Nom, type, version firmware et adresse du module. Seul le nom du 
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module est modifiable. 
• Statut : En mode PC Actif, le Bouton de Statut, permet de visualiser l'état des paramètres 

suivants: Niveau de Batterie, Connectique au bus, Mise en Charge, Niveau de température 
du module, détection de carte SIM, État de Réveil du DGSM01, Initialisation du DGSM01, 
Validation du code PIN. Menu Code PUK. Après insertion de 3 codes PIN erronés, la carte 
SIM se bloque. Insérer le code PUK de la carte SIM dans le menu Code PUK pour la 
débloquer. 

 
• Paramètre entrée/sortie : Noms de l'entrée et de la sortie. 
• Envoi de message : Permet l'envoi d'un message personnalisé, au choix, sur  perte 

d'alimentation et /ou sur restauration d'alimentation. Les messages sont envoyés à un seul 
numéro possible, le N°alarme . 

• Option GSM : Champs de code PIN. Toujours utiliser un code PIN. Ne pas utiliser le code 
0000, il est interprété comme code d'une carte SIM non initialisée. N° centre de message : 
Pour plus d'information référez-vous à la liste disponible sur le site PRO de Domintell ou 
consultez votre opérateur téléphonique. 
 Informations supplémentaires 
• Configuration via le software GoldenGate : 

Lors de la mise en service, la batterie doit être chargée pour permettre l'envoi d'un 
message. Pour atteindre un niveau de charge suffisant, attendre au moins 3 heures. 
Veuillez insérer la carte SIM à la fin de la configuration du module. 
Effectuer un scan du réseau, le module DGSM01 apparaît dans la colonne d'entrée et 
dans la colonne de sortie. En effet, le DGSM01 peut recevoir et émettre des SMS. 
Cliquer droit sur l’icône représentant le module. (colonne d'entrée ou de sortie au choix). 
Ensuite cliquez sur Éditer. 
Un Pop-up de configuration apparaît. 
Valider, aux choix les messages d'alarme pour l'information de la perte d'alimentation et 
de la remise sous tension. 
Introduisez le numéro d'alarme du propriétaire de l'utilisateur du DGSM01 (ex: 
+32487326101) 
Introduisez le numéro de serveur sms de votre opérateur téléphonique. Liste 
(SMS_Message_Service_2008.pdf) disponible sur le site PRO de Domintell. 
Proximus : +32475161616 Base : +32486000005 Mobistar : +32495002530 
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Tous les numéros doivent être encodés sous la forme : +_indicatif pays_numéro 
Introduisez le code PIN de la carte SIM. Ne pas sélectionner le code 0000 Transférer 
l'application au Master. 
À la fin du transfert de l'application, vous pouvez introduire la carte SIM dans le module 
DGSM01. 
Contrôler le statut du module GSM. 
• Autre : 

La recharge d'une carte prépayée ne peut se faire avec le module DGSM01 ou le logiciel 
GoldenGate. Utiliser un téléphone portable pour recharger la carte prépayée. 

DRS23201 
 Description 

Module d'interface entrée/sortie pour protocole RS232. Permet l'interconnexion avec des 
systèmes tels que air conditionné, alarmes, home vidéo etc... Informations émises et 
reçues par voie de messages textes. Connexion vers les périphériques par connecteur 
RS232 femelle (DB9). Librairie centrale pour la gestion des messages textes dans le 
logiciel GoldenGate. Possibilité d'utilisation de caractères spéciaux. 
 Édition du module 

La vitesse de transmission des données (Baud rate) et la parité du module doivent être 
sélectionnées pour permettre le transfert d'information. Le "mode étendu" permet 
d'envoyer et de recevoir des caractères dont le code ASCII est compris entre 0 et 31 
(caractères de contrôles) sous forme hexadécimal. 
 Informations supplémentaires : 

Le module DRS23201 gére une seule connexion. L'installation devra comporter autant de 
module DRS23201 que de systèmes à interfacer. 

 Par exemple, un message en provenance d'une centrale d'alarme peut enclencher 
l'allumage de tous les points lumineux de la maison. 

Informations générales DETH0x 
Avant d'utiliser un module DETH0x, il est conseillé de transférer une première fois la 
programmation via le port USB du Master (DGQG01). Cette connexion permet la 
configuration des paramètres du module DETH0x. 
 Édition du module et paramètres généraux 
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Accéder aux propriétés des modules DETH0x en éditant l'entrée du module DETH0x. 

Paramètres de connexion 
Si la case Utiliser DHCP est cochée. Le module recevra une adresse IP par un serveur 
DHCP présent sur le réseau. Si la case n'est pas cochée, il est possible d'entrer une 
adresse IP statique. Le port d'écoute définit le port sur lequel le module peut être 
contacté. Le port d'écoute par défaut est le 17481. Il est préférable d'utiliser un numéro 
de port supérieur à 1024. 
Paramètres de session 

Par défaut, le module est configuré en session exclusive. Lorsqu'une session est ouverte, 
il est nécessaire de fermer cette session avant de pouvoir ouvrir une nouvelle session à 
partir d'un autre ordinateur. En configuration de session non- exclusive, tout utilisateur qui 
demande une ouverture de session prendra la main sur le module DETH0x. Si une 
session était ouverte elle sera fermée. Une session exclusive implique de définir une 
durée de validité de cette session. Elle se fermera automatiquement si aucune 
commande n'est reçue durant le temps d'expiration de la session. 
Paramètres NTP 

Le NTP (Network Time Protocol) est un protocole permettant la remise à l'heure 
automatique. Les modules DETH0x offrent tous cette fonctionnalité qui remplace 
avantageusement le module DDCF01 (mise à l'heure automatique via l'horloge atomique 
de Francfort). L'option NTP requiert un accès à Internet. Chaque jour, à 3h du matin, une 
requète NTP est envoyée pour mettre à jour l'horloge du Master. L'adresse du serveur 
NTP doit obligatoirement être une adresse IP. Le bouton Rechercher serveur NTP, 
permet de trouver automatiquement un nom de domaine et de configurer la passerelle 
réseau (lue dans la configuration de Windows). 
Paramètres avancés 

Le bouton Rechercher permet de trouver l'adresse IP associée au nom de domaine 
donné. 
Le fuseau horaire (déterminé à partir des paramètres régionaux de Windows) ainsi que le 
passage à l'heure d'été (si activé dans le menu Outils->changement d'heure 
automatique) sont gérés par le Master. 
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Pour l'ouverture d'une session, il est possible de définir un mot de passe. Ce mot de 
passe est uniquement stocké dans le module, il ne figure pas dans le fichier *.dap. 
Modifier l'adresse MAC uniquement si le réseau comporte une carte possédant la même 
adresse MAC (qui doit être unique sur un réseau LAN). 
L'adresse MAC est uniquement stockée dans le module. 

DETH03 
 Description 

Interface de communication Ethernet. Connexion entre le bus domotique et le réseau 
local (LAN). Permet la connexion par Ethernet au logiciel de configuration GoldenGate. 
Possibilité d'adresse IP dynamique (DHCP) et fixe. Option de temps d'expiration de 
session. Fonctionnalité de mise à l'heure par connexion NTP (Network Time Protocol). 
Possibilité d'utiliser un mot de passe. Modification d'une partie de l'adresse MAC du 
module si nécessaire. Une connexion à Internet est indispensable pour la synchronisation 
au serveur de temps. 
Information de configuration au point Informations générales DETH0x 
 Informations supplémentaires 

Pour connaître l'adresse IP du module, utiliser les outils de diagnostic mis à votre 
disposition : Le logiciel GdethTester ou le menu ETH DIAGNOSTIC présent sur le master 
(DGQG01). 
 

 TEMPÉRATURE 
Informations générales : sonde de température 

Attention, certains écrans disposent de sonde de température permettant la gestion 
climatique. Cette rubrique reprend les modules strictement orientés gestion climatique. 
Les sondes thermiques Domintell disposent de profils différents, 
entièrement configurables, pour la gestion du chauffage et du refroidissement. 
Pour que la régulation puisse se réaliser correctement, chaque sonde Domintell doit être 
paramétrée. 
 Paramètres de base 
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Compensation 
Les sondes thermiques ne sont pas calibrées en usine. Cette compensation s'effectue 
lors de la mise en place du système. À l'aide d'un thermomètre étalon, mesurer la 
température au niveau du capteur de température. Entrer la différence entre la valeur 
mesurée de votre thermomètre étalon et la valeur fournie par la sonde Domintell (valeur 
disponible en mode Master en PC actif). 
Hystérèse 

Valeur utilisée lors de la sélection d'une régulation tout ou rien. Valeur paramétrable pour 
chaque sonde individuellement. Pour plus de détails, consulter le chapitre Type de 
régulations   
Températures d'absence 

Valeurs utilisées lorsque le mode de température de la sonde est en mode absence. Pour 
plus de détails, consulter le chapitre Type de régulations  
Rem : les températures d'absence sont communes à toutes les sondes. 
 Réglage consigne 

Réglage consigne 
Limitation du réglage consigne (en chauffe et en refroidissement) au niveau des 
différents écrans (DPBLCD02/DTSC02/DTSC04). Le réglage manuel de la consigne ne 
pourra excéder ces valeurs. 

Incrémentation consigne 
Cette valeur spécifie le pas d'incrémentation de la consigne lors du réglage manuel de la 
consigne de température. 
Rem : Cette valeur est commune à toute les sondes. 
Rem : En mode absence et en mode gel, la consigne ne peut être modifiée 
manuellement. 
 Paramètres d'affichage 

Les paramètres d'affichage gèrent l'affichage des modes de température (automatique, 
absence, confort et gel) et des modes de régulation (Mixte, Chauffe, Refroidissement, 
Off) de la sonde au niveau des afficheurs. (DTSC02 / DTSC04/ DPBLCD02). Si la case 
du mode est cochée le mode sera disponible dans le menu température de l'écran. 
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DTEM01 
 Description 

Module capteur température. Chaque minute, le module envoie au master la température 
mesurée. Permet l'enclenchement d'une sortie en fonction d'une température déterminée. 
Gestion d'actions par test logique, selon un mode de température (automatique, absence, 
confort et gel) ou un mode de régulation (Mixte, Chauffe, Refroidissement, Off) 
 Édition du module 

Se référer au titre : Informations générales : sonde de température  
 Informations supplémentaires 

Les paramètres de régulation & température sont réglés dans le logiciel GoldenGate. 
Pour plus de détails, consulter le chapitre Type de régulations . 

DTEM02 
 Description 

Module thermostat. Permet l'enclenchement de sorties en fonction d'une température 
déterminée avec la possibilité de modifier la consigne via 2 touches intégrées sur le 
module. Quatre modes de fonctionnement : automatique, absence, confort, gel. 

DFAN01 
 Description 

Module de contrôle pour climatiseurs de type FAN COIL. Trois relais contrôlent la vitesse 
du ventilateur. Deux relais contrôlent la demande de chauffage / refroidissement. Le 
module doit être utilisé avec une sonde de température Domintell. Possibilité d'adaptation 
d'enclenchement des vitesses d'Offset. Menu sélectif Activation climatisation/ chauffage. 
Mode de test disponible en gestion Master en PC actif. 
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 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Paramètre sortie : Valeur d'enclenchement des vitesses d'Offset de ventilation. 
• Activation climatisation/ chauffage : Possibilité de valider/dévalider les modes de 

température selon les modes de régulation de climatisation et de chauffage. 
 Informations supplémentaires 

Les paramètres de régulation & température sont réglés dans le logiciel GoldenGate. 
Pour plus de détails, consulter le chapitre Type de régulations . 
 

 DIVERS 
DRS23202 
 Description 

Interface RS232 Light Protocol. Module d'interface entre le bus Domintell et une entrée- 
sortie RS232. Permet l'interconnexion avec divers systèmes extérieurs tels que PC, 
écrans tactiles autres que Domintell et autres systèmes domotiques. Les actions sur le 
système Domintell s'exécutent par code texte Light Protocol, l'état du système Domintell 
est renvoyé par cette interface via un protocole disponible et délivré avec le module. 
Connexion vers les périphériques par connecteur RS232 femelle (DB9). 
 Édition du module 
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• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 
 Informations supplémentaires 

La vitesse des données (Baud rate) est fixée à 57600 Bauds et sans parité. 
Le module DRS23202 est destiné aux intégrateurs qui souhaitent interfacer leur système 
(système de supervision, programme informatique, etc) avec Domintell. Le but est de 
piloter directement un module de l'installation grâce à un protocole simplifié. Le 
DRS23202 peut recevoir des textes personnalisés (comme le DRS23201) mais pas en 
émettre. 

DAMPLI01 
 Description 

Amplificateur audio multi room. Permet la diffusion sonore stéréo de 4 sources audios à 4 
zones audios de la configuration. Les sources diffusées proviennent d'appareils 
indépendants auxiliaires (exemple : lecteur CD, lecteur DVD, lecteur de bandes, etc.) ou 
d'un des quatre tuners FM intégrés au module. Le DAMPLI01 dispose de sorties stéréo : 
4 paires (8 ohms). Puissance de sortie : 4 x 20 W RMS stéréo. 
 Édition du module 

• Paramètre module : Nom, type, version firmware et adresse du module. Seul le nom du 
module est modifiable. 

• Auxiliaires : Activation des entrées auxiliaires par sélection des cases correspondantes. 
Nom des appareils connectés dans les champs correspondants aux entrées utilisées. 

• Sorties IR dédiées : Si présence sur l'installation d'un module DIREMIT01 et d'un écran 
(avec sélection du menu audio), les sorties IR du DIREMIT01 permettent le contrôle des 
entrées auxiliaires audio dotées d'un récepteur IR. 

 Par exemple, La gestion audio d'une chambre se commande à partir d'un interrupteur 
tactile DPBTLCD0X. Lorsque je sélectionne la source audio DVD, il est possible 
d'envoyer au DVD des commandes Infrarouges. Par défaut, il s'agit des codes 
infrarouges des actions précédent et suivant. 
• Paramètre sorties : Noms des haut-parleurs connectés, valeur maximum du volume par 

canal. Sélection de groupes de stations radio. Ajustement de la balance des canaux de 
sorties 
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 Informations supplémentaires 
La répartition des sources entre les différentes sorties HP est indépendante. Il est 
possible d'écouter la radio dans la cuisine, de profiter d'un CD dans la salle de bain. Pour 
chaque sortie, il vous est possible de sélectionner la source à diffuser et d'ajuster le 
volume. Lorsqu'un des tuners est enclenché, il est possible de sélectionner une station 
radio ou d'ajuster la fréquence. 
Possibilité de contrôle du module depuis tous les modules Entrée (bouton poussoir, 
horloge, télécommande, …) Les fonctions dédiées au module DAMPLI01 sont définies 
grâce aux liens créés entre des entrées et les sorties du module. La répartition des 
sources est également accessible en sélectionnant la sortie depuis l'écran tactile. Une 
fenêtre permet de choisir le type de source à diffuser et d'y ajuster le volume (et les 
paramètres de radio si la source sélectionnée est un des tuners). 

 Pour une visualisation des commandes audios du DAMPLI01, il est conseillé 
d'utiliser un écran tactile. Outre la gamme d'écrans proposée par Domintell, il est 
possible de commander la gestion de l'audio via des applications pour smartphone 
Android, IOS, ... 
 Sélection des stations radios 

A partir du menu Projet > Gestion des stations, programmer vos stations radio FM 
favorites. 
Possibilité de scanner directement les fréquences radio avant de les enregistrer dans la 
base de données. 

Créer la liste de stations FM : 
• Recherche manuelle : (Mode Master autonome et mode Master autonome PC actif) 

Si vous connaissez la fréquence d'une station radio que vous désirez ajouter à la base de 
données, vous pouvez directement l'ajouter sans faire de recherche. 
Entrez la Fréquence et le Nom de la station. La fréquence doit être de la forme 99,1 ou 
99.1. 
Le bouton Fixer permet de tester la fréquence sur le module son (uniquement si le Master 
est en mode Master autonome PC actif). 
La station est ajoutée à la base de données en cliquant sur Ajouter. 
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• Recherche automatique : (Mode Master autonome PC actif) 
Cette opération nécessite de transférer l'application dans le Master et de passer en mode 
Master autonome PC actif. 

 

Marche à suivre pour l'encodage des stations : 
1. Sélectionner la sortie audio, physiquement la plus proche de vous, grâce aux 

boutons HP1, HP2, HP3 ou HP4. 
2. Ajustez le volume d'écoute à l'aide de la barre graduée. 
3. Démarrer la   recherche   en   appuyant   sur  les   boutons flèches       ou   

. Possibilité d'augmenter et de réduire la qualité sonore des stations en 
déplaçant le curseur de Sensibilité. 

4. Dès qu'une station est détectée, sa fréquence est indiquée dans le champ 
Fréquence. 

5. Désignez ensuite la station dans le champ Nom. 
6. Ajouter la nouvelle station dans la base de données en appuyant sur le bouton 

Ajouter. 
7. Répéter les opérations 3 à 5, afin de mémoriser toutes les stations 

désirées. Les stations mémorisées apparaissent dans la partie droite de 
la fenêtre. 

 

Le nom ou la fréquence d'une station de la base de données peut être modifiée en 
cliquant dessus et en adaptant les informations dans la recherche manuelle. 
Pour supprimer une station, faites un clic-droit sur la station et cliquez sur Supprimer. 
• Définition des groupes de stations : 

Pour limiter le nombre de stations radio à une sortie HP, lier cette sortie à un groupe de 
stations. L'action de sélection suivante et précédente se limite aux stations sélectionnées. 
Marche à suivre : 

1. Menu Projet => Groupe de Stations. 
2. Dans la partie centrale de la fenêtre, effectuer un clic droit et sélectionner l'option 

Ajouter. 
3. Nommer le nouveau groupe. 
4. Les stations précédemment mémorisées apparaissent à l'écran. Décocher celles 

qui ne doivent pas figurer dans le groupe. 
5. Valider en appuyant sur le bouton OK. 

 
Les groupes ainsi créés vont pouvoir être attribués à certaines sorties du module ( Il vous 
est possible à tous moments de modifier les groupes. Ils peuvent être supprimés 
uniquement s'ils n'interviennent pas dans les paramètres du module. 
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DETH02 
 Description 

Interface Ethernet "Light Protocol". Module d'interface entre le bus Domintell et un réseau 
Ethernet. Permet l'interconnexion avec divers systèmes extérieurs tels que tablette, 
smartphone, PC, écrans tactiles autres que Domintell et autres systèmes domotiques. 
Les actions sur le système Domintell s'exécutent par code texte Light Protocol. L'état du 
système Domintell est renvoyé par cette interface via le Light Protocol disponible et 
délivré avec le module. 
Possibilité d'adresse IP dynamique (DHCP) et fixe. Option de temps d'expiration de 
session. Fonctionnalité de mise à l'heure par connexion NTP (Network Time Protocol). 
Possibilité d'utiliser un mot de passe. Modification d'une partie de l'adresse MAC du 
module si nécessaire. Une connexion à Internet est indispensable pour la synchronisation 
au serveur de temps. 
Information de configuration au point Informations générales DETH0x. 
 Informations supplémentaires 

Une librairie (Windows / linux) est fournie pour crypter le mot de passe de connexion. 
La configuration de la communication et de la sécurité sur Internet doit être réalisée par 
un technicien compétent en réseaux informatiques. 
Pour connaître l'adresse IP du module, utiliser les outils de diagnostic mis à votre 
disposition : Le logiciel GdethTester ou le menu ETH DIAGNOSTIC présent sur le master 
(DGQG01). 
 

 MODULES PLUS SUPPORTÉS DEPUIS LA VERSION 1.24.xx 
Informations générales 

Cette rubrique reprend les éléments qui ne sont plus supportés depuis la version 1.24.00. 
Une partie ou la totalité des fonctionnalités de ces modules peuvent ne plus réagir dans 
la programmation. Cette information concerne particulièrement l'interconnexion de ces 
modules avec des modules récent. 

DTSC01 
 Description 

Écran tactile monochrome qui permet la visualisation et la commande des points 
domotisés ainsi que le paramétrage des températures, horloges, SMS, son, etc. Il intègre 
: sonde de température, récepteur infra-rouge 32 canaux, code d'accès. 

DTSC03 
 Description 

Écran tactile couleur qui permet la visualisation et la commande des points domotisés 
ainsi que le paramétrage des températures, horloges, SMS, son, etc. Il intègre : sonde de 
température, récepteur infra-rouge 32 canaux, code d'accès. 
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DLCD02 
 Description 

Module LCD. Permet la visualisation de l'état de toutes les sorties ainsi que la 
température des sondes. Il permet également la commande de toutes les sorties ainsi 
que la modification de certains paramètres. 6 boutons poussoirs dont 2 libres de 
programmation. 

DLCD03 
 Description 

Module LCD / température / son. Permet la visualisation de l'état et la commande des 
sorties ainsi que la température des sondes. Permet la modification de certains 
paramètres. Dispose d'une sonde de température, de cinq boutons poussoirs libres de 
programmation et de cinq images témoins. 

DUSB01 
 Description 

Module d'interface entre le bus Domintell et une entrée-sortie USB. Ce module permet 
l'interconnexion avec des systèmes extérieurs équipés d'une connexion USB tels que PC 
portable, PC, etc… Les informations sont émises et reçues par voie de messages texte. 

DDCF01 
 Description 

Horloge DCF. Se connecte au bus Domintell. Il met le système à l'heure exacte toutes les 
minutes dès que la synchronisation est établie. Ce module fonctionne sur la réception 
gratuite du signal de l'horloge atomique de Francfort (DCF77). 

DGRAFINT01 
 Description 

Interface USB - logiciel graphique. Interface par connexion USB. Permet le contrôle et la 
consultation des états de l'installation à l'aide du logiciel Visual Domintell. Support 
graphique en fond d'écran par importation d'images JPEG, BMP, ICO ou WMF au choix 
(équivalent au DETH04). 

DETH04 
 Description 

Interface Ethernet / Internet - logiciel graphique Visual Domintell. Module de 
communication Ethernet / Internet. Utilisation : Logiciel graphique en ligne (équivalent au 
DGRAFINT01), NTP. Permet de commander le programme Visual Domintell par 
connexion Ethernet / Internet. 

DETH07 
 Description 

Interface pour télécommande Philips Pronto. Interface Ethernet bidirectionnelle vers la 
commande Pronto de Philips. Permet en raccordant ce module à un routeur wifi, de 
contrôler son installation Domintell avec la commande Pronto de Philips. 
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 MODULES PLUS SUPPORTÉS DEPUIS GOLDENGATE 
DPULSE01 
 Description 

Interface le bus domotique à un triple compteur d'impulsion permettant le monitoring des 
consommations. Les trois entrées indépendantes d'impulsions sont paramétrables par le 
logiciel de configuration. 

DIREMIT01 
 Description 

Le module DIREMIT01 est une télécommande infrarouge universelle. Ses 3 émetteurs IR 
permettent l'envoi de codes IR vers des récepteurs infra-rouges (exemple : lecteur DVD, 
TV, projecteur, radio, etc). Le module dispose d'un capteur d'apprentissage (TEACH) 
pour apprendre les séquences de codes IR. 
 

 LES LIENS 
Action de base 

Le principe de la programmation sous GoldenGate est le Glisser-Déposer. Il consiste à 
sélectionner un élément de la colonne des sorties (droite de l'écran) et à le déplacer vers 
la colonne des entrées (gauche de l'écran). Un lien associe une entrée à une sortie et 
crée une action spécifique entre ces deux composants domotiques. 

 

Sélectionner 
 

 
 
 
 

Glisser 
 

 
 
 

Déposer 
 

 
 

Choisir l'action 
 

 
 Depuis la version 1.16.xx, les déplacements de Glisser - Déposer dans le 
programme GoldenGate se font toujours de la colonne de droite vers la colonne de 
gauche. 

Marche à suivre de la création d'un lien Domintell : 
1. Sélectionnez un composant dans la colonne des Sorties. 
2. Maintenez le bouton gauche de la souris enfoncé. 
3. Déplacer le composant sélectionné vers un composant de type Entrées 
4. Relâcher le bouton de la souris lorsque le composant Sorties est sur le composant 

Entrées désiré. 
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Si le lien est impossible, un sigle d'interdiction apparaît à côté du composant sélectionné. 

 
5. Au relâchement du bouton de la souris, une boîte de dialogue permet de configurer le 

lien. 
 

Paramétrage des liens 
Une boîte de dialogue apparaît à la fin de la manipulation de Glisser-Déposer. Les 
options de la boite de dialogue dépendent des caractéristiques techniques du module 
d'Entrée et du module de Sortie repris dans ce lien. 
Voici une boîte de dialogue qui apparaît suite au lien entre un module interrupteur (Ex : 
DPBT02-LG) et un module relais (DBIR01). Elle reprend tous les paramètres applicables 
au lien créé. 

Types d'appuis sur le module d'entrée 

Ce paramètre enclenche la sortie du lien sur un appui court ou sur un appui long de 
l'entrée. Un appui est considéré comme long lorsqu'il dépasse 0,4 seconde. 
Pour sélectionner l'option d'appui long, sélectionner cette fonction dans les paramètres 
du module d'entrée. 
Sélectionner l’appui long uniquement si deux actions différentes sont associées à 
l'entrée. Ex : une temporisation sur l'appui court et une action ON/OFF alterné sur l'appui 
long. 
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Les actions fonction dimmer et fonction volet enclenchent automatiquement l'option appui 
long. 

 Attention, ne pas valider l'appui long sans programmation du lien sur ce bouton. 
Sans programmation, l'utilisateur risque de dépasser le temps d'appui court et arriver 
dans la période longue. Donc ne pas avoir d'action. 

Marche à suivre : 
1. Cliquer-droit sur l’Entrée (1) 
2. Cliquer sur le bouton Éditer (2) 
3. Cocher la case appui long correspondant à l'entrée associée au lien (3) 
4. OK 

 
 

L'option Action sur fin d'appui permet de réaliser le lien uniquement lors du relâchement de 
l'entrée (front montant). 

Le paramétrage de chaque module est évoqué dans la suite de ce manuel. 
 Inversion du signal d'entrée : 

La fonction inverse permet d'inverser le signal transmis par un capteur. Elle est utilisée 
lorsque le contact d'un capteur est un contact normalement fermé (NC) ou que le 
consommateur raccordé sur la sortie est normalement fermé (NC). 
Fonction accessible à partir de l'écran de paramétrage des modules entrée de type 
bouton ou DISM0x. 

Actions de base : Modules sortie de type relais sur entrée de type bouton-
poussoir 
 Actions relais 

Les actions d'un module entrée, de type bouton poussoir, glissé et déposé sur une sortie 
de type relais se présentent comme ci-dessous. Les actions décrites ci-après sont 
applicables aux modules suivants : 
• DBIR01 ; DTRP01 ; DLED01 ; Sorties Auxiliaires DMV01 ; DMR01. 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    55 
TVA : BE0429942701  

• LEDs des modules entrées de type boutons poussoirs DPBU0x. 

ON/OFF Alterné 
Un premier appui sur l'entrée peut être l'enclenchement de la sortie. Un second appui 
provoque le déclenchement de la sortie. 
ON 

Un appui sur l'entrée provoque l'enclenchement de la sortie. 
OFF 

Un appui sur l'entrée provoque le déclenchement de la sortie. 
Maintien 

La sortie est enclenchée uniquement lorsque l'entrée est activée, maintenue. 
Temporisation 

Un appui sur l'entrée provoque le début de l'action sur la sortie. Elle peut être 
l'enclenchement ou le déclenchement. Cette action durera la période de temporisation 
déterminée. La durée maximum d'une temporisation est de 720 minutes. 
La sélection de l'action temporisation fait apparaître les paramètres suivants. Ils 
programment la durée de l'action de temporisation sur la sortie. 
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1. L'option Début > ON active la sortie pendant un temps déterminé. 
2. L'option Début > OFF désactive la sortie pendant un temps déterminé puis la 

rallume. 
3. L'option Durée détermine le temps de temporisation. 
4. L'option Action sur réappui permet trois types d'actions lors d'un nouvel appui 

durant la période de temporisation. L'action sur réappui est une action sur le 
même interrupteur. 

• Il peut y avoir un rechargement de la période de temporisation. 
• Il peut y avoir une exécution de l'action de fin. 
• Il peut également ne pas y avoir d'action. 

 

Si une action est enclenchée par une autre entrée du système (interrupteur, horloge, etc) 
sur la même sortie temporisée, la temporisation en cours sera annulée. 
 Délai 

Le délai permet de différer l'exécution du lien. 

 

La sélection de l'onglet Délai permet le retardement de l'action sur la sortie. 
L'option Action sur réappui permet quatre types d'actions lors d'un nouvel appui durant la 
période du délai 

1. Il peut y avoir un Rechargement de la période de délai. 
2. Il peut y avoir un Arrêt. Il supprime le délai ainsi et l'exécution du lien. La sortie ne 

sera donc pas activée. 
3. Il peut y avoir une exécution de l'action de fin. Le Délai est annulé et l'action prend 

effet immédiatement. 
4. Il peut ne pas y avoir d'action. Le Délais court jusqu'à l'exécution de l'action. 

 Le délai est fréquemment utilisé lors d'une extinction générale de la maison. Il 
permet à l'utilisateur de ne pas directement se retrouver dans le noir. Il dispose par 
exemple d'1 minute pour sortir, fermer sa porte et entrer dans sa voiture. 
 En laissant plus de 5 secondes le curseur de votre souris au-dessus d'une des 
actions mentionnées, le descriptif de l'action apparaît. 
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Actions de base : Modules de type sortie Dimmer/ Variateur sur entrée de 
type bouton poussoir 

Les actions d'un lien entrée de type bouton poussoir sur une sortie de type Dimmer/ 
Variateur se présente comme ci-dessous. Les actions décrites ci-après sont applicables 
aux modules suivants : 
• DDIM01 ; DOUT10V02 ; DDMX01 ; DINTDALI01 

Les actions de type ON/OFF, ON, OFF et Maintien sont vues au point Actions de base : 
Modules sortie de type relais sur entrée de type bouton poussoir   
 Actions dimmer / variateur 

Valeur dimmer 
Permet d'enclencher un point lumineux à un certain pourcentage de sa valeur maximale. 
Pour éteindre la sortie, il faut créer un second lien ou sélectionner l'action Valeur/OFF 
alternés. 
Le temps de montée est la période pendant laquelle le point lumineux va atteindre la 
valeur sélectionnée. 
Fonction dimmer 

Cette action permet de varier la valeur d'un point lumineux en fonction de la durée de 
l'appui sur l'entrée. 
Une action brève sur l'entrée, lorsque le point lumineux est éteint, allume le point 
lumineux à sa valeur maximale. Une action brève sur l'entrée lorsque le point lumineux 
est allumé éteint le point lumineux. 
Une action longue sur l'entrée dimme/varie le pourcentage d'intensité. 
Fonction temporisation 

Cette fonction permet l'enclenchement d'un point lumineux pendant une période 
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déterminée. Le temps de montée ainsi que la valeur appliquée sont configurables à partir 
de l'onglet Dimmer. Information de base de la temporisation au point Actions de base : 
Modules sortie de type relais sur entrée de type bouton poussoir   
Valeur/OFF alternés 

L'action enclenche un point lumineux à un certain pourcentage de sa valeur maximale. 
Une action sur l'entrée lorsque le point lumineux est éteint provoque son allumage 
jusqu'à la valeur sélectionnée. 
Une action sur l'entrée lorsque le point lumineux est allumé provoque son extinction. 
Le temps de montée s'applique lors de l'allumage et lors de l'extinction du point lumineux. 

Actions de base : Modules sortie de type Volet/ moteur à deux directions 
sur entrée de type bouton poussoir 

Les actions d'un lien entrée de type bouton poussoir sur une sortie de type Volet/ Moteur 
à deux directions se présentent comme ci-dessous. Les actions décrites ci-après sont 
applicables aux modules suivants : 
• DTRV01 ; DTRP02 ; DTRVBT01 

 Actions Volet/ moteur à deux directions 
Montée 

L'action permet la montée automatique d'un volet. Les paramètres de l'écran ci- dessous 
indiquent le temps de montée du volet. 
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Descente 
L'action permet la descente automatique d'un volet. Comme pour l'action « Haut », il est 
possible d'introduire le temps de descente du volet. 
Montée sur maintien 

L'action permet la montée manuelle d'un volet en combinant l'appui long et l'appui court. 
L'appui court permet une levée avec temporisation de fin de course. L'appui long permet 
une levée avec maintien. 
Descente maintien 

L'action permet la descente manuelle d'un volet en combinant l'appui long et l'appui court. 
L'appui court permet une descente avec temporisation de fin de course. L'appui long 
permet une descente avec maintien. 
Fonction volet 

La fonction volet commande la montée et la descente à partir d'un seul bouton poussoir. 
Les appuis courts et longs sont sélectionnés automatiquement. 
Un appui court sur le bouton de commande active la montée ou la descente du volet. Un 
nouvel appui lors de la montée ou de la descente arrête le mouvement. Si aucun appui 
est effectué pendant le mouvement, le volet s'arrêtera à la fin de la durée de 
montée/descente paramétrée. 
Un appui maintenu sur le bouton de commande provoque la montée ou la descente 
manuelle du volet. Le mouvement s'arrête après relâchement du bouton. 

 Les commandes de montée et de descente sont alternées. Une commande de 
montée sera obligatoirement suivie d'une commande de descente. Deux commandes de 
montée ou de descende successives sont donc impossibles sur cette fonction. 
OFF 

L'action permet l'arrêt immédiat d'un volet quel que soit le mouvement. 
Impulsion montante 

Lors de l'automatisation de stores à lamelles (volet américain), il est possible de contrôler 
l'orientation des lamelles par l'enclenchement d'impulsions successives du relais. L'action 
permet l'envoi d'un nombre d'impulsions montantes durant une période de temps haut. Le 
nombre d'impulsions est séparées par une période temps de pause éditable. 
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Impulsion descendante 
Lors de l'automatisation de stores à lamelles (volet américain), il est possible de contrôler 
l'orientation des lamelles par l'enclenchement d'impulsions successives du relais. L'action 
permet l'envoi d'un nombre d'impulsions descendantes durant une période de temps 
haut. Le nombre d'impulsions est séparées par une période temps de pause éditable. 
Fonction montée volet américain 

Lors de l'automatisation de stores à lamelles (volet américain), il est possible de contrôler 
l'orientation des lamelles par l'enclenchement d'impulsions successives du relais. 
L'action permet la montée manuelle d'un store à lamelle en combinant l'appui long et 
l'appui court. L'appui court permet une levée avec temporisation de fin de course. L'appui 
long permet l'enclenchement par impulsions avec maintien. 
Fonction descente volet américain 

Lors de l'automatisation de stores à lamelles (volet américain), il est possible de contrôler 
l'orientation des lamelles par l'enclenchement d'impulsions successives du relais. L'action 
permet la descente manuelle d'un store à lamelle en combinant l'appui long et l'appui 
court. L'appui court permet une descente avec temporisation de fin de course. L'appui 
long permet l'enclenchement par impulsions avec maintien. 
Fonction volet américain 

La fonction volet américain permet de commander la montée et la descente ainsi que le 
pivotement par impulsions à partir d'un seul bouton poussoir. Les appuis courts et longs 
sont sélectionnés automatiquement. 
Un appui court sur l'entrée active la montée ou la descente du volet. Un nouvel appui lors 
de la montée ou de la descente arrête le mouvement. Si aucun appui n'est effectué 
pendant le mouvement, le volet s'arrêtera à la fin de la durée de montée/descente 
paramétrée. 
L'appui long permet l'enclenchement d'impulsions avec maintien, vers le haut ou vers le 
bas, selon le dernier mouvement de la sortie. 

 Les commandes de montée et de descente sont alternées. Une commande de 
montée sera obligatoirement suivie d'une commande de descente. Deux commandes de 
montée ou de descende successives sont donc impossibles sur cette fonction. 
 

 LIENS SUR MODULE ENTRÉE ANALOGIQUE 0-10V : DIN10V02 
Les liens présentés dans cette partie sont accessibles si le module DIN10V02 est en 
mode Entrée analogique. En cas de validation du mode entrée température, consulter le 
titre Gestion de la température   
 Gestion d'une action selon le niveau de tension 0-10V 

La création d'un lien sur le module DIN10V02 s'effectue en fonction d'une valeur 
analogique. 

1. Action si la valeur analogique est Au-dessus d'un niveau de tension 0-10V 
2. Action si la valeur analogique est En dessous d'un niveau de tension 0-10V 
3. Action si la valeur analogique est Égale à un niveau de tension 0-10V 
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4. Action si la valeur analogique est Compris entre un niveau de tension 0-10V 

Pour une sortie dimmable, l'Action peut être effectuée en fonction d'une fonction 
mathématique. Sélectionner Fonction, cliquer droit sur le graphique et Modifier. 
Créer une fonction en cliquant dans le graphique. La valeur INPUT (signal analogique) 
est en abscisse. La valeur OUTPUT est en ordonnée. La fonction peut être effectuée en 
continue ou en palier. Valider l'enregistrement de la fonction en cliquant sur le bouton OK. 

Lors de l'édition d'une fonction existante, possibilité de modifier ou d'ajouter une nouvelle 
fonction. 

 Exemple : Utiliser un capteur de luminosité émettant un signal analogique 0-10V 
raccordé sur le module DIN10V02. Selon le niveau d'intensité lumineuse, les interfaces 
dimmer/variateur de la pièce s'adapteront pour diffuser une luminosité constante. 
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 LIENS DRS23201, DUSB01, DRS23202, DETH02 ET 
 DGSM01 
 Envoi d'un message texte (Uniquement avec DRS23201 et DUSB01) 

Cette action est obtenue lorsque la sortie du module DRS23201/DUSB01 (dans la partie 
droite de l'écran) est liée à une entrée. L'écran de paramétrage est le suivant : 

 

Sélectionner le message à traiter et le valider en appuyant sur OK. 
 Activation d'une sortie sur réception d'un message texte 

Cette action est obtenue lorsqu'une sortie est liée à l'entrée du module 
DRS23201/DRS23202 /DETH02/DUSB01 (dans la partie centrale de l'écran). 
Pour Ajouter un nouveau message, l'écrire dans le champ de saisie. Cliquer sur Ok pour 
finaliser la création du lien. Attention, la taille des textes ne doit pas dépasser 32 
caractères. 

Si le "mode étendu" est activé, les codes ASCII compris entre 0 et 31 doivent être notés 
en décimal (toujours deux caractères) et entourés par les caractères "<" et ">". 

 Exemple : Pour envoyer STX et GS, il faut écrire "<02><19>" (sans les guillemets). 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    63 
TVA : BE0429942701  

Valider en appuyant sur OK. 
 Gestion des messages pour le module DETH02 

Hormis sa fenêtre de configuration, le module DETH02 a les mêmes fonctionnalités que 
le module DRS23202. 
En dehors de l'utilisation du Light Protocol de Domintell, possibilité de créer des liens 
entrées sur le module DETH02. Cette fonctionnalité contrôle le système Domintell grâce 
à l'envoi d'autres messages textes que ceux utilisés par le Light Protocol. 
 Gestion des messages pour le module DGSM01 

L'interface DGSM01 dispose des mêmes fonctions que les modules DRS23201 et 
DUSB01. Dans le cas du DGSM01, l'élément effectuant l'action est la réception d'un 
message SMS. L'action du module est l'envoi d'un message sms. 

 Exemple : Le module DGSM01 envoie un SMS pour avertir d'une intrusion. Il est 
possible d'envoyer un SMS au DGSM01 pour enclencher toutes les lampes de 
l'installation et faire fuir le voleur. 

La gestion des numéros de téléphone est établie dans Contacts. 
(Projet > Contacts). 
Le répertoire téléphonique reprend les numéros des personnes pouvant recevoir et 
envoyer un SMS au DGSM01. Pour qu'un SMS envoyé d'un certain numéro puisse 
enclencher une action, le numéro doit être repris dans le répertoire téléphonique et 
disposer de la qualité accepter commande. 

• Lien DGSM01 en tant que Sortie (émetteur d'un SMS) 

1. Effectuer un glisser-déposer de la Sortie DGSM01  sur un module Entrée 
(exemple : bouton-poussoir). 

2. Introduisez le texte que vous souhaitez 
3. Valider en appuyant sur OK. 

 Exemple : le capteur de niveau d'eau de votre cave s'enclenche, le DGSM01 envoie le 
SMS 'INNONDATION'. 

• Lien DGSM01 en tant qu'Entrée (récepteur d'un SMS) 
1. Effectuer un glisser-déposer d'un élément Sortie (ex : lampe de la cuisine) 

sur l'élément Entrée du DGSM01 . 
2. Choisir le texte effectuant l'action 
3. Choisir l'action à effectuer. 
4. Valider en appuyant sur OK. 
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 Exemple : Je quitte la maison rapidement. Après 15 minutes, je me rends compte 
que je n'ai pas éteint certaines lampes. J'envoie un SMS Groupe toutes mes lampes 
OFF pour effectuer une extinction générale. 
 

 LIEN DMV01 
Le module dispose de 3 sorties de gestion de ventilation et de 2 sorties auxiliaires. La 
gestion des liens des sorties auxiliaires s'effectue comme les relais d'un module DMR01. 
Pour leur configuration, référez-vous au titre Actions de base : Modules sortie de type 
relais sur entrée de type bouton poussoir   
 Lien ventilation sur entrée de type boutons poussoirs ou horloge 

Les actions de contrôle de la ventilation sont : 
• L'enclenchement d'une vitesse précise. OFF, Vitesse 1, Vitesse 2, Vitesse 3. 
• L'incrémentation des vitesses avec une possibilité de bouclage des valeurs. 
• La décrémentation des vitesses avec une possibilité de bouclage des valeurs. 
• L'arrêt du module. Les 3 relais sont relâchés. 

 Lien ventilation sur entrée analogique 0-10V (DIN10V02) 
Selon la valeur analogique, possibilité d'effectuer l'enclenchement de vitesse(s) de 
ventilation. Pour configurer la gestion des valeurs analogiques du DIN10V02, consulter le 
titre Liens sur Module entrée analogique 0-10V : DINT10V02 .  
Les actions de contrôle de la ventilation dans un lien avec un DIN10V02 sont : 
• L'enclenchement d'une vitesse précise. OFF, Vitesse 1, Vitesse 2, Vitesse 3 
• L'arrêt du module. Les 3 relais sont relâchés. 

 LIEN DAMPLI01 
Le module DAMPLI01 est un amplificateur audio qui permet la diffusion sonore stéréo de 
4 sources audios à 4 zones audios de la configuration. Les sources diffusées proviennent 
d'appareils indépendants auxiliaires (exemple : lecteur CD, lecteur DVD, lecteur de 
bandes, Blue Ray, Serveur Audio, etc.) ou d'un des quatre tuners FM intégrés au module. 
L'amplificateur est pourvu de 4 sorties, sur chacune desquelles se raccorde une paire de 
haut-parleurs. 
Pour configurer les paramètres de base du DAMPLI01, lire le titre Sélection des 
stations radios  
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 Pour une visualisation des commandes audios du DAMPLI01, il est conseillé 
d'utiliser un écran tactile. Outre la gamme d'écran proposée par Domintell, il est possible 
de commander la gestion de l'audio via des applications pour smartphone Android, IOS, . 

Création des liens sur les sorties du module DAMPLI01 
L'utilisation du module DAMPLI01 nécessite la création de liens entre des entrées de la 
configuration et les sorties du module DAMPLI01. 
Les actions étant exclusives, sélectionnez-les une par une parmi les 3 principaux types 
(Volume, Tuner et Source). Pour effectuer l'enclenchement d'une station radio à un 
volume de 50 %, il faudra créer 2 liens comme illustré ci-dessous. 

Pour rappel, chaque paire de haut-parleurs connectée au module est considérée comme 
une seule sortie. 

1. Lien d'une sortie audio sur un bouton poussoir 
 

Contrôle du volume 
• Off : cette action coupe la sortie. 
• Augmenter volume : cette action augmente de 2 db (décibels) le volume de la 

sortie à partir de chaque impulsion sur l'entrée. Un appui long sur l'entrée génère 
l'augmentation dynamique du volume. 

• Diminuer volume : cette action diminue de 2 db le volume de la sortie à partir de 
chaque impulsion sur l'entrée. Un appui long sur l'entrée génère la diminution 
dynamique du volume. 

• Volume : Cette action permet d'obtenir le pourcentage de volume défini à partir de 
la liste déroulante Volume. Il est possible de configurer un temps de transition. 

• Volume ON/OFF : Cette action active et/ou coupe la sortie en un seul lien. Un 
premier appui sur l'entrée du lien permet d'obtenir le pourcentage de volume 
défini à partir de la liste déroulante Volume. Un second appui permet de couper la 
sortie. 

• Fonction volume : Cette fonction permet d'augmenter et de diminuer le volume à 
partir d'une seule entrée. Les commandes d'augmentation et de diminution du 
volume sont alternées : une commande d'augmentation sera automatiquement 
suivie d'une commande de diminution de volume, et inversement. Les appuis 
courts permettent la coupure ou l'enclenchement de la sortie. Les appuis longs 
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permettent de modifier dynamiquement le volume appliqué à la sortie. 
Pour les fonctions volume, Augmenter volume et Diminuer volume, les appuis 
courts et longs sont sélectionnés automatiquement. Il est possible de commander 
séquentiellement (par pas de 2 décibels) ou dynamiquement la sortie. 

Il est possible de déterminer un temps de transition pour les actions Off, Volume et 
Volume On/Off. Il s'agit de la période prise par la sortie pour atteindre le volume défini. 
Ce paramètre se détermine à partir des listes déroulantes de Temps de transition. 
Contrôle des stations radio 
• Recherche Up : Permet le balayage croissant des stations radio. 
• Recherche Down : Permet le balayage décroissant des stations radio. 
• Fréquence : Permet d'atteindre directement la station radio dont la fréquence doit être 

indiquée à partir du champ Fréquence. 
• Station : Permet d'atteindre une station radio mémorisée dans la base de donnée . Le choix 

de la station s'effectue à partir de la liste déroulante Station. 
• Station suivante et Station précédente : Permettent de passer en revue les stations 

contenues dans le groupe de stations attribué à la sortie. 
Contrôle des sources 
• Sélection source : Permet de sélectionner directement une des sources connectées au 

module DAMPLI01. La sélection de la source s'effectue à partir de la liste déroulante 
Source. 

• Source suivante et Source précédente : Permettent de passer en revue les différentes 
sources Auxiliaires connectées au module DAMPLI01 (Ex : Blu-Ray, Ordinateur, 
Télévision, etc.) 

2. Lien d'une sortie audio sur une horloge. 
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Action 
• Off : cette action coupe la sortie. 
• Volume : Cette action permet d'obtenir le pourcentage de volume défini à partir de la liste 

déroulante Volume. Il est possible de configurer un temps de transition. 
• Fréquence : Permet d'atteindre directement la station radio dont la fréquence doit être 

indiquée à partir du champ Fréquence. 
• Station : Permet d'atteindre une station radio mémorisée dans la base de données. Le 

choix de la station s'effectue à partir de la liste déroulante Station. 
• Sélection source : Permet de sélectionner directement une des sources connectées au 

module DAMPLI01. La sélection de la source s'effectue à partir de la liste déroulante 
Source. 

 

 LIEN DTSC02/DTSC04 
Cette partie reprend les fonctionnalités de verrouillage écran et vidéo DTSC04. Les liens 
concernant les leds témoins sont repris au titre Actions de base : Modules sortie de 
type relais sur entrée de type bouton poussoir  

Programmation des touches Actions 
Chaque écran est pourvu de 4 touches Action programmables. 

 

Ces touches sont des boutons poussoirs tactiles à partir desquels il est possible de 
programmer des liens. Les paramètres et le nom de ces touches sont modifiables. Elles 
sont visibles lorsqu'un lien est créé. 

Sélection des icônes 
Possibilité de modifier les îcones attribuées par défaut. Les icônes sont reprises dans 
une librairie. A partir du menu Projet > Sélection icônes. 

 
Marche à suivre : 

1. Sélectionnez le type d'élément (entrées, sorties, sondes, étages/pièces, 
ambiances, mémos, ...) pour lequel il faut une modification de l'icône. Parcourir 
la liste déroulante en haut à droite. 

2. Sélectionner l'élément pour lequel l'icône doit être remplacé. Parcourir la colonne 
de droite. Les icônes attribuées par défaut apparaissent en haut à gauche. 

3. Sélectionner dans la librairie l'icône qui représente l'élément dans son état ON. 
Glisser et déposer la dans le carré repéré Image ON. Effectuer la manipulation 
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similaire pour les autres états. 

Masquage de certains éléments sur l'écran tactile 
Certains éléments de l'installation peuvent ne pas être affichés. 
Marche à suivre : 

1. Sélectionner l'élément à ne pas afficher 
2. Cliquer sur le v vert « » pour masquer l'élément des écrans. Une croix rouge «   » 

à gauche de ces éléments indique qu'ils ne sont pas affichés à l'écran. Les Témoins 
lumineux, les Entrées et les Variables sont masqués par défaut. 

 

 Fonction intéressante lorsque des sorties de l'installation sont inutilisées ou lorsque 
des variables ou des mémos ne doivent pas être commandés. 

Paramétrage des écrans 
Par défaut, l'affichage des éléments sur les écrans DTSC0x suit la configuration de 
l'arborescence établie dans la première colonne du logiciel GoldenGate. 
Possibilité d'avoir un affichage différent pour chaque écran de la maison. Possibilité de 
définir l'ordre des éléments, d'afficher ou de masquer certains éléments. Le paramétrage 
devient essentiel lorsque l'installation comporte plusieurs écrans tactiles et qu'il est 
nécessaire de répartir les commandes en fonction de l'emplacement de chaque écran. 
Les paramètres définis seront d'application uniquement pour le module DTSC0x 
concerné. Toutes les modifications réalisées pour un écran local, ne se reporteront pas 
sur la globalité des autres écrans de l'installation. 

 Exemple : Un bâtiment industriel dispose de 2 écrans DTSC0x. L'écran installé dans 
le bureau du directeur peut commander l’entièreté de l'installation, l'écran DTSC0x de la 
réception, commande uniquement les pièces à l'avant du bâtiment. 

 
Pour accéder au paramétrage des écrans : Clic droit sur une des touches action de 
l'écran à configurer > Sélection de l'option Structure de l’écran. 
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La partie gauche de la fenêtre de paramétrage comprend : 
• Le menu Composants. Il reprend tous les éléments qui sont affichés sur l'écran principal. 
• Le Menu température. Il reprend toutes les sondes de température, les modes de 

température et les profils de température qui sont affichés dans le sous-menu Gestion de la 
climatisation de l'écran. 

• Le Menu horloge. Il reprend toutes les horloges créées qui pourront être affichées dans le 
sous-menu Gestion des horloges de l'écran. 

La partie droite de la fenêtre de paramétrage comprend les différents éléments qui 
pourront être affichés dans l'écran ou le menu correspondant. 
 Configuration par défaut : 

Chaque écran est paramétré selon un affichage par défaut : 
• la configuration de la maison apparaît telle qu'elle a été créée; 
• les sorties sont affichées par type et par ordre croissant de numéro de série du module; 
• les Témoins lumineux, les entrées et les variables ne sont pas affichés ; 
• les éléments masqués à partir de la fenêtre de gestion des icônes ne sont pas affichés. 

Personnaliser l'arborescence d'un écran local en décochant l'option 
Utiliser la configuration par défaut. 
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 Possibilités de paramétrage : 
• Définition de l'ordre d'apparition des éléments : 
• Organiser l'écran principal par manipulation de glisser-déposer vertical dans la partie 

gauche de la fenêtre. 
• Suppression d'éléments : 
• Cliquer droit et supprimer les éléments qui ne doivent pas apparaître dans l'écran principal. 

Les éléments retournent dans la partie droite de la fenêtre de configuration. 
• Ajout d'éléments : 
• Par manipulation de glisser-déposer à partir de la partie droite de la fenêtre de 

configuration, ajouter des éléments qui ne sont pas dans l'écran principal. 
• Modifications des noms et des icônes attribués aux pièces et aux étages : 
• Cliquer droit sur l'élément à modifier et remplacer les noms et/ou les icônes définis pour les 

pièces et les étages. 
• Les icônes des autres types d'éléments (entrées, sorties, mémos,...) sont communes à 

tous les écrans et ne sont pas modifiables à partir de la fenêtre de paramétrage des écrans 
tactiles. Pour les modifier, lire le titre Sélection des icônes  

Masquage de modules 
Certains modules et paramètres des écrans tactiles peuvent être protégés. A partir de la 
fenêtre de paramétrage d'un écran, cliquer droit sur un module et sur Supprimer. 

 

Le masquage d'un des menus supprimera l'accès à tous les paramètres qu'il contient. 
Désactiver les modules et les paramètres à masquer en les supprimant depuis cet écran. 

 Si l'écran tactile doit subir une modification de son OS. Veuillez vous référer au 
titre : Opérations préliminaires à la programmation  

Lien de Verrouillage écran 
Le verrouillage d'écran permet de bloquer l'accès aux fonctionnalités présente sur l'écran 
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durant la période de verrouillage. Les actions de verrouillage sont identiques à celles d'un 
module de type relais. Pour plus d'information, consulter le titre : Actions de base :  
Modules sortie de type relais sur entrée de type bouton poussoir  

Paramétrer le code de verrouillage par la fenêtre d'édition de l'écran tactile, dans la partie 
Verrouillage écran. 
Lors de l'appui sur l'écran, si le verrouillage est actif, un pavé numérique apparaît. Entrer 
le code pour déverrouiller l'écran. 
En cas de sélection du code 0000, aucun pavé numérique n'apparaît sur l'écran. Dans ce 
cas, le déverrouillage doit s’opérer par un autre élément entrée du système. 

 Exemple : Lors de l'enclenchement du système d'alarme, celui-ci averti la domotique 
et bloque l'écran tactile. Il faut que le système d'alarme soit désarmé pour que l'écran 
puisse à nouveau être disponible. 

Lien vidéo DTSC04 
L'écran DTSC04 permet l'affichage de flux vidéo provenant de vidéophone DVIP01 et de 
caméra(s) IP installée (s) sur le réseau. 

 Lien vidéo 
Par manipulation de glisser-déposer, faire apparaître la fenêtre de création de lien. Les 
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actions possibles sont : 
• Démarrer caméra 
• Arrêter caméra 

Possibilité de déconnexion automatique après une période déterminée. 
 Gestion des caméras IP 

Le menu Projet > Gestion des caméras reprend la liste des caméras présentes dans 
l'application. 
 Implémentation de caméras IP autres que les DVIP01/DVIP02 
• Pour des caméras IP autres que DVIP01/DVIP02 disposant d'une URL de contact : 

Introduire manuellement les paramètres de connexion, l'adresse IP et l'URL. 
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• Pour connaître l'URL de la caméra à encoder, lire les spécifications du fabriquant de la 

caméra ou consultez le site ISPY connect. 
http://www.ispyconnect.com/sources.aspx#info 

 Exemple : Pour la caméra IP D-LINK DCS 2121, il s'agit de cette forme d'URL : 
http://IPADDRESS/video/mjpg.cgi . 

Dans le logiciel GoldenGate, vous devez inscrire : /video/mjpg.cgi 
Le port de communication par défaut est le port 80, 
Le login et le mot de passe sont ceux utilisés par la caméra IP 
 

• Pour confirmer, cliquer sur Appliquer les changements puis OK. 
 

 CRÉATION DE LIENS MULTIPLES 
Possibilité de commander plusieurs Sorties à partir d'une seule et même Entrée. Comme 
pour les liens uniques, par manipulation de glisser-déposer, programmer les sorties les 
unes après les autres vers l'entrée sélectionnée. Pour chaque lien créé, une boîte de 
dialogue apparaît pour programmer le type de lien et ses paramètres. 

 

Si les actions de plusieurs Sorties insérées sont équivalentes, lire le titre Groupe . 
 

 FONCTION AVANCÉE DE L’APPLICATION 
Ce titre contient la marche à suivre pour la création de liens non repris au titre Actions 
de base : Modules sortie de type relais sur entrée de type bouton poussoir . 
 

 AMBIANCE 
La gestion des ambiances permet de modifier la configuration d'acteurs domotiques en 
une seule action. Une ambiance regroupe plusieurs sorties (points lumineux, 
commandes de volet, codes infra-rouges, etc.). L'ajout d'une scène attribue des valeurs 
par défaut aux sorties. Par manipulation de glisser-déposer, la scène programmée est 
liée à une entrée. 
La gestion des ambiances permet de centraliser une programmation de plusieurs liens 
entre différentes sorties et une seule entrée. La même scène peut être glissée sur 
plusieurs entrée. 
La fonction d'enregistrement permet de mémoriser les valeurs actuelles des sorties 
regroupées. Ces valeurs sont appliquées lors du prochain appui sur l'entrée dédiée à 
l'exécution de l'ambiance. 
 

http://www.ispyconnect.com/sources.aspx#info
http://ipaddress/video/mjpg.cgi
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Création de la liste des acteurs de l'ambiance 
1. Sélectionner les sorties à commander simultanément. (relais, dimmer, volet, variables, 

SMS, etc..). 
2. Effectuer un clic droit sur l'icône Ambiance => Ajouter une ambiance. 
3. Nommer la nouvelle ambiance. 
4. Par manipulation de glisser-déposer, de la colonne de droite vers celle de gauche, 

construire la liste des sorties reprises dans l'ambiance. 
5. Appuyer sur OK pour valider. 

Création des scènes 
Détermine les valeurs de chacune des sorties qui forment l'ambiance. Pour une même 
ambiance, il est possible de créer maximum 8 scènes différentes. 

Marche à suivre : 
1. Effectuer un clic droit sur l'ambiance précédemment configurée et sélectionner 

l'option 
Ajouter scène. 
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La colonne Nom reprend les sorties sélectionnées, 
La colonne Action reprend le type d'action appliqué aux sorties, 
La colonne Paramètres indique la valeur associée au type d'action. Cette colonne est 
complétée dans le cas d'une commande par dimmer, d'une commande audio,... 

2. Renommer la scène 
3. Dans la colonne des Noms, sélectionner la sortie désirée. Sélectionner la case 

correspondante dans la colonne Action. Sélectionner une action associée à la sortie. 
4. Si l'action est paramétrable, la partie Paramètres ambiance de la fenêtre affiche les 

différents paramètres associés au type d'action sélectionné. 
5. Valider en appuyant sur Appliquer. Ces paramètres sont maintenant affichés dans la 

colonne Paramètres au niveau de la sortie configurée. 
6. Effectuer les manœuvres décrites aux points 3 et 4 pour toutes les sorties du groupe. 
7. Terminer la configuration de la scène en appuyant sur le OK. 

 Par exemple : Le salon d'une habitation est équipé des cartes dimmers (DDIM01), volets 
(DTRV01), audio (DAMPLI01) et d'un émetteur infrarouge (DIREMI01). Celles-ci sont 
sélectionnées et forment l'ambiance SALON. Cette ambiance se décline en 3 scènes 
différentes. 

• La scène Cosy : Les dimmers sont à 70% et une musique douce est diffusée. 
• La scène Projection Cinéma : l'écran descend, le projecteur s'allume et les dimmers 

s'éteignent sur une période de 5 minutes. 
• La scène Eco: Une lampe est dimmée à 70%. L'audio et le projecteur passent en mode 

veille. 
• La scène OFF : Tous les acteurs de l'ambiance SALON sont éteints. 

Exécution des ambiances 
L'exécution d'une ambiance nécessite la création d'un lien entre une entrée et une les 
scènes précédemment créées. Par glisser-déposer, placer la scène désirée sur une 
entrée domotique. Lors de la création du lien, sélectionner Exécution ambiance. 
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Enregistrement d'ambiances 
L'enregistrement d'une ambiance consiste, à un moment précis, de mémoriser les 
valeurs des sorties des acteurs de l'ambiance. L'enregistrement crée une scène virtuelle. 
Ses statuts sont enregistrés dans la mémoire RAM du DGQG01. 

 L'exécution et l'enregistrement d'une scène peuvent s'effectuer à partir d'une seule 
et même entrée. Utiliser alors la fonction appui court pour l'exécution et la fonction appui 
long pour l'enregistrement. 

 Par exemple : Imaginons que les valeurs des appliques du salon, lorsque la scène 
« vidéo » est activée ne satisfassent plus les occupants. Il leur est alors possible 
d'ajuster les valeurs de ces lampes puis de les mémoriser en appuyant sur une entrée 
(bouton ou autre) qui est réservée à cette fonction. Les valeurs seront mémorisées 
uniquement pour cette scène. Les valeurs programmées pour les autres scènes restent 
donc inchangées. 

 

 GROUPES 
Les groupes permettent de regrouper plusieurs sorties (de même type ou de types 
différents) en une seule et même sortie. En un seul lien, un groupe permet de modifier, 
vers un même état, l'état de plusieurs sorties. 
Différents types de groupes : 
• Le groupe de Base : Regroupe les sorties suivantes : DLED01, DMR01, DBIR01, 

DTRP01, DDIM01, DOUT10V02, DAMPLI01, DIREMI01, leds/images témoins 
d'interrupteurs et variables. 

• Le groupe Volet : Regroupe les sorties de commande de moteurs à deux directions, 
principalement les volets. (DTRV01, DTRVBT01 et DTRP02). 

• Le groupe Dimmer : Regroupe uniquement les sorties dimmables (DDIM01 et 
DOUT10V02). Seul ce type de groupe autorise les actions fonction dimmer, Valeur 
dimmer et Valeur/Off alterné sur des sorties dimmer regroupées. 

• Le groupe Son : Regroupe les sorties des modules DAMPLI01. 
• Le groupe FAN : Regroupe les sorties des modules DFAN01. 
• Le groupe DMX : Regroupe les sorties des modules DDMX01. 
• Le groupe écran : Regroupe les sorties vidéos des écrans DTSC04. 
• Le groupe Led: Regroupe les sorties leds des modules DPBR0x et DPBL0x. 
• Le groupe DMV: Regroupe les sorties des modules DMV01. 
• Le groupe DALI: Regroupe les canaux de sorties DALI des interfaces DINTDALI01. 

Création d'un groupe 
Marche à suivre : 

1. Clic droit sur l'icône Groupes de la colonne des Sorties. 
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2. Renommer le nouveau groupe. 
 

3. Par manipulation de glisser-déposer, de la colonne de droite vers celle de 
gauche, construire la liste des sorties reprise dans le groupe. Pour ajouter 
plusieurs sorties en une fois dans le groupe, sélectionner les sorties désirées et 
cliquer sur le bouton     . Possibilité de supprimer une ou plusieurs sorties du 
groupe en appuyant sur la flèche unique        ou la flèche générale      . 

 Utiliser un groupe dès que plusieurs sorties de même type doivent être 
commandées par la même entrée. Ceci permet de replacer facilement ce groupe de 
sorties sur une autre entrée. Le groupe évite la désynchronisation de lien, car 
l’entièreté du groupe adopte le même état. 

Modification d'un groupe 
Possibilité de modifier la composition d'un groupe pour y ajouter ou supprimer une ou 
plusieurs sorties. Effectuer un Clic droit sur le groupe > Éditer 
Dans un but de stabilité de l'application, il est impossible de supprimer un groupe s'il est 
utilisé dans un lien. Il faut d'abord supprimer ce lien pour pouvoir supprimer le groupe. 
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Création d'un lien groupe 
Du point de vue programmation, un groupe est considéré comme une sortie unique. La 
création d'un lien groupe est identique à celui d'un lien entre une entrée et une sortie. 
L'état du groupe est l'état du premier élément de la liste des éléments composant le 
groupe. 
Les actions proposées dépendent du type de groupe. Pour plus d'information, consulter 
le titre Actions de base : Modules sortie de type relais sur entrée de type bouton 
poussoir  

 Le groupe de Base ne peut effectuer que les actions de base (ON/OFF alternés, 
ON, OFF, maintien, temporisation) même si elle est composée uniquement de modules 
dimmer. 

 

 LES SUIVEURS 
Suiveurs manuels 

La fonction suiveur permet de reporter l'état d'une sortie sur une autre sortie sans tenir 
compte de la commande exécutée sur la première. 

 Le suiveur manuel est utilisé lorsqu'un ballast de néon est contrôlé par un variateur 
0- 10V. Dans certains cas, il faut couper l'alimentation du ballast lorsque le variateur est 
à 0%. 

Marche à suivre : 
1. Sélectionner la sortie suiveuse et déplacez la vers l'icône suiveur dans la 

colonne des Entrées. 

 
2. Dans la boîte de dialogue, sélectionner la sortie suivie ; 

 
3. Validez en appuyant sur OK. 

 
Lorsqu’une fonction suiveur est attribuée à une sortie, il n'est plus possible d'attribuer 
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une autre fonction suiveur à cette sortie. 
 

 Lorsque plusieurs sorties doivent suivre une seule et même sortie, regrouper au 
sein d'un groupe les différentes sorties suiveuses. Lier le groupe à la sortie à suivre. 

Suiveurs automatiques 
Depuis la version 1.16.13, il est possible de générer automatiquement les suiveurs pour 
les leds témoins des boutons poussoirs (les images des modules DPLCD sont assimilées 
à des leds témoins). 
Marche à suivre : 

1. Créer les liens entre les Sorties et les Entrées disposant de leds témoins. 
 

2. Par un clic-droit sur l'icône Suiveurs, choisir Créer les suiveurs automatiques. 

 
Cette fonctionnalité crée un groupe de leds dans la colonne des sorties et un suiveur 
dans la colonne des entrées. Le suiveur dans la colonne des entrées lie la sortie qui 
changera d'état au groupe de leds qui vient d'être généré. 
Le suiveur est généré si un lien est programmé et que la led ou l'image du module 
entrée n'est pas repris dans une autre partie du programme (dans un lien, une condition, 
un groupe, une ambiance, …) 

 Par exemple : Un suiveur automatique généré pour le lien d'un relais d'un module 
DBIR01 piloté à partir d'un seul bouton. 

 Par exemple : Un suiveur automatique généré pour le lien d'un relais d'un module 
DBIR01 piloté à partir de plusieurs boutons. 

 

 Effectuer tous les liens de programmation. En fin de programmation, générer le 
groupe suiveur. 
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 ÉVÉNEMENTS PÉRIODIQUES 
Événements qui se répètent à intervalles réguliers, à chaque période de temps 
configurée. La première période commence à la fin de l'initialisation du master, juste 
après le transfert d'une application ou d'une action de redémarrage du DGQG01. 
Le schéma ci-dessous illustre la commande d'une sortie à partir d'un événement 
périodique. La fonction qui les lie est une action ON/OFF alternée. L'événement se 
répéte après chaque période. 
Le but de ces événements est de réaliser des actions répétitives sans avoir recours à une 
intervention de la part de l'utilisateur. 

 Par exemple : Un système de chauffage dispose de plusieurs circuits. Lorsqu'au 
moins un circuit est en demande, le circulateur doit se mettre en route. Lorsqu'aucun 
circuit n'est en demande, le circulateur doit s'arrêter. Une vérification périodique offre une 
solution rapide dans ce type de programmation. 
Les événements périodiques peuvent vérifier régulièrement les états des sorties 
regroupées au sein d'un groupe. En fonction de l'état d'une ou de plusieurs sorties du 
groupe, un type d'action programmé peut avoir lieu. 

 Pour ne pas surcharger la communication sur le bus, limiter le nombre 
d'événements ayant des périodes de courte durée (5 secondes est le délai minimum 
conseillé). 

Création d'un événement périodique 
Marche à suivre : 

1. Clic droit sur l'icône Événement périodique > Ajouter événement 

2. Renommer le nouvel événement. 
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3. Déterminer la durée de la période 

4. Valider en appuyant sur OK. 

  Par exemple : L'événement Action Arrosage effectuera une action sur la (les) sortie(s) à 
laquelle il est lié toutes les heures et 30 minutes. 

Création de liens à partir d'un événement périodique 
L'utilisation d'un événement périodique nécessite la création d'un lien entre celui-ci et la 
ou les sorties à piloter. Par manipulation de glisser-déposer, programmer les liens. Pour 
plus d'information consulter le titre Actions de base : Modules sortie de type relais sur 
entrée de type bouton poussoir   

 

 Certains liens repris au titre : Actions de base : Modules sortie de type relais sur entrée de 
type bouton poussoir   

ne sont pas disponibles dans la fonction d'événements périodiques. Un lien avec un 
module relais ne permet pas l'action de maintien. 
 

 ÉVÉNEMENT SUR CHANGEMENT 
Événement qui s'exécute suite au changement d'état d'une autre sortie. En fonction de 
l'action effectuée sur la première sortie mise en place dans l’événement sur 
changement, ON, OFF ou sur changement d'état, une action est exécutée sur une 
seconde sortie. 

 Par exemple : La lampe de mon WC est indépendante de la ventilation de mon WC. 
Lorsque j’éteins le WC, la ventilation débute une temporisation de 5 minutes. 

 L'événement sur changement est une bonne alternative à la programmation 
d'événements périodiques trop courts. 

Création d'un événement sur changement 
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Marche à suivre 
1. Par manipulation de glisser-déposer, apporter la Sortie dont son changement 

d'état produira le changement. 

2. Par manipulation de glisser-déposer, apporter la Sortie qui, suite au changement 
d'état de la première Sortie, effectue l’événement. 

 

3. Choisir le type de changement d'état qui enclenche l'action. ON, OFF ou changement 
d'état. 

4. Choisir le type d'action souhaité. Pour plus d'information lire le titre Actions de base 
: Modules sortie de type relais sur entrée de type bouton poussoir  

5. Valider en appuyant sur OK. 

 

 LIEN CONDITIONÉ, LES CONDITIONS 
Un lien peut s'effectuer selon certaines conditions. La sortie s'enclenche uniquement si 
toutes les conditions sont vérifiées. 
Les conditions prennent la forme de : 
• l'état d'une entrée ; 
• l'état d'une sortie ; 
• l'état ou la valeur d'une sortie dimmée ; 
• la température d'une sonde de température ; 
• la valeur d'une horloge ; 
• l'état ou la valeur d'une variable ; 
• l'état ou la valeur d'une variable système; 
• l'état ou la valeur d'une sortie audio ; 
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• l'état de groupes ; l'état d'ambiances ; 
• l'état, le mode ou la vitesse du DFAN01 ; 
• la valeur d'un signal analogique 0 -10Volt ; 
• la valeur d'un canal DMX ; 
• la valeur d'un canal DINTDALI01 

 

Ajout d'une condition 
Marche à suivre : 
1. Lors de la création d'un lien, sélectionner l'onglet Condition de l'écran ci-dessous. 

2. Effectuer un clic droit sur la première ligne vierge du tableau en bas de la fenêtre et 
sélectionner l'option Ajouter à la condition pour ouvrir la fenêtre de paramétrage de la 
condition. 

 
3. Sélectionner l'onglet du type de condition souhaité (Entrée, Sortie, Dimmer, etc...). 
4. Glisser-déposer la condition et déterminer ses paramètres. 
5. Cliquez sur OK. La condition apparaît dans la liste. 

 

6. Ajouter une autre condition si nécessaire 
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7. Valider en appuyant sur OK. La fenêtre de création des liens affiche maintenant 
toutes les conditions appliquées au lien. 

 Il s'agit ici d'une programmation de condition de type ET (AND). Pour constituer une 
condition de type OU (OR), vous devez répéter le lien de base entre l'entrée et la sortie, 
le nombre de fois que la condition de type OU est souhaitée. 

Types de conditions 
Condition sur une entrée 
• Option ON : le lien ne sera effectué que si l'entrée sélectionnée est activée. 
• Option OFF : le lien ne sera effectué que si l'entrée sélectionnée est désactivée. 

Condition sur une sortie 
• Option ON : le lien ne sera effectué que si la sortie sélectionnée est activée. 
• Option OFF : le lien ne sera effectué que si la sortie sélectionnée est désactivée. 

Condition sur une sortie dimmée 
• Option ON : le lien ne sera effectué que si la sortie dimmée sélectionnée est activée. 

Option OFF : le lien ne sera effectué que si la sortie dimmée sélectionnée est désactivée. 
Option Au-dessus de : le lien ne sera effectué que si la valeur de la sortie dimmée 
sélectionnée est supérieure à la valeur de consigne. 

• Option En dessous de : le lien ne sera effectué que si la valeur de la sortie dimmée 
sélectionnée est inférieure à la valeur de consigne. 

 
Condition sur une température 
 Selon la température que la sonde détecte 
• Option T° supérieure à : le lien ne sera effectué que si la valeur transmise par la sonde de 

température sélectionnée est supérieure à la valeur indiquée. 
• Option T° inférieure à : le lien ne sera effectué que si la valeur transmise par la sonde de 

température sélectionnée est inférieure à la valeur indiquée. 
• Option T° égale : le lien ne sera effectué que si la valeur transmise par la sonde de 

température sélectionnée est égale à la valeur indiquée. 
• Option T° comprise entre : le lien ne sera effectué que si la valeur transmise par la sonde 

de température sélectionnée se situe entre les valeurs des températures T1 et T2 
mentionnées. 
 Selon la consigne du profil de température 
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• Option Consigne supérieure à : le lien ne sera effectué que si la consigne est supérieure à 
la valeur indiquée. 

• Option Consigne inférieure à : le lien ne sera effectué que si la consigne est inférieure à la 
valeur indiquée. 

• Option Consigne égale à: le lien ne sera effectué que si la consigne est égale à la valeur 
indiquée. 

• Option Consigne comprise entre : le lien ne sera effectué que si la consigne se situe entre 
les valeurs de consigne T1 et T2 mentionnés. 

 Sélection du mode température de la sonde : Mode automatique, mode absence, 
mode confort, mode gel. Si cette restriction supplémentaire n'est pas désirée, laisser 
l'option tous les modes activés. 
 Sélection du mode de régulation de la sonde : Mode chauffage, mode 
refroidissement, mode mixte, mode OFF. Si cette restriction supplémentaire n'est pas 
désirée, laisser l'option tous les modes activés. 

 
Condition sur une horloge 
• Option Heure Après : le lien ne sera effectué que si l'entrée est activée après l'heure de 

consigne. 
• Option Heure Avant : le lien ne sera effectué que si l'entrée est activée avant l'heure de 

consigne. 
• Option Heure Comprise entre : le lien ne sera effectué que si l'entrée est activée entre les 

heures de consigne. 
• Option Date Comprise entre : le lien ne sera effectué que si l'entrée est activée entre les 

dates indiquées. 
◦ Sélection de jours de la semaine : le lien sera effectué en fonction des options 

reprises ci- dessus et si le jour de la semaine est sélectionné. 
◦ Sélection d'un jour, d'un mois, d'une année : le lien sera effectué en fonction des 

options reprises ci-dessus, si le jour de la semaine est sélectionné et si le jour et/ou 
le mois et/ou l'année correspond au moment de l'action. 

Condition sur une sortie audio 
• Option ON : le lien ne sera effectué que si la sortie audio sélectionnée est activée (au 

moins à 1%). 
• Option OFF : le lien ne sera effectué que si la sortie audio sélectionnée est désactivée 

(0%). 
• Option Au dessus de : le lien ne sera effectué que si le volume de la sortie audio 

sélectionnée est supérieur à la valeur de consigne. 
• Option En dessous de : le lien ne sera effectué que si le volume de la sortie audio 

sélectionnée est inférieur à la valeur de consigne. 

Condition sur une sortie DFAN01 

 Selon le Mode 
• Option Mode automatique : le lien ne sera effectué que si le mode de climatisation est en 

automatique. 
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• Option Mode manuel : le lien ne sera effectué que si le mode de climatisation est en 
manuel. 

• Selon la Vitesse 
• Option Off : Le lien ne sera effectué que si la vitesse de ventilation est nulle. 
• Option Vitesse 1: Le lien ne sera effectué que si la vitesse de ventilation est en vitesse 1. 

Option Vitesse 2: Le lien ne sera effectué que si la vitesse de ventilation est en vitesse 2. 
Option Vitesse 3: Le lien ne sera effectué que si la vitesse de ventilation est en vitesse 3. 
 Selon l'Etat 

• Option Off : Le lien ne sera effectué que si l'état des contacts de climatisation est éteint 
(OFF). 
• Option En chauffe : Le lien ne sera effectué que si l'état des contacts de climatisation est en 

chauffe. 
• Option En refroidissement : Le lien ne sera effectué que si l'état des contacts de 

climatisation est en refroidissement. 
Condition sur une sortie DMX 
• Option Au-dessus de : Le lien ne sera effectué que si la valeur du canal DMX sélectionné 

est supérieure à la valeur de consigne. 
• Option En dessous de : Le lien ne sera effectué que si la valeur du canal DMX sélectionné 

est inférieure à la valeur de consigne. 
• Option Egal : Le lien ne sera effectué que si la valeur du canal DMX sélectionné est égal à 

la valeur de consigne. 
• Option ON : Le lien ne sera effectué que si le canal DMX sélectionné est activé (au moins 

1%). 
• Option OFF : Le lien ne sera effectué que si le canal DMX sélectionné est désactivé (0%). 

Condition sur une entrée analogique de 0 à 10 Vdc (DD10V ou DOUT10V02) 
• Option Au-dessus de : Le lien ne sera effectué que si la valeur de l'entrée analogique 

sélectionnée est supérieure à la valeur de consigne. 
• Option En dessous de : Le lien ne sera effectué que si la valeur de l'entrée analogique 

sélectionnée est inférieure à la valeur de consigne. 
• Option Compris entre : Le lien ne sera effectué que si la valeur de l'entrée analogique 

sélectionnée est compris entre les valeurs sélectionnées. 
• Option Egal : Le lien ne sera effectué que si la valeur de l'entrée analogique sélectionnée 

est égal à la valeur de mesurée. 
Conditions sur un groupe 
• Option Au moins X sorties ON : Le lien ne sera effectué que lorsque le nombre de sorties 

activées au sein du groupe est supérieur ou égal au paramètre défini. 
• Option Au moins X sorties OFF : Le lien ne sera effectué que lorsque le nombre de sorties 

désactivées au sein du groupe est supérieur ou égal au paramètre défini. 
• Option Exactement X sorties ON : Le lien ne sera effectué que lorsque le nombre de sorties 

activées au sein du groupe est égal au paramètre défini. 
• Option Tout ON : Le lien ne sera effectué que si toutes les sorties du groupe sont activées. 
• Option Tout OFF : Le lien ne sera effectué que si toutes les sorties du groupe sont 

désactivées. 
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Conditions sur une ambiance 
• Option Ambiance identique : Le lien ne sera effectué que si toutes les valeurs des sorties 

de l'ambiance ont les mêmes valeurs que celles définies dans les paramètres de la scène 
sélectionnée. 

• Option Ambiance différente : Le lien sera effectué si la valeur d'au moins une sortie de 
l'ambiance est différente de celle définie dans les paramètres de la scène sélectionnée. 

Condition sur une variable système 
 Selon la simulation de présence 
• Option Valeur : Le lien ne sera effectué que si la valeur de la variable système sélectionnée 

est égale à la valeur de la consigne. La simulation de présence est active lorsque la valeur 
est vraie. La simulation de présence est inactive lorsque la valeur est fausse. 
 Selon que l'on soit en jour ou en nuit selon l'horloge astronomique 
• Option Journée : Le lien ne sera effectué que si la valeur de la variable système 

sélectionnée est égale à la valeur de la consigne. La valeur jour commence dès le lever du 
soleil et la valeur nuit commence dès le coucher du soleil. 

Condition sur une variable 
• Option Valeur : le lien ne sera effectué que si la valeur de la variable sélectionnée est égale 

à la valeur de la consigne. S'il s'agit d'une variable de type valeur, son statu sera  vrai ou 
faux. S'il s'agit d'une variable valeur, elle sera de 0 à 100 inclus. Pour plus d'information, 
consulter le titre : Les variables 

• Option Au-dessus de : le lien ne sera effectué que si la valeur de la variable sélectionnée 
est supérieure à la valeur de consigne. 

• Option En dessous de : le lien ne sera effectué que si la valeur de la variable sélectionnée 
est inférieure à la valeur de consigne.  

 

 LES VARIABLES 
Les variables sont des informations contenues dans la mémoire du master (DGQG01) 
en mémoire du système. L'utilisation de variables dans les conditions va permettre la 
création de liens plus complexes entre des entrées et des sorties. 
Les variables peuvent prendre la forme de sorties fictives Vrai/faux ou de valeur 
numérique. 

 Par exemple : Utilisation d'une variable VRAI/FAUX (booléene) pour le blocage d'une 
fonction pendant certaine période de la journée. 

 Par exemple : Utilisation d'une variable numérique pour programmer le déroulement 
de 5 fonctions successives (ex : 5 ambiances différentes) sur un même bouton. 

Création d'une variable 
Marche à suivre : 
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1. Clic droit sur l'icône variables dans la colonne des Sorties 

2. Renommer la variable créée. 

Paramétrage des variables 
L'utilisation de variables nécessite de déterminer préalablement le Type de variables. 
• Les variables de Type vrai/faux (Booléene) : 

Deux valeurs possibles : vrai ou faux. Les actions sur ce type de variables sont 
semblables à une sortie relais (allumée ou éteinte ; ON ou OFF). 

• Les variables de Type Valeur (numériques): 
Valeurs possibles : un nombre compris entre 0 et 100 inclus. La valeur limite de cette 
variable est sélectionnable à partir de la liste déroulante Limite. 
La valeur de la variable peut être bouclée : lorsque la variable incrémentée a atteint 
sa valeur limite, elle recommence son cycle. Cette option est activée en cochant la 
case indiquée Bouclage des valeurs. 

Modification de l'état des variables 
Le changement d'état d'une variable s'effectue à partir d'une Entrée (ex : bouton-poussoir). 
Modification de la valeur d'une variable de type vrai/faux 
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Une action sur une entrée va inverser l'état initial de la variable. Les actions disponibles 
sont : 

• Vrai/Faux alternés : Un premier appui sur l'entrée peut être l'activation de la 
Variable. Un second appui désactive la Variable. 

• Vrai : Un appui active la Variable. 
• Faux : Un appui désactive la Variable. 
• Maintien et temporisation : Plus information au titre Actions de base : Modules 

sortie de type relais sur entrée de type bouton poussoir  

 
Modification de la valeur d'une variable numérique 

La valeur d'une variable valeur peut être incrémentée, décrémentée ou portée à une 
certaine valeur. Ce changement a lieu à partir d'une impulsion sur l'entrée liée à la 
variable. La création du lien génère les actions suivantes : 
Incrémenter : La valeur de la variable augmente d'une unité après chaque impulsion sur 
l'entrée du lien. 
• Décrémenter : La valeur de la variable diminue d'une unité après chaque impulsion 

sur l'entrée du lien. 
• Valeur : La variable a comme valeur le nombre sélectionné dans la liste déroulante 

« Valeur » après une impulsion sur l'entrée du lien. 
• Valeur/ 0 alterné : La variable a comme valeur le nombre sélectionné dans la liste 

déroulante Valeur après une impulsion sur l'entrée du lien. Une nouvelle impulsion sur 
l'entrée provoque la remise à zéro de la variable. 



Domintell S.A.   
Rue de la Maîtrise, 9 
1400 Nivelles 
Belgique    90 
TVA : BE0429942701  

 L'utilisation du mode Master autonome en PC actif permet via l''ordinateur de 
changer le statut de la variable. Pour une variable valeur, il s'agit d'un changement de 
valeur de 0 à sa valeur maximale définie lors de sa création. 
 

 SIMULATION DE PRÉSENCE 
La simulation de présence reproduit les habitudes des occupants du bâtiment. 
Lorsqu'elle est active, elle enclenche les actions enregistrées une semaine auparavant. Il 
est possible de ne sélectionner qu'une partie des Sorties. 
L'enregistrement sur une période d'une semaine est effectué sous forme d'un 'buffer 
circulaire' mobile. Le système procède à une mise à jour continue de la simulation. 
Sélection des sorties à commander pendant la simulation 

Cette opération consiste à déterminer les sorties pour lesquelles le système va 
enregistrer l'état et ensuite le reproduire lors de la simulation. A partir du menu Projet > 
Simulation de présence. La fenêtre permet de sélectionner les sorties à enregistrer. 

 

 La lampe d'un WC ne disposant pas de fenêtre, ou la régulation d'un chauffage 
ne seront pas sélectionnés. 

Activation de la simulation 
La variable système Simulation de présence active la fonctionnalité de simulation de 
présence. La programmation de cette variable est semblable à la programmation d'une 
variable de type Vrai/faux. L'activation de la simulation peut donc s'effectuer à partir de 
n'importe quel type d'entrée : bouton, écran tactile, réception d'un message texte, 
horloge, ... 
Marche à suivre : 

1. Sélectionner la variable système Simulation de présence. Par glisser-déposer, 
déplacer la vers l'entrée souhaitée. 
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2. Sélectionner l'action souhaitée. (Pour plus d'information, consulter le titre Les 
variables ) 

3. Valider en appuyant sur OK. 
La simulation de présence peut être activée directement depuis un écran tactile. 

1. Pour les écrans DTSC01 et DTSC03 : A partir du menu de configuration de 
l'écran, sélectionner le sous-menu Gestion de la sécurité. A cet emplacement se 
trouve l'icône de la variable Simulation de présence. Ce type de commande ne 
nécessite aucun lien dans le programme de configuration. 

 
2. Pour les écrans DTSC02 et DTSC04 : A partir du menu de configuration de 

l'écran, sélectionner le sous-menu Outil. A cet emplacement se trouve l'icône de 
la variable Simulation de présence. Ce type de commande ne nécessite aucun 
lien dans le programme de configuration. 

Le système ayant besoin d'une semaine complète pour mémoriser les états des sorties à 
piloter, la simulation ne pourra fonctionner qu'une semaine après la mise en service de 
l'installation. Ce délai est également d'application à chaque nouveau transfert 
d'application vers le master DGQG01. Les données de simulation de présence sont 
stockées dans la mémoire RAM du DGQG01. Pour connaître l'état d'enregistrement de la 
simulation de présence, consulter le menu Outils > Journaux de simulation. 

 
 

 HORLOGES 
Les horloges effectuent des actions à des moments précis. L'horloge se règle sur une 
plage horaire de 24 heures liée à une grille hebdomadaire et à une sélection précise d'un 
jour, d'un mois ou d'une année. Les horloges sont incluses dans la mémoire du 
DGQG01. La limite est de 250 horloges. 

Type d'horloge 
• Horloge classique : A un certain moment s'enclenche une action que l'on a programmé. 
• Horloge astronomique : Elle s'adapte automatiquement au coucher et au lever du soleil 
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en fonction d'une date précise et de la situation géographique de l'installation. Il est 
possible de retarder ou d'anticiper une action par rapport à l'enclenchement de cette 
horloge. 

• Horloge au démarrage : Possibilité d'effectuer un certain nombre d'actions au démarrage 
du système (DGQG01 - Master) pour mettre des sorties dans des états particuliers. Ceci 
s'effectue à la fin de la période d’initialisation du DGQG01. 

Création des horloges 
Marche à suivre : 

1. Clic droit sur l'icône Horloges (colonne des entrées) > Ajouter horloge ; Ajouter 
horloge astronomique ; Ajouter horloge au démarrage. 

Horloge standard : Ajouter horloge : 
1. Renommer la nouvelle horloge. 
2. Déterminer les paramètres de l'horloge : 

• Heure : Détermine l'heure exacte à laquelle aura lieu l'événement. 
• Semaine : Détermine les jours de la semaine au cours desquels l'événement aura 

lieu. 
• Sélection du jour : Déterminer un jour d'un mois d'une année, un mois complet, 

une année complète ou une date précise à laquelle aura lieu une programmation. 
3. Valider en appuyant sur OK. 

Horloge astronomique : Ajouter horloge astronomique 
1. Ouvrez les paramètres de l’horloge astronomique via Projet > Paramètres 

régionaux 
2. Dans l’onglet Heure, vous pourrez configurer les paramètres pour sélectionner 

l’heure qui vous convient. Celle-ci est par défaut réglée pour la ville la plus 
proche de votre installation mais elle peut être personnalisée. 
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Cette fenêtre indique l'heure de lever et de coucher du jour. 
3. L'horloge astronomique peut effectuer une action soit au lever, soit au coucher. 
4. Il est possible de déterminer les paramètres de l'horloge : Anticiper ou Retarder 

l’exécution de l'horloge. Pour plus d'information sur le paramétrage de l'horloge, 
lire le titre Déterminer les paramètres de l'horloge . 

5. Valider les paramètres en appuyant sur OK. 
Horloge au démarrage ; Ajouter horloge au démarrage 

1. Cliquer droit sur Horloges > Ajouter une horloge au démarrage 

2. L'horloge au démarrage exécute sa programmation dès que le module 
DGQG01 effectue son initialisation. Ceci se produit après le transfert d'une 
application au master. 

3. Valider en appuyant sur OK. 

 Possibilité de Trier les horloges pour vous apporter plus de clarté dans 
votre programmation. 

Modification des paramètres d'une horloge 
Il est possible à tout moment d'adapter les paramètres d'une horloge : Clic droit sur 
l'horloge > Éditer. La fenêtre de configuration s 'ouvre alors et vous autorise à modifier 
les paramètres. 

Il est également possible de modifier une horloge à partir des écrans tactiles. Pour ce 
faire, référez-vous au chapitre Erreur : source de la référence non trouvée Erreur : source 
de la référence non trouvée. 
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Création des liens sur une horloge 
L'activation d'une sortie à un moment précis nécessite la création d'un lien entre un 
élément sortie et une horloge précédemment créée. Cette création de lien est la même 
pour les horloges standard, les horloges astronomiques et les horloges au démarrage. 

La partie gauche de la fenêtre indique les paramètres de l'horloge : nom, heure 
d'activation et périodes de fonctionnement. Il est possible de modifier ces paramètres 
directement à partir de cet écran en appuyant sur le bouton Horloge. 
En fonction de la nature de la sortie liée, choisir l'action souhaitée. Pour plus 
d'information sur les actions à effectuer, consulter le titre Actions de base : Modules 
sortie de type relais sur entrée de type bouton poussoir .  
 

 GESTION DE LA TEMPÉRATURE 
Le système Domintell permet d'effectuer des actions en fonction de la température 
mesurée par des sondes domotiques. Les actions sont de deux types. Soit une régulation 
climatique, soit un test logique appliqué à la température mesurée.  
 

 TYPES DE RÉGULATIONS 
Le système Domintell dispose de 4 types d'actions. Il s'agit de 3 types de régulations et 
d'un type d'action en fonction d'une valeur de température. Les régulations sont : la 
régulation proportionnelle, la régulation tout ou rien et la régulation DFAN01. Ces 
régulations sont disponibles pour la gestion du chauffage ou du refroidissement. 

Régulation proportionnelle 
1. Pour une sortie de type Relais 

Pour une période définie, la durée d'activation de la sortie est proportionnelle à la 
différence de température entre la consigne et la valeur mesurée par la sonde. 

2. Pour une sortie de type Dimmer 
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La période n'entre plus en compte. La valeur de la sortie sera directement 
proportionnelle à la différence de température entre la température mesurée et la 
température de consigne. 

Trois régulations proportionnelles prédéfinies sont proposées. Possibilité de personnaliser la 
régulation. 

* Rapide : période = 5 min ; bande proportionnelle = 1,5°C 

* Moyenne : période = 10 min ; bande proportionnelle = 2,5°C 

 

* Lente : période = 20 min ; bande proportionnelle = 3,5°C 

* Personnalisée : permet de modifier les paramètres de régulation. 
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Régulation tout ou rien 
Si la température est supérieure à la température de consigne la sortie est désactivée. Si 
la température est inférieure à la température de consigne diminuée de la valeur 
d'hystérèse, la sortie est activée.  

En mode climatisation, pour les régulations de type proportionnel et tout ou rien, la gestion 
d'activation de la sortie est inverse par rapport à la gestion du chauffage.  

1. Pour le chauffage, la sortie est activée si la température mesurée est inférieure à 
la température de consigne moins la valeur d'hystérèse. 

2. Pour le refroidissement, la sortie est activée si la température mesurée est 
supérieure à la température de consigne plus la valeur d'hystérèse. 

Toutes les sondes Domintell sont capables de gérer un profil de chauffe et un profil de 
refroidissement. En fonction des possibilités de votre installation vous devez sélectionner 
un seul, ou les 2 modes de climatisation. 

Régulation DFAN01 
Choix unique de régulation DFAN01. Les vitesses du module DFAN01 sont enclenchées 
en fonction de la différence de température entre la température de consigne et la 
température mesurée. Les relais de chauffage ou de refroidissement sont contrôlés 
suivant cette différence de température. 

Actions en fonction d'une valeur de température 
Il s'agit de l'action d'une Sortie en fonction d'un test logique appliqué à la température 
mesurée. 
On distingue 3 modes de comparaison ou test logique : 

Plus petit : la sortie sera activée si la température mesurée est inférieure à la 
température de consigne. 
Plus grand : la sortie sera activée si la température mesurée est supérieure à la 
température de consigne. 
Égal : la sortie sera activée si la température mesurée est égale à la température de 
consigne. 
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 PROGRAMMATION DE LA CLIMATISATION 
Pour accéder à la programmation de climatisation, effectuer un lien entre une sortie et 
une sonde de température. 

L'explication du choix du type de régulation est décrite au titre Type de régulations   

Choisir la gestion du chauffage et/ou du refroidissement 
En fonction des capacités de l'élément connecté au module de sortie, choisir le mode de 
gestion du chauffage et /ou gestion du refroidissement. 
Le choix de la gestion du mode de température chauffage et du mode de température 
refroidissement, se fait dans la fenêtre de Création de lien (pas le capteur de 
température). 

1. Si la sortie pilote uniquement une gestion de chauffage, sélectionner uniquement la 
gestion du chauffage. 

 Par exemple, une chaudière à gaz. 

2. Si la sortie pilote uniquement une gestion du refroidissement, sélectionner 
uniquement la gestion du refroidissement. 

 Par exemple, groupe de froid unique. 

3. Dans le cas d'un circuit de climatisation unique (2 pipes), si le module de sortie 
est capable de gérer le chauffage et le refroidissement, sélectionner les 2 
gestions (gestion du chauffage et gestion du refroidissement). 

 Par exemple, pompe à chaleur Inverter. 
4. Dans le cas d'un circuit de climatisation double (4 pipes), la gestion du chauffage 

se fait avec un module de sortie. La gestion du refroidissement se fait avec un 
autre.module de sortie. 

 Par exemple, Configuration utilisée dans des hôtels. Un lien contrôle le groupe 
de froid, l'autre lien contrôle la chaudière. En période d'entre saison, une partie du 
bâtiment peut être chauffée, et l'autre peut être refroidie. 
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La gestion de la climatisation se fait sur base d'une vanne normalement fermée. Lors de 
l'utilisation d'une vanne normalement ouverte, il est possible d'inverser la sortie en 
cochant l'option inversion de la sortie de la fenêtre de création de lien. 

Écart de température 
Une régulation s'effectue toujours à partir de la consigne du capteur de température. 
Domintell permet d'ajouter un Décalage de la température sur cette consigne. Lorsqu'un 
Écart de température est programmé, la régulation se fera sur la consigne de 
température additionnée de l'offset de température. 

 Par exemple, la salle de bain dispose d'un chauffage sol et d'un sèche serviette 
électrique. L'enclenchement du sèche serviette peut disposer de cet écart de 
température. Lorsque la température est trop éloignée de la consigne, le sèche serviette 
s'enclenchera pour chauffer plus rapidement la salle de bain.  

 

 MODE DE TEMPÉRATURE ET MODE DE RÉGULATION 
Mode de température 

Chaque sonde de température dispose d'un mode de température. Le mode de 
température d'une sonde permet la gestion de l'installation climatique au niveau de la 
gestion des profils de températures. 
Choisir un profil automatique, de confort, d'absence, ou de gel. 
• Mode Auto : Les profils de température de chaque jour de la semaine sont sélectionnés. 
• Mode Confort : Le profil de confort est sélectionné. 
• Mode Absence : La température d'absence est sélectionnée. 
• Mode Gel : La température de gel est sélectionnée. 

Pour avoir accès au mode de température dans un lien, il faut créer une zone de 
température comprenant la sonde. 

Mode de régulation 
Chaque sonde de température dispose d'un mode de régulation. Le mode de régulation 
d'une sonde gère l'installation climatique au niveau de la régulation. Les modes de 
régulation sont disponibles pour chaque sonde de température. 
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• Mode Mixte : exécution des liens (régulation) gérant le chaud et le froid. 
• Mode Off : les sorties liées aux régulations sont coupées. 
• Mode Chaud : exécution des liens (régulation) gérant le chaud. 
• Mode Froid : exécution des liens (régulation) gérant le froid. 

 
Pour accéder au mode de régulation dans un lien, créer une zone de température 
comprenant la sonde. 
Dans le cas d'une gestion en mode mixte, lorsque la gestion de la climatisation (source 
de chaud et source de froid) est centralisée dans un seul appareil, s'assurer que le 
changement du mode de régulation au niveau des sondes soit aussi communiqué à 
l'appareil de climatisation.  
 

 PARAMÉTRAGE DES SONDES DE TEMPÉRATURE 
Toutes les sondes Domintell possèdent la gestion de double régulation. Cette gestion 
permet de gérer le chauffage et le refroidissement par la même sonde. 
Pour que la régulation puisse se réaliser correctement, chaque sonde Domintell doit être 
paramétrée, plus d'information au titre Informations générales : sonde de température  

Assignation des profils 
Toutes les sondes Domintell possèdent 16 profils distincts, 8 pour la gestion du 
chauffage, 8 pour la gestion du refroidissement. 
Les profils automatiques qui parcourent les 7 jours de la semaine possèdent un profil de 
chauffe et un profil de refroidissement. 
Le profil confort possède également un profil de chauffe et un profil de refroidissement. 
La température d'absence est commune à toutes les sondes de température. 
La température de gel est commune à toutes les sondes de température. 
Assigner un profil 

Effectuer une action de glisser-déposer depuis la liste des profils vers l'image 
correspondante. 
Un profil de chauffage doit être déposé sur le thermomètre à fond rouge, signifiant la 
chauffe. Un profil de refroidissement doit être déposé sur le thermomètre à fond bleu, 
signifiant le refroidissement. 
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Effacer un profil 

Sur la page d’un profil, cliquer sur Profile > Supprimer. Possibilité d'effacer le profil de 
chauffe et le profil de refroidissement pour un jour sélectionné. Il est aussi possible d'effacer 
tous les profils de la sonde. 

Copier le profil 
Dans la menu d’édition de la sonde, aller dans l’onglet Copier les paramètres. 
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Copier les profils de température sur d'autres jours et / ou sur d'autres sonde de 
température. Sélectionner les jours où le profil doit être assigné. Sélectionner le profil à 
copier (Profil de chauffe et/ou profil de refroidissement). Sélectionner les sondes où le 
profil doit être copié. Valider en appuyant sur OK. 
Pour que la régulation climatique soit opérationnelle, tous les profils doivent être 
paramétrés (pour le type de régulation désiré). Si un profil n'est pas rempli un message 
apparaît lors de l'envoi de l'application. La régulation climatique se met en sécurité si un 
profil n'est pas complété. 
Si la sonde ne gère pas de régulation de chauffe, il est conseillé de ne pas remplir les 
profils de chauffe. Si la sonde ne gère pas de régulation de refroidissement il est 
conseillé de ne pas remplir les profils de refroidissement. 

Dépendance des sondes 
Lorsque plusieurs sondes constituent la régulation climatique, il est possible de constituer 
une dépendance entre celles-ci. Une sonde peut être Maître d'une ou de plusieurs autres 
sonde(s). 
La sonde esclave suit la sonde maître : 

• uniquement pour son mode de température, 
• uniquement pour sa consigne, 
• uniquement pour son mode de régulation, 
• ou une combinaison des trois options précédentes. 

Marche à suivre : 
1. Ouvrir la fenêtre de dépendance des sondes de température. Via l'édition d'une 

sonde de température et la modification de la fenêtre de sonde esclave. 
2. Sélectionner une sonde présente dans la colonne de droite de la fenêtre de 

dépendance et glissez la dans la colonne de gauche sur la sonde qui sera maître 
de cette sonde. 

3. Sélectionner le type d'héritage souhaité : héritage du mode de température, 
héritage du mode de régulation, héritage de la consigne. 

Pour supprimer une dépendance entre deux sondes, cliquez droit sur la sonde 
dépendante à supprimer. Cliquer sur supprimer. 

 Par exemple, Une habitation multizone est équipée d'une pompe à chaleur Inverter. La sonde 
du living est la sonde principale de la maison. Lorsque celle-ci change de mode de régulation, 
toutes les autres adoptent ce mode de régulation.  
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 CRÉATION D’UN PROFIL DE TEMPÉRATURE 
Les modes automatiques et confort se composent de profils de température. Le mode 
automatique peut gérer 7 profils différents pour les 7 jours de la semaine. Le mode 
confort utilise un profil fixe. 
Il est nécessaire de définir des profils de température pour chaque sonde. 
Marche à suivre : 

1. Éditer la sonde pour laquelle les profils de température doivent être définis. 
2. Profil > Ajouter/Modifier (en haut à gauche). Ou par, clic droit sur la liste des 

profils, sélectionner Ajouter/Modifier. 

3. Déterminer les différentes plages qui constituent le profil. Maximum 12 plages 
sur une période de 24 heures. 

Ajout d'un profil de température 
Marche à suivre : 

1. Dans la liste des profils, appuyer sur Nouveau. 
2. Clic gauche dans la zone de profil. Tout en maintenant le bouton gauche de 

votre souris enfoncé, bouger la souris pour dessiner le profil de température. 
Lors du relâchement du bouton gauche, la plage est créée. 

3. Les températures peuvent être directement complété dans le tableau situé dans 
la partie droite de l'écran. 

4. Pour enregistrer le nouveau profil, veuillez entrer un nom et appuyer sur enregistrer. 
Votre nouveau profil est ainsi créé. 
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Modification d'un profil de température existant 
Sélectionner le profil à modifier dans la liste des profils après être allé dans l’onglet 
Profils > Ajouter. Retourner dans l’onglet Profil > Enregistrer. 

Suppression d'un profil 
Sélectionner le profil à supprimer dans la liste des profils. Appuyer sur le bouton Supprimer. 
Le profil est supprimé de l'application. 
• Si le profil est utilisé dans l'application, une confirmation est demandée pour 

la suppression du module. 
• Si un profil utilisé est supprimé, toutes les sondes utilisant ce profil ne sont 

plus paramétrées.
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 ÉTAPES SUCCESSIVES D’UNE INSTALLATION STANDARD 
 Tâche 1 : Vérifier les loaders dans le master et écran tactile 
 Tâche 2 : Scanner le réseau 
 Tâche 3 : Renommer toutes les entrées et sorties 
 Tâche 4 : Répartition des pièces et des étages 
 Tâche 5 : Création des groupes (sorties, son, volets etc.) 
 Tâche 6 : Création des ambiances 
 Tâche 7 : Création des horloges 
 Tâche 8 : Adapter l’horloge astronomique 
 Tâche 9 : Création des événements périodiques 
 Tâche 10 : Création des variables utilisateurs 
 Tâche 11 : Création des zones de température 
 Tâche 12 : Par glisser-déposer, établir les liens entrées-sorties et attribuer les fonctions 
 Tâche 13 : Création des profils température 
 Tâche 14 : Par glisser-déposer, établir les liens éléments chauffage-sonde température 
 Tâche 15 : Configurer le module son + émetteur IR /récepteur 
 Tâche 16 : Configurer le module DGSM01 
 Tâche 17 : Sauver la configuration 
 Tâche 18 : Envoyer la configuration au master 
 Tâche 19 : Tester la configuration et vérifiez les fonctions 
 Tâche 20 : Prendre une copie de la configuration sur CD. 
 Tâche 21 : Effectuer un diagnostic réseau de l'installation 
 Tâche 22 : Enclencher tous les éléments domotiques durant au moins 2 heures pour 

s'assurer de la stabilité du réseau et des alimentations basse tension sur le bus.
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 DÉPANNAGE 
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 DIAGNOSTIC ET PRISE DE MESURE 
Vérifications du logiciel 

Exécuter le logiciel pour vérifier l'installation. Menu > Outils > Diagnostic réseau. 
Si des erreurs sont détectées, les résoudre. 

Heure & écran du DGQG01 
Mettre l'installation à l'heure correcte. 
Vérifier sur l'écran du DGQG01 que les 2 points entre l'heure et les minutes clignotent. 

Pile du DGQG01 
La tension de la pile (type = CR1216) du DGQG01 doit être plus haute que 2.8Vdc. 
La batterie du DGQG01 se situe sur le PCB électronique du DGQG01. Ouvrir le boitier du 
module délicatement par l'arrière. 

Consommation & coffrets électriques 
Chaque coffret électrique doit comprendre au moins une alimentation DALI0x. Toutes les 
consommations des coffrets doivent être calculées séparément dans le logiciel de 
configuration. Il est conseillé de ne pas interconnecter 2 coffrets avec l'alimentation + 
(câble rouge). Cette mesure est importante pour le câblage de la DALI03. 

Mesures sur le bus 
Votre système Domintell doit être alimenté par une alimentation DALI0x. 
Avec un multimètre: toutes les alimentations ON 

NOIR - ROUGE Toujours > 14 Vdc (tous les relais ON) 
NOIR – BLEU Data + : entre 2 & 4 Vdc. 
NOIR - BLANC Data - : entre 1 & 3 Vdc. 

Connexions 
Les raccordements au bus s'effectuent avec du câble « Domintell DCBU01 ». Respecter 
les couleurs des fils lors de leur branchement dans le connecteur rapide. 
Utiliser une configuration en bus. Éviter le câblage en ÉTOILE. La configuration en 
ÉTOILE constitue une perte de qualité du signal domotique. 
Il est interdit de faire une BOUCLE simple ou totale dans le câblage des datas du bus. La 
boucle génère des messages 'fantôme' empêchant le fonctionnement optimal du 
système. 
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 DDIM01 & modules de puissance 
La phase connectée aux modules dimmer de puissance (DD10V / DD400L/ DD75 / 
DD500/DD750/DD1000) doit être la même que celle connectée au module DDIM01 
correspondant. 
Veuillez vous référer à la documentation DDIM01 pour de + amples détails. 

 

 
 Le module DHUB01 

Uniquement nécessaire si : 
• Il y a plus de 128 modules sur le bus et/ou 
• Le bus a une longueur de plus de 300m et/ou 
• Votre bus est câblé en étoile avec une longueur totale de plus de 100m. 

 
Condition requise: chaque DHUB01 doit avoir une connexion sur la même ligne que 
l'unité centrale DGQG01 : c'est votre référence sur le bus. 
Veuillez vous référer à la documentation DHUB01 pour de plus amples détails. 

 
 DTRP01 - DTRP02 

Les modules télérupteurs ont besoin d'un courant de pointe important à chaque 
changement d'état. Domintell ne peut garantir le bon fonctionnement de ces modules s'il 
n'y a pas d'alimentation DALI01 dans le même coffret électrique, ou si le nombre 
d'alimentations est trop faible. Maximum 32 télérupteurs peuvent changer d'état en même 
temps s'il n'y a qu'une DALI01. 

 
 DGSM01 

Avant toute programmation du module DGSM01, les batteries doivent être chargées. 
Afin de traiter les requêtes sur le module DGSM01, nous avons besoin de la capture 
d'écran de la fenêtre d'état correspondante : 

1. Charger votre application et attendre l'initialisation 
2. Passer en mode PC actif 
3. Cliquer droit sur l'entrée DGSM01 => Statut 
4. Prendre une capture de l'écran 
5. Envoyer-la par email 
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 FICHIERS LOG 
• Le support peut vous demander un fichier log en cas de besoin. 
• Ils sont générés dans c:/Program_Files/Trump/GoldenGate/Log. 
• Début lors du démarrage du logiciel Domintell. 
• Fin lorsque vous quittez le logiciel Domintell. 
• Envoyer uniquement le fichier correspondant à l'heure désirée. 

 SUPPORT TECHNIQUE 
Pour toute information complémentaire, contacter le support technique de Domintell via 
support@domintell.com ou au +32 (0) 67 88 82 50. 
Envoyer le fichier d'application avec une description complète, le diagnostic et les 
résultats des prises de mesures sur le bus. Les photos et captures d'écran peuvent être 
envoyées pour permettre un diagnostic rapide.  

mailto:support@domintell.com
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